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TIẾT 1: EM CÓ THỂ LÀM ĐƯỢC GÌ NHỜ MÁY TÍNH
1. Mục tiêu:

 a) Kiến thức.  Giúp học sinh biết được những ứng dụng của máy tính trong quá trình học tập, vui chơi và trong cuộc sống.

b) Kỹ năng. Tìm hiểu những ứng dụng của tin học trong cuộn sống hàng ngày.

c) Thái độ: Nghiêm túc học tập, chủ động liên hệ thực tế.

2. Chuẩn bị của giáo viên và học sinh: 

a) Giáo viên:   SGK, SGV

b) Học sinh:  Vở ghi, SGK

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ: (3’)

* Câu hỏi:

 Em hãy kể tên những ứng dụng của máy tính trong xã hội mà em biết.

* Yêu cầu trả lời:

Những ứng dụng chủ yếu của máy tính trong xã hội:

     - Trong khoa học kĩ thuật

     - Trong quản lí.

     - Trong ngành tự động hoá và điều khiển.

     - Trong soạn thảo, in ấn và lưu trữ văn bản

     - Trong học tập.

* Đặt vấn đề: (1’)

Ngoài các ứng dụng trên của máy tính, vậy máy tính có thể giúp bản thân các em làm những công việc gì? Thầy cùng các em tìm hiểu bài học hôm nay. 

b) Dạy nội dung bài mới: (39’)

	
	Hoạt động của giáo viên và học sinh
	Ghi bảng

	GV

   ?
	Yêu cầu hs nghiên cứu mục 1 sgk – 9

Cả lớp nghiên cứu thông tin

Qua n/c, em hãy cho biết một số khả năng của máy tính?
	1.Một số knăng của máy tính: (15’)

	HS
	Khả năng tính toán nhanh, tính toán với độ chính xác cao, lưu trữ lớn, làm việc không mệt mỏi.

Lấy ví dụ minh hoạ cho mỗi knăng trên?

VD: 

+ Máy tính thực hiện hàng tỉ phép tính trong một giây.

+ Các thiết bị nhớ của máy tính lưu trữ thông tin khoảng 100.000 cuốn sách khác nhau.

+ Làm việc liên tục trong 1 thời gian dài.
	

	GV


	Chốt: Với những khả năng trên máy tính trở thành một công cụ xử lý thông tin hữu hiệu. 

Vậy có thể dùng máy tính vào những việc gì? sang P2.
	2. Có thể dùng máy tính điện tử vào những việc gì? (12’)

  - Thực hiện các tính toán

  - Tự động hoá các công việc văn phòng

	GV

   ?

HS

HS

GV


	Việc giải quyết các bài toán kinh tế và khoa học kỹ thuật ngày nay đòi hỏi khối lượng tính toán vô cùng lớn, nhiều khi con người không thực hiện được, khi đó máy tính là công cụ trợ giúp đắc lực.

Tại sao nói máy tính tự động hoá các công việc văn phòng

Vì thế có thể soạn thảo, trình bày, in ấn các văn bản, dùng máy tính thuyết trình trong các hội nghị.

Trong các cơ quan, doanh nghiệp để nắm được T2, con người, tài sản,... nhà quản lý sử dụng máy tính lưu trữ.
	- Hỗ trợ công tác quản lý

- Công cụ học tập và giải trí

- Điều khiển tự động và Robot

- Liên lạc, tra cứu và mua bán trực tuyến

	  GV
	 Qua phần trên ta thấy máy tính là một công cụ tuyệt vời, tuy nhiên máy tính do con người tạo ra, vậy sức mạnh của nó phụ thuộc vào con người và do con người quyết định
	3. Máy tính và điều chưa thể: (12’)

	   ?
	Theo em máy tính không thể làm được những việc gì?
	

	HS
	Không phân biệt được mùi, vị, cảm giác
	

	 GV
	  Do vậy máy tính chưa thể thay thế hoàn toàn được con người hay chưa thể có năng lực tư duy như con người.
	

	   ?
	Vậy đâu là hạn chế lớn nhất của máy tính?
	

	HS

GV

?

HS
	Chính là năng lực tư duy.

Đó là nội dung của ghi nhớ.

Một bạn độc ghi nhớ trong SGK

Đọc ghi nhớ.
	* Ghi nhớ: Sgk- 13


c) Củng cố, luyện tập. (1’) 

Bài học này giúp  các em nhận thấy những ứng dụng của máy tính điện tử, trợ giúp các em trong quá trình học tập, vui chơi và tìm hiểu khoa học.

d)  Hướng dẫn học sinh tự  học bài ở nhà:  (1’)
- Học bài, đọc bài đọc thêm.

- Trả lời câu hỏi 1; 2; 3 (sgk – 13)

- Chuẩn bị bài máy tính và phần mềm máy tính để tiết sau học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

----------------------------------------------------------------------------------------------
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TIẾT 2 BÀI 4.  MÁY TÍNH VÀ PHẦN MỀM MÁY TÍNH

1. Mục tiêu:

a) Kiến thức.  Học sinh nắm được cách đưa thông tin vào, xử lý thông tin và đưa thông tin ra của máy tính hay chính là mô hình ba bước.

b) Kỹ năng. - Nắm được cấu trúc chung của máy tính: CPU, bộ nhớ, thiết bị, vào. 

c) Thái độ.  Rèn học sinh lòng yêu thích, khơi gợi chí tò mò thích khám phá của các em. Đồng thời giáo dục ý thức tổ chức nhóm cao trong giờ học.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên:  Giáo án, SGK,  Sách tham khảo về tin học

b) Học sinh:  Vở ghi, SGK, ôn bài cũ, chuẩn bị bài mới.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ: (2’)

* Câu hỏi: 

Những khả năng to lớn nào đã làm cho máy tính trở thành một công cụ xử lý thông tin hữu hiệu?

* Đáp án và biểu điểm:

Mỗi ý trả lời đúng 2 điểm

       Một số khả năng của máy tính:

+ Khả năng tính toán nhanh

+ Tính toán với độ chính xác cao

+ Khả năng lưu trữ lớn

+ Khả năng làm việc không mệt mỏi.

* Đặt vấn đề: (1’)

 Bài học hôm nay thầy cùng các em tìm hiểu cấu trúc của máy tính điện tử gồm những bộ phận nào? Chức năng của mỗi bộ phận đó là gì? 

b) Dạy nội dung bài mới: (40’)

	
	Hoạt động của giáo viên và học sinh
	Ghi bảng

	GV
	Đưa mô hình quá trình ba bước lên bảng phụ cho học sinh quan sát


  

	1. Mô hình quá trình ba bước: (07’)

 

	GV


	   Yêu cầu học sinh nghiên cứu ba ví dụ mẫu: giặt quần áo, pha trà mời khách và giải toán
	

	  HS

   ?


	Nghiên cứu

Qua ví dụ em hãy cho biết bước nhập (Input) làm những công việc gì?
	

	HS
	Phải có nguyên liệu trước ví dụ:(quần áo, xà phòng, nước); (trà, nước sôi),..
	

	 GV
	Sau khi đã có sẵn nguyên liệu bước tiếp theo xử lý các nguyên liệu đó. Ví dụ: Vò quần áo bẩn, xà phòng và nước.
	

	?
	Bước cuối cùng gồm công việc gì?
	

	HS
	Lấy được kết quả đã xử lý (quần áo sạch, trà mời khách)
	

	 GV
	Khi a) Giáo viên thầy đặt câu hỏi, các em suy nghĩ rồi trả lời
	

	   ?

HS
	Hãy chỉ ra ba bước trong ví dụ trên

Nhập: câu hỏi

Xử lý: suy nghĩ

Xuất: trả lời câu hỏi
	

	GV
	Vậy bất kỳ một quá trình xử lý thông tin nào cũng là quá trình ba bước như trên có bộ phận đảm nhận các chức năng tương ứng để phù hợp với mô hình ba bước.

   Máy tính có cấu trúc chung như thế nào? thầy cùng các em nghiên cứu tiếp phần hai
	

	GV

HS

GV

   ?

HS

GV


	Hiện nay MTĐT có rất nhiều loại khác nhau: máy tính để bàn, MT sách tay, siêu máy tính,...Kích thước và hình thức khác nhau, các em quan sát hình ảnh của chúng SGK- 15

  Quan sát và nghe giáo viên giới thiệu.

   Tuy nhiên tất cả các máy tính đều có chung một cấu trúc theo nguyên lý Von Neumanm: Bộ xử lý trung tâm các thiết bị vào/ ra, và bộ nhớ.

   Các khối chức năng trên hoạt độnh dưới sự hướng dẫn của các chương trình máy tính do con người lập ra.

Vậy chương trình là gì?

Chương trình là tập hợp các câu lệnh, mỗi câu lệnh hướng dẫn một thao tác cụ thể cần thưc hiện.

...
	2. Cấu trúc chung của máy tính điện tử: (19’)

- Cấu trúc chung của MTĐT gồm:

   + Bộ xử lý trung tâm

   + Các thiết bị vào, ra

   + Bộ nhớ

- Chương trình là tập hợp các câu lệnh mỗi câu lệnh hướng dẫn một thao tác cụ thể cần thực hiện.

a) Bộ xử lý trung tâm (CPU)

  - CPU được coi là bộ não của máy tính nó điều khiển mọi hoạt động của máy tính

b) Bộ nhớ

  - Bộ nhớ là nơI lưu trữ chương trình và dữ liệu

  - Bộ nhớ chia làm hai loại: bộ nhớ trong và bộ nhớ ngoài

 - Đvị đo dung lượng nhớ là Byte (B)
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	 GV
	  Giới thiệu hai loại bộ nhớ: bộ nhớ trong (RAM), bộ nhớ ngoài (đĩa cứng, đĩa mềm, CD, DVD,...)

Đơn vị chính dùng đo dung lượng nhớ là Byte (B), Kilo byte (KB), Mega byte (MB),...
	c) Thiết bị vào, ra

Input (I), Output (O)

	GV

  ?

HS

  ?

HS
	Giới thiệu các thiết bị vào, ra dữ liệu

Kể tên các thiết bị vào (nhập dữ liệu)?

Bàn phím, chuột

Các thiết bị ra (xuất dữ liệu)?

Màn hình, máy in, máy Fax,...
	

	GV
	   Các thiết bị vào, ra gọi chung là các thiết bị ngoại vi giúp máy tính trao đổi thông tin với con người.
	

	?

HS
	Một em nhắc lại quá trình ba bước?

Nhập        Xử lý      
 Xuất
	3. Máy tính là một công cụ xử lý thông tin : (04’)

	GV
	  Cùng với cấu trúc của máy tính: bộ xử lý trung tâm, bộ nhớ, thiết bị vào, ra đã làm cho máy tính trở thành một công cụ xử lý thông tin hữu hiệu. Quá trình xử lý thông tin trong máy tính được tiến hành một cách tự động theo sự chỉ dẫn của các chương trình
	

	   ?

HS
	Các em quan sát sơ đồ minh hoạ quá trình hoạt động ba bước của máy tính sgk/ 17

Cả lớp quan sát
	

	GV

GV

HS


	Yêu cầu học sinh nghiên cứu thông tin sgk – 17; 18

   Như các em đã biết máy tính là công cụ xử lý thông tin tự động và ứng dụng trong hầu hết các lĩnh vực của cuộc sống, để đáp ứng yêu cầu đó thì nhà sản xuất, người lập trình,...đưa ra các phần mềm ứng dụng để phục vụ các mục đích đó.

   Vậy qua nghiên cứu, em hãy cho biết phần mềm là gì?

   Người ta gọi các chương trình máy tính là các phần mềm máy tính hay ngắn gọn là phần mềm 
	4.Phần mềm và phân loại phần mềm:  (10’)

- Để phân biệt với phần cứng chính là máy tính cùng tất cả các thiết bị vật lý kèm theo, người ta gọi các chương trình máy tính là phần mềm máy tính hay ngắn gọn là phần mềm.



	GV
	Phần mềm máy tính rất quan trọng, được ví như đem sự sống đến cho phần cứng vì nếu không có phần mềm thì màn hình, loa, chuột, bàn phím không có bất kỳ một tín hiệu nào cả.
	

	?

HS
	   Phần mềm máy tính được chia thành mấy loại? đó là những loại nào?

... có hai loại: phần mềm hệ thống và phần mềm ứng dụng
	- Phần mềm chia thành hai loại

   + phần mềm hệ thống

   + phần mềm ứng dụng

	GV
	Phần mềm hệ thống là những chương trình tổ chức, quản lý điều kiển máy tính trong quá trình hoạt động ví dụ: phần mềm MS - DOS, WINDOWS 98, WINDOWS XP,..Phần mềm ứng dụng là những chương trình đáp ứng những yêu cầu ứng dụng cụ thể ví dụ: phần mềm đồ hoạ, soạn thảo văn bản Word, chương trình bảng tính Excel,...
	

	?

   ?

HS
	Hãy kể tên một vài phần mềm mà em biết?

Đọc ghi nhớ trong SGK

Đọc ghi nhớ 
	*) Ghi nhớ: sgk - 18


c) Củng cố, luyện tập. (1’) 

Qua bài học hôm nay các em cần nắm được cách đưa thông tin vào, xử lý thông tin và đưa thông tin ra của máy tính hay chính là mô hình ba bước, nắm được cấu trúc chung của máy tính: CPU, bộ nhớ, thiết bị, vào

d)  Hướng dẫn học sinh tự  học bài ở nhà: (1’)

- Nắm chắc mô hình ba bước của MTĐT, cấu trúc chung của MTĐT và chức năng của mỗi bộ phận đó.

- Trả lời câu hỏi (sgk – 19).

- Đọc trước các phần còn lại của bài máy tính và phần mềm máy tính.

- Phần còn lại tiết sau học tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

-------------------------------------------------------------------
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TIẾT 3:   BÀI THỰC HÀNH 1

LÀM QUEN VỚI MỘT SỐ THIẾT BỊ MÁY TÍNH

1. Mục tiêu:

a) Kiến thức.  Học sinh nhận biết được một số bộ phận cấu thành cơ bản của máy tính cá nhân (loại máy tính phổ dụng hiện nay)

b) Kỹ năng.  Biết cách bật, tắt máy tính, làm quan với bàn phím và chuột.


c) Thái độ: Nghiêm túc thực hành, tuân thủ đúng nội quy phòng máy.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: sgk, sgv, phòng máy vi tính.

b) Học sinh:   Ôn lại lý thuyết, sgk

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ:  Xen kẽ trong giờ thực hành.

* Đặt vấn đề: (1’)

 Ở những tiết học trước các em đã được học cấu tạo và chức năng một số thiết bị của máy tính. Để hiểu rõ hơn về các thiết bị này, các em làm quen với một số thiết bị máy tính phổ dụng hiện nay. 

b) Dạy nội dung bài mới: (42’)

	
	Hoạt động của thầy và trò
	Ghi bảng

	GV

HS
	Chia học sinh thành các nhóm nhỏ, mỗi nhóm từ 4 – 5 học sinh. Cho học sinh quan sát các bộ phận cấu thành một máy tính

Quan sát
	1.Phân biệt các bộ phận của máy tính cá nhân: (18’)

- Các thiết bị nhập dữ liệu: bàn phím, chuột

- Thân máy tính: CPU

- Các thiết bị xuất: màn hình, máy in, loa, ổ ghi CD/ VCD

- Các thiết bị lưu trữ dữ liệu: đĩa cứng, đĩa mềm, USB,..

	  ?
	Chỉ ra những thiết bị vào?
	

	HS

GV

GV

HS
	Bàn phím, chuột, thân máy

   Thân máy tính còn gọi CPU, ngoài các thiết bị trên còn có các thiết bị khác: đĩa cứng, đĩa mềm, USB,...

   Hướng dẫn học sinh bật CPU và màn hình

   Thực hành theo hướng dẫn của giáo viên
	2.Bật tắt CP và màn hình: (3’)

	   ?
	Bàn phím được cấu tạo như thế nào?
	

	 HS
	Gồm 107 phím, chia 4 nhóm.

+ Nhóm phím kí tự.

+ Nhóm phím chức năng.

+ Nhóm phím điều khiển.

+ Nhóm phím số.
	3. Làm quen với bàn phím và chuột: ( 19’)

	   ?

HS

GV
	   Em hãy chỉ cụ thể từng nhóm phím trên bàn phím.

Thực hiện

Ngoài ra trên bàn phím còn có một số phím đặc biệt khác: Enter, Backspace, Spacebar, ESC, Delete,...
	

	   ?
	Chuột được cấu tạo như thế nào?
	

	HS
	  Gồm chuột trái, phải, phím dưới có con lăn giúp chuột di chuyển
	

	   ?
	Cho học sinh các nhóm gõ bàn phím để xem kết quả trên màn hình 
	

	 HS
	Thực hành
	

	GV
	  Hướng dẫn học sinh tắt máy tính:

Start 
Turn off Cumputer, hãy quan sát quá trình tự kết thúc và tắt máy tính.
	4. Tắt máy tính   (2’)

	HS
	Thực hành
	


c) Củng cố, luyện tập. (1’) 

Qua bài thực hành hôm nay các em cần biết một số bộ phận cấu thành cơ bản của máy tính cá nhân (loại máy tính phổ dụng hiện nay), biết cách bật, tắt máy tính, làm quan với bàn phím và chuột

d)  Hướng dẫn học sinh tự  học bài ở nhà: (1’)

 - Nắm chắc vị trí và chức năng của một số thiết bị trong máy tính.

- Đọc trước bài: Luyện tập chuột. Đọc lại cách nháy chuột đơn, chuột kép.

- Tiết sau thực hành tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

	Ngµy so¹n:   03/ 9/ 2017
	Ngµy d¹y: 06/ 9/ 2017
	Líp 9A

	
	Ngµy d¹y: 09/ 9/ 2017
	Líp 9B


CHƯƠNG II: PHẦN MỀM HỌC TẬP

Tiết 4
 BÀI 5: LUYỆN TẬP CHUỘT

1. Mục tiêu:

a) Kiến thức. HS nắm được chức năng của chuột: Chuột trái, chuột phải và cách sử dụng chuột.

b) Kỹ năng.  Kỹ năng quan sát, rèn thao tác nháy chuột nhanh, chính xác.

c) Thái độ: Nghiêm túc học tập, luyện tập chuột đúng cách.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên:  giáo án, Sgk, SGV, chuột, máy tính. 

b) Học sinh:  Ôn cấu tạo của chuột, SGK, vở ghi

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ: (15’)

Ghi lại chữ cái đứng trước câu trả lời đúng:
Caâu 1. Hãy chọn một câu đúng trong các câu sau đây

A. 1Byte = 8 bít.
B. 1Byte = 1024 bít.


C. 1Byte = 102 bít.
D. 1Byte = 100 bít.

Caâu 2. Bộ phận điều khiển các thiết bị của máy tính là

A. Bộ nhớ.
B. Thiết bị vào/ ra.


C. Cả ba câu đều sai.
D. Bộ xử lý trung tâm.

Caâu 3. Tin học là bộ môn học để:

A. Hoàn thành cấu trúc và tính chất của thông tin.

B. Nghiên cứu cấu trúc và tính chất của thông tin.

C. Xây dựng nên cấu trúc và tính chất của thông tin.

D. Tất cả đều sai.

Caâu 4. Thiết bị vào thông tin có thể là:

A. Máy quét, con chuột, bàn phím.
B. Máy quét, máy in, con chuột.

C. Màn hình, máy in, bàn phím.
D. Con chuột, màn hình, máy in.

Caâu 5. Máy tính có thể điều khiển:

A. Tất cả đúng.
B. Phi thuyền không gian.

C. Tàu ngầm.
D. Máy bay.

Caâu 6. Thông tin có thể ở dạng:

A. Tất cả các dạng kia.
B. Chữ viết.


C. Quyển sách.
D. Tấm bảng hiệu.

Caâu 7. Những người cần có thông tin là:

A. Người già.
B. Trẻ em.


C. Thanh niên.
D. Tất cả mọi người.

Caâu 8. Thông tin máy tính chưa xử lý được là:

A. Các mẫu tự.
B. Các loại mùi vị.


C. Các con số.
D. Các hình ảnh.

Caâu 9. Tốc độ xử lý thông tin của máy tính là:

A. Chậm.
B. Vừa phải.


C. Nhanh.
D. Tất cả đều sai.

Caâu 10. Trong cuộc sống con người: 

A. Không cần có thông tin . 

B. Đôi khi cần thông tin.
C. Thường xuyên thu nhận, xử lí và phát thông tin. 
D. Tất cả 3 câu kia đều đúng. 

	Câu
	Đáp án
	Điểm
	Câu
	Đáp án
	Điểm

	1
	A
	1
	6
	A
	1

	2
	D
	1
	7
	D
	1

	3
	B
	1
	8
	B
	1

	4
	A
	1
	9
	C
	1

	5
	A
	1
	10
	C
	1


* Đặt vấn đề: (1’)

Các em đã biết chuột là một thiết bị đưa thông tin vào máy tính, ngoài chức năng đó ra, chuột còn những chức năng nào khác không? Để trả lời câu hỏi này thầy cùng các em nghiên cứu nội dung bài hôm nay. 

b) Dạy nội dung bài mới: (28’)

	
	Hoạt động của thầy và trò
	Ghi bảng

	GV
	Chuột máy tính giúp các em điều khiển máy tính thuận tiện, nhanh chóng hơn.

Mặt trên của chuột có hai nút: Nút trái và nút phải. Mỗi khi em nhấn nút tín hiệu điều khiển sẽ được chuyển cho máy tính.
	1.Các thao tác chính với chuột: (5’)

	  ?
	   Trên màn hình chuột có biểu tượng như thế nào?
	

	HS
	  Chuột có hình mũi tên, hình đồng hồ cát,...
	

	  ?
	  Khi thay đổi vị trí của chuột em làm thế nào?
	

	HS
	Ở phía dưới chuột có con lăn giúp chuột di chuyển trên mặt bàn, khi đó mũi tên trên màn hình cũng di chuyển theo.
	

	GV
	Đây chính là cách di chuyển chuột.

  Các em cầm chuột và di chuyển chuột trên 1 mặt phẳng (thường là bàn di chuột)
	2.Sử dụng chuột:  (7’)


	  ?
	Vậy cách cầm chuột như thế nào?
	a) Cách cầm chuột

	HS

GV
	  Đặt úp bàn tay phải lên chuột, ngón trỏ đặt vào nút trái của chuột, ngón giữa đặt vào nút phải của chuột.

Các ngón còn lại cầm giữ 2 bên chuột.
	- Đặt úp bàn tay phải lên chuột, ngón trỏ đặt vào nút trái của chuột, ngón giữa đặt vào nút phải của chuột.

 - Ngón cái và các ngón còn lại cầm giữ 2 bên chuột.

	GV


	Như các em đã biết hình ảnh của chuột trên màn hình là mũi tên. Đó chính là con trỏ chuột.
	b) Con trỏ chuột.

	  ?
	Bằng các kiến thức thực tế, ngoài hình ảnh của con trỏ chuột trên, em còn thấy hình ảnh nào khác không?
	- Con trỏ chuột có hình dạng:

     I , (; (; (,...

	 HS
	Còn có dạng khác như: (; (; (,...
	

	GV
	Các hìmh ảnh đó chính là con trỏ chuột
	

	GV
	Khi thay đổi vị trí của chuột trên mặt phẳng, thao tác này gọi là thao tác di chuyển chuột.
	c) Các thao tác sử dụng chuột:

- Di chuyển chuột: Thay đổi vị trí 

	
	
	- Nháy chuột: Nhấn nút trái chuột rồi thả ngón tay.

- Nháy đúp chuột: Nháy chuột nhanh hai lần liên tiếp.

	GV
	Các em lưu ý, phân biệt được nháy chuột và nháy đúp chuột, khi thao tác nháy đúp chuột các em nháy chuột trái nhanh hai lần liên tiếp.
	

	  ?
	Lấy ví dụ khi nào ta sử dụng nháy đúp chuột?
	

	HS
	Nháy đúp chuột vào các biểu tượng của các phần mềm khi cần SD phần mềm.
	- Kéo thả chuột: Nhấn và giữ nút 

	GV
	Các em lưu ý khi gặp yêu cầu nháy chuột, nháy đúp chuột hoặc kéo thả chuột em sẽ sử dụng nút chuột trái. Khi nào cần dùng chuột phải thầy sẽ nhắc.
	trái của chuột di chuyển con trỏ đến vị trí cần thiết thì thả ngón tay nhấn giữ chuột.

	GV
	Chia lớp thành 6 nhóm, mỗi nhóm 4 học sinh.

Yêu cầu thực hành các nội dung sau:
	1. Quan sát chuột máy tính & phân biệt nút trái, phải chuột:  (1’)

	GV
	Hướng dẫn học sinh cách cầm chuột, di chuyển chuột, nháy chuột, nháy đúp chuột, nháy chuột phải, kéo thả chuột
	2.Luyện cách sử dụng chuột:  15’
- Cách cầm chuột.

- Di chuyển chuột.

- Nháy chuột.

- Nháy đúp chuột.

- Kéo thả chuột.

	GV 

HS
	Các em thực hành lại các thao tác trên.

Thực hành nd trên trong thời gian 15’
	

	 GV
	Kiểm tra cách làm của mỗi nhóm.
	

	 GV


	Nxét đánh giá ý thức, kết quả học tập của hs
	


c) Củng cố, luyện tập. (không) 

d) Hướng dẫn học sinh học bài ở nhà: (1’)

- Nắm được các thao tác khi sử dụng chuột.

- Đọc trước phần cấu tạo và chức năng của từng nhóm phím trong bàn phím.

- Chuẩn bị bài học gõ mười ngón để tiết sáu học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

-----------------------------------------------------------------------------------------

	Ngµy so¹n:   06/ 9/ 2017
	Ngµy d¹y: 09/ 9/ 2017
	Líp 9A

	
	Ngµy d¹y: 11/ 9/ 2017
	Líp 9B


TIẾT 5: BÀI 6  HỌC GÕ 10 NGÓN

1.Mục tiêu:

a) Kiến thức: HS nắm được vị trí của các ngón tay trên bàn phím, biết được điểm gốc trước khi để các ngón tay lên bàn phím có gai F và J

b) Kỹ năng: Rèn kỹ năng quan sát và tính kiên trì trong quá trình học.

c) Thái độ: Chăm chỉ học bài, vận dụng vào gõ mười ngón.

2. Chuẩn bị của giáo viên và học sinh

a) Giáo viên: Giáo án, SGK, Bàn phím, tài liệu tham khảo.

b) Học sinh: Nắm được các nhóm phím chính của bàn phím, vở ghi.

3. Tiến trình bài dạy

a) Kiểm tra bài cũ: (5’)

Câu hỏi:

Bàn phím có bao nhiêu phím? Chia thành mấy nhóm? đó là những nhóm nào?

Yêu cầu trả lời:

Bàn phím có 107 phím, bốn nhóm phím chính.

- Nhóm phím kí tự: Từ A -> Z và %, $,...

- Nhóm phím chức năng: F1 -> F12 

- Nhóm phím điều khiển: Ctrl, Alt, Shift

- Nhóm phím số và phép toán: Từ 0 -> 9, các phép toán +, -, *, /

? Nhận xét phần trả lời của bạn. 

* Đặt vấn đề. (1’) Các em đã nắm được cấu tạo, vị trí của các nhóm phím trên máy tính. Vậy làm cách nào để sử dụng bàn phím máy tính nhanh và khoa học. Thầy cùng các em nghiên cứu bài học hôm nay. 
b. Dạy nội dung bài mới: (37’)

	
	Hoạt động của thầy và trò
	Ghi bảng

	GV
	Tại hàng phím cơ sở, đặt ngón trỏ của tay trái lên phím F, các ngón cồn lại đặt lên các phím A, S, D.

  Đặt ngón trỏ của tay phải lên phím J các ngón cồn lại đặt lên các phím K, L, ;

  ở đây 2 phím F, J gọi là 2 phím có gai, chia bàn phím làm 2 nửa. Các em lưu ý, ngón tay nào quy định phím nào rồi, chỉ đánh theo phím quy định và các phím, A, S, D, F, J, K, L, :là các phím xuất phát.
	1.Cách đặt tay trên bàn phím: (4’)



	  ?
	Hai ngón tay cái sẽ gõ phím nào?
	

	HS
	Hai ngón tay cái sẽ gõ phím cách (Space bar)
	

	 GV

  ?
	Các em lưu ý các ngón tay vào các phím quy định

Khi gõ các phím ở hàng cơ sở, mỗi 
	2. Cách gõ các phím ở hàng cơ sở (8’)

	
	ngón tay gõ mấy phím?
	

	HS
	Mỗi ngón tay gõ 1 phím đã quy định ở trên.
	

	  ?
	Hai ngón trỏ đặt ở những phím nào?
	

	HS


	Ngón trỏ trái đặt ở phím F, trỏ phải đặt phím J
	

	 GV


	Lưu ý còn phím G, H thì 2 ngón trỏ tay gõ phím đó, sau khi gõ xong trở về vị trí xuất phát. Tương ứng là F và J
	

	GV
	Để gõ các phím hàng trên, các em đặt tay ở các phím hàng cơ sở, rồi vươn các ngón tay lên hàng trên.

Ngón trỏ trái gõ: R, T
	3.Tập gõ các phím ở hàng trên:  (8’)

	  ?
	Tương tự ngón trỏ phải gõ phím nào?
	

	HS
	Ngón trỏ phải gõ Y, U
	

	GV
	Các ngón còn lại vươn lên theo thứ tự tương ứng, theo thứ tự từ ngón út (trái sang phải) 

Trái:Q(út),W(nhẫn), E(giữa), R,T(trỏ). 

Phải: Y, U(trỏ), I(giữa), O(nhẫn), P(út)

Lưu ý: Sau khi gõ xong 1 phím, phải đưa ngón tay về phía xuất phát tương ứng ở hàng cơ sở.
	

	GV
	Cho hs hoạt động theo nhóm: Thực hiện yêu cầu: Cách đặt tay bàn phím, tập gõ các phím ở hàng cơ sở và các phím ở hàng trên.

Mỗi nhóm 1 bàn phím: T hđộng 10’
	

	GV
	Gọi 1 số em trong mỗi nhóm ktra
	

	  ?
	Phím có gai là những phím nào?
	

	HS
	Đó là các phím F, J

Cả hàng phím đó gọi là phím cơ sở
	

	GV
	Ktra cách đặt ngón tay của các em
	


	  ?
	Với 2 hàng phím: Cơ sở, hàng phím trên, ngón trỏ gõ ở phím nào?
	

	HS
	Trỏ trái: F, G, R, T.

Trỏ phải: J, H, U, Y
	

	  ?
	Tương tự như các phần mềm trên để gõ các phím ở hàng dưới cách đặt tay trên bàn phím như thế nào?
	4.Tập gõ các phím ở hàng dưới:  (5’)



	HS
	Đặt tay ở hàng phím xuất phát
	

	  ?
	Vậy cách gõ như thế nào?
	

	 HS

GV
	Các ngón tay sẽ đưa xuống để gõ các phím ở hàng dưới

Chú ý sau khi gõ xong 1 phím phải đưa ngón tay trở lại phím xuất phát tương ứng ở hàng cơ sở. 
	

	  ?
	Các phím hàng dưới gồm những phím nào?
	

	HS
	Trái: Z (út), X (nhẫn), C (giữa), V,  B (trỏ)

Phải: N, M (trỏ); , (giữa); . (nhẫn), /(út)
	

	GV
	Các ngón tay vẫn đặt lên các phím xuất phát ở hàng cơ sở.
	5. Tập gõ các phím ở hàng phím số: 4’

	  ?


	Em cho biết vị trí các ngón tay khi gõ phím số?
	

	HS


	Trái:(út) 1, (nhẫn)  2, (giữa) 3, (trỏ) 4, 5

Phải: (trỏ) 6,  7, (giữa) 8, (nhẫn) 9, (út) 0
	

	  ?
	Gõ các phím ở hàng số theo mẫu sau:

 10  10      10   01    01  10    01  01

2222    3333  3232      3322    2233

   49       49      44         99      94

    86         68      88        66

     75          57
	

	
	
	6. Luyện gõ kết hợp các phím kí tự trên toàn bàn phím:  (4’)

	GV

HS
	Các em gõ kết hợp các phím ở các hàng trên bàn phím

Luyện gõ trên bàn phím

maul   mod   nuff   mug  nuum  magg  muagaf  aft ...
	

	
	
	7. Luyện gõ kết hợp phím Shift: 4’

	GV
	Sử dụng ngón út bàn tay trái hoặc phải để ấn giữ phím Shift kết hợp gõ phím tương ứng để gõ chữ hoa theo mẫu.
	Chữ hoa = Shift + chữ cái đó

VD: A ấn (Shift) kết hợp (A)


c) Củng cố, luyện tập. (1’) 

Qua bài học hôm nay các đã biết cách gõ các phím ở hàng phím dưới và và hàng phím số, gõ kết hợp các phím trên bàn phím.

d) Hướng dẫn học sinh học bài ở nhà: (1’)

- Ôn luyện cách gõ 10 ngón, nắm được hàng phím cơ sở.

- Không yêu cầu gõ nhanh mà quan trọng là các em phải sử dụng đúng ngón tay khi gõ phím. Đọc trước bài sử dụng phần mềm Mario để luyện gõ phím để tiết sau học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

	Ngµy so¹n:   10/ 9/ 2017
	Ngµy d¹y: 13/ 9/ 2017
	Líp 9A

	
	Ngµy d¹y: 14/ 9/ 2017
	Líp 9B


TIẾT 6: 

BÀI 7  SỬ DỤNG PHẦN MỀM MARIO ĐỂ 

LUYỆN GÕ PHÍM

1.Mục tiêu:

a) Kiến thức:  HS biết cách khởi động và thoát khỏiphần mềm Mario.

b) Kỹ năng:  Biết sử dụng phần mềm Mario để luyện gõ 10 ngón.

c) Thái độ: Hình thành phong cách làm việc chuẩn mực, thao tác dứt khoát.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên:  Giáo án, SGK, phần mềm Mario, tài liệu tham khảo.

b) Học sinh:  Ôn  cách gõ 10 ngón, SGK, vở ghi.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ:   Xen kẽ trong giờ

* Đặt vấn đề. (1’)

 
Để giúp các em học gõ mười ngón các nhà viết phần mềm đẫ viết ra phần mềm Mario. Bài hôm nay chúng ta nghiên cứu về phần mềm này.

b) Dạy nội dung bài mới: 42’
	
	Hoạt động của thầy và trò
	Ghi bảng

	GV
	Gthiệu phần mềm Mario:

Phần mềm Mario Traches Typing (Mario dạy gõ phím)là phần mềm khá phổ biến trong số các phần mềm luyện gõ bàn phím. Được viết năm 1992 do hãng Interplay Entertainment phát hành dựa trên cơ sở Mario - 1 nhân vật nổi tiếng trong trò chơi điện tử và phin hoạt hình.

Đây là 1 trong các phần mềm nổi tiếng nhất về luyện gõ 10 ngón được viết trên nền của DOS trong những năm cuối thế kỷ XX, tuy nhiên vẫn có thể chạy được trên các hệ điều hành windows 98/2000/XP. Phiên bản được gthiệu là bản 2.0
	1. Giới thiệu phần mềm Mario: (10’)



	GV

HS
	Yêu cầu các em nghiên cứu sgk màn hình chính của phần mềm sau khi khởi động

Nghiên cứu sgk
	Màn hình chính của Mario:

Bảng chọn: File(cáclệnh h/thống)

    Student (cài đặt thông tin hs)

    Lessons (lựa chọn các bài học để gõ phím)

	GV
	Trong bảng chọn Lessons có các mức luyện tập:

1: Dễ        3. Khó         

2. TB        4. Mức luyện tập tự do
	

	   ?

HS
	Muốn vào bài 1 ở mức độ dễ các em làm như thế nào?

Nháy chuột bài 1 trên màn hình 
	

	GV
	Khi đó 1 bảng chọn xuất hiện chứ các lệnh có thể chọn tiếp để thực hiện:

Home Row Only: Bài chỉ gõ các phím hàng cơ sở

Add Top Row: Bài chỉ gõ các phím hàng trên.

Add Bottom Row: Bài chỉ gõ các phím hàng dưới.

Add Numbers: Bài chỉ gõ các phím hàng số.

Add Symbols:Bài chỉ gõ các phím kí tự.

All Keyboard: Kết hợp toàn bộ bàn phím

Các em nên bắt đầu từ bài luyện tập đầu tiên.
	

	  ?
	Để thoát khỏi phần mềm này chúng ta làm như thế nào?
	

	HS
	ấn Q hoặc File -> Qiut
	

	 GV


	Như vậy các em đã biết cách khởi động, cách thoát phần mềm Mario.

Nếu là lần đầu tiên chạy ctrình, các em phải đăng kí tên của mình để phần mềm Mario theo dõi, đánh giá kết quả luyện gõ phím của các em trong qtrình htập

Vậy cách đăng kí như thế nào, chúng ta sang phần 2.
	2. Luyện tập:  (12’)

	GV


	Sau khi k/đ phần mềm Mario:

B1: Gõ W (hoặc nháy chuột Student

 -> New). Cửa sổ Student Infor maition xuất hiện.

B2: Nhập tên(New Student Name...)

Nhập xong ấn (
B3: Nháy chuột nút DONE để đóng cửa sổ
	a) Đăng kí người luyện tập

	GV
	Đã đăng kí được tên với Mario rồi, mỗi lần muốn luyện tập các em chỉ cần nạp tên để Mario tiếp tục theo dõi kết quả học tập của em.
	

	HS

GV
	Luyện gõ trên bàn phím

Sau khi thực hiện các thao tác trên em
	b) Nạp tên người luyện tập

B1: Gõ phím l hoặc nháy chuột tại mục Student -> Load trong bảng chọn.

B2: Nháy chuộtđể chọn tên.

B3: Nháy DONE

	
	sẽ thấy tên của mình xuất hiện trên màn hình
	

	GV
	Để đánh giá khả năng gõ bàn phím người ta sử dụng tiêu chuẩn WMP (Word Pu Minute)
	2. Luyện tập:  (Tiếp)

c) Thiết đặt các lựa chọn để luyện tập: 6’


	  ?
	Vậy WMP là gì?
	

	HS
	WMP là số lượng từ gõ đúng TB trong 1’
	

	  ?


	Như vậy WMP là thông số quan trọng đánh giá kết quả của việc gõ chính xác bàn phím bằng 10 ngón.

Nếu WMP của em chỉ đạt từ 5 - 10 thì đó là kết quả chưa tốt.

Từ 10 - 20 là kết quả khá.

Từ 30 trở lên là tốt. 
	

	GV

HS
	Các em nghiên cứu cách thiết đặt các lựa chọ để luyện tập.

Tự nghiên cứu sgk
	

	  ?
	Đặt lại mức WMP ta làm như thế nào?
	

	HS
	- Student/ Exit (bảng chọn xuất hiện) vào mục Goal WMP để đặt lại
	

	GV


	Ngoài cách đó ra các em có thể gõ E từ bàn phím, ấn (
	

	  ?

HS

GV

HS
	Tiếp sau đó làm như thế nào?

- Chọn người dẫn ctrình.

- Nháy DONE

Như vậy các em đã thiết đặt các lựa chọn. Để lựa chọn các bài học làm như thế nào các em sang tiếp phần d)

Nghiên cứu sgk
	d) Lựa chọn bài học và mức độ luyện gõ bàn phím: (8’)

	
	
	- Lessons/ Home Row Only (chỉ luyện các phím hàng cơ sở).

- Chọn mức luyện tập(từ 1 -> 4) hoặc nháy chuột trên biểu tượng tương ứng.

	GV
	Khi luyện gõ bàn phím theo hướng dẫn trên màn hình. Lưu ý em tập gõ chính xác theo các bài tập mẫu mà phần mềm đưa ra. Trên màn hình có kết quả:

- Key Typed: Số kí tự đã gõ.

- Errors: Số lần gõ bị lỗi.

- Word/ Min: WMP đã đạt được của bài.

- Goal WMP: WMP cần đạt được.

- Accuracy: Tỉ lệ gõ đúng.

- Lesson Time: Thời gian luyện tập.
	e) Luyện gõ bàn phím: (5’)



	GV
	Sau khi luyện tập xong 1 bài, em có thể nháy nut NEXT để sang bài tiếp theo, hoặc nháy MENA để quay về màn hình chính.
	


c) Củng cố, luyện tập. (1’) 

Qua bài học này các em đã biết cách chọn các mức để luyện gõ phím bằng mười ngón với các mức độ khó tăng dần..

d) Hướng dẫn học sinh học bài ở nhà: (1’)

- Ôn lại các cách sử dụng phần mềm Mario.

- Luyện cách gõ bàn phím bằng 10 ngón. Kẻ 1 bàn phím.

- Về nhà chuẩn bị bài quan sát trái đất và các vì sao trong hệ mặt trời để tiết sau học.  

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

--------------------------------------------------------------------------------------------

	Ngµy so¹n:   11/ 9/ 2017
	Ngµy d¹y: 14/ 9/ 2017
	Líp 9A

	
	Ngµy d¹y: 14/ 9/ 2017
	Líp 9B


CHƯƠNG III    HỆ ĐIỀU HÀNH

TIẾT 7: BÀI 9: VÌ SAO CẦN CÓ HỆ ĐIỀU HÀNH

1. Mục tiêu:

a) Kiến thức:  HS thấy được vai trò quan trọng của các phương tiện điều khiển qua 2 quan sát

 b) Kỹ năng: Rèn kỹ năng làm việc nghiêm túc, có hiệu quả tuân theo trình tự nhất định.

c) Thái độ: Nghiêm túc học tập, áp dụng tin học vào môn địa lí.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên:  Giáo án, SGK.

b) Học sinh:  Vở ghi,  SGK.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ.

      Kết hợp trong giờ kiểm tra

* Đặt vấn đề. (2’)

  Ở các chương học trước các em đã được làm quen với máy tính và các phần mềm học tập. Trong chương học này các em sẽ được cung cấp thêm 1 số kiến thức mở đầu về hệ điều hành của máy tính, làm quen với 1 trong những hệ điều hành thông dụng nhất hiện nay cua Windows.

Trong tiết học hôm nay chúng ta cùng tìm hiểu vì sao máy tính cần có hệ điều hành?
b) Dạy nội dung bài mới:  41’

	
	Hoạt động của GV và HS
	Ghi bảng

	GV

HS

?

HS

?

HS

Gv

?

HS

GV

HS

   ?

HS

GV

   ?

HS

?

HS

GV

HS

GV

HS

GV
	Các em nghiên cứu ND quan sát 1 - sgk:

Nghiên cứu

Hãy mô tả lại quan sát 1?

Trên đường phố ngã ba, tư,...hiện nay có rất nhiều các phương tiện (ô tô, xe máy, xe đạp, xe búyt, ...) tham gia giao thông. Vào giờ cao điểm ở đó thường sảy ra cảnh ùn tắc giao thông. Những lúc đó có hệ thống đèn tín hiệu giao thông.

Vậy đèn tín hiệu giao thông có vai b) Học sinh gì?

Phân luồng cho các phương tiện giao thông đóng vai trò điều khiển hoạt động giao thông.

Cũng có thể thay đèn tín hiệu giao thông bằng các chú cảnh sát giao thông ở ngã tư đường phố trong giờ cao điểm.

Nếu không có đèn tín hiệu, cảnh sát giao thông thì sảy ra hiện tượng gì?

Khi đó sảy ra các hiện tượng vi phạm luật giao thông, tai nạn,...

Như vậy, qua qsát 1 ta thấy vai trò của điều khiển hết sức quan trọng, nhất là trong thời đại công nghiệp hiện nay.

Yêu cầu nghiên cứu quan sát 2.

Đọc quan sát 2.

Các em thử hình dung hoạt động của nhà trường khi mất thời khoá biểu?

...các lớp nhốn nháo không biết học tiết nào môn gì, các a) Giáo viên thầy nếu không nhớ thời khoá biểu lớp mình dạy...

Khi đó việc học tập của các lớp sẽ trở nên hỗn loạn.

Vai trò của thời khoá biểu

Thời khoá biểu đóng vai trò rất quan trọng trong việc điều khiển các hoạt động học tập trong nhà trường.

Bằng cách quan sát các hiện tượng trong xã hội và cuộc sống em lấy ví dụ và đưa ra nhận xét của mình.

Lấy ví dụ, nhận xét

Đưa ra ví dụ: Như các em đã biết đường dây điện thoại giúp việc thông tin liên lạc được thuận lợi hơn, giúp các hoạt động kinh tế, chính trị diễn ra đồng bộ, đến khắp trên cả nước.

Giả sử đường dây bị hỏng, các em hình dung khi đó các hoạt động trong xã hội

như thế nào?

Các hoạt động bị đảo lộn, thông tin kinh tế, chính trị bị ùn tắc, các cơ quan đầu não không nắm bắt được tình hình xã hội

Qua các qsát trên em rút ra nhận xét gì?

...thấy vai tròquan trọng của các phương tiện điều khiển.

Như vậy ta thấy các phương tiện điều khiển có vai trò hết sức quan trọng trong việc hướng dẫn, định hướng các hoạt động đi vào"quỹ đạo chuyển động", giúp các công việc được thực hiện nhanh chóng và hiệu quả hơn.
	1. Các quan sát. 

a) Quan sát 1:   (5’)

* Quan sát 2:  (10’)

* Nhận xét: (2’)



	GV

  ?

HS

GV

  ?

HS

?

HS

Gv

HS

GV

  ?

HS

GV

  ?

HS


	Khi máy tính hoạt động, có nhiều đối tượng cũng tham gia vào qtrình sử lí thông tin các đối tượng này có thể là phần cứng, có thể là phần mềm máy tính

Nhắc lại phần cứng, phần mềm MT?

Phần cứng: là tất cả các linh kiện kĩ thuật vật lí tạo thành 1 MTĐT.

Phần mềm: Là tất cả các ctrình chạy trên MT, nhằm khai thác các tài nguyên MT. Có phần mềm hệ thống và phần mềm ứng dụng.

 Các đối tượng này hoạt động cũng cần được điều khiển 1 cách tương tự như trong các qsát trên. Công việc này do hệ điều hành của MT đảm nhận.

Hệ điều hành của MT có nhiệm vụ gì?

..đ/khiển các thiết bị (phần cứng), t/chức việc thực hiện các ctrình (phần mềm).

Vậy hệ điều hành có vai trò như thế nào?

HĐH có vai trò rất quan trọng, nó đ/khiển mọi hoạt động của phần cứng và phần mềm t/gia vào qtrình sử lí T2.

Đây chính là nội dung ghi nhớ

Đọc lại ghi nhớ

Cho hs các nhóm thảo luận câu 5 sgk - 41

Các nhóm đại diện trình bày.

Phần mềm học gõ bàn phím bằng 10 ngón có phải là hệ điều hành không?

 Gợi ý: Muốn rõ, các em xem phần mềm này nó có thể điều khiển được mọi hoạt động của máy tính không?

 ... không điều khiển được mọi hoạt động của máy tính.

Yêu cầu hoàn chỉnh câu 5 vào vở.

Chốt lại: Các em lưu ý có các phần mềm không phải là hệ điều hành vì nó không thể điều khiển mọi hoạt động của máy tính cũng như việc thực hiện các phần mềm khác.

Lấy ví dụ về 1 số phần mềm khác không phải là hệ điều hành?

Phần mềm học tiếng anh, toán học, phần mềm quan sát trái đất và các vì sao trong hệ mặt trời...
	2. Cái gì điều khiển máy tính:  (18’)

* Ghi nhớ (sgk - 40):  (6’)

Ví dụ: Windows 98, Windows XP, MS DOS,...




c) Củng cố, luyện tập. (1’) 

Qua bài các em thấy được vai trò của hệ điều hành trong quá trình hoạt động và sử lí thông tin của MTĐT. Phân biệt được hệ điều hành và các thiết bị máy tính khác.

 d) Hướng dẫn học sinh học bài ở nhà: (1’)


- Học thuộc nội dung của bài trong vở ghi, xem thêm trong SGK.
- Học thuộc ghi nhớ, trả lời câu hỏi 4, 5 sgk - 41.


- Đọc trước bài mới "hệ điều hành làm những việc gì"

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:.....................................................................................
	Ngµy so¹n:   13/ 9/ 2017
	Ngµy d¹y: 16/ 9/ 2017
	Líp 9A

	
	Ngµy d¹y: 16/ 9/ 2017
	Líp 9B


TIẾT 8: BÀI 10: 

HỆ ĐIỀU HÀNH LÀM NHỮNG VIỆC GÌ

1. Mục tiêu:

a) Kiến thức: . Học sinh biết được: Hệ điều hành là phần mềm máy tính được cài đặt đầu tiên trong máy tính và được chạy đầu tiên khi khởi động máy tính.

b) Kỹ năng:  Rèn trí tưởng tượng, quan sát các hiện tượng thực tế liên hệ thấy được vai trò, nhiệm vụ của hệ điều hành.

c) Thái độ: Nghiêm túc học tập, chủ động liên hệ thực tế.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên:  Giáo án, SGK.

b) Học sinh:  Vở ghi, vở bài tập, SGK.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ: (5’)

Câu hỏi: 

Hãy nêu vai trò của hệ điều hành máy tính: Lấy ví dụ về hệ điều hành mà em biết?

Yêu cầu trả lời: 

Hệ điều hành nó có vai trò rất quan trọng, nó điều khiển mọi hoạt động của phần cứng và phần mềm tham gia vào quá trình xử lí thông tin.

Ví dụ: Hệ điều hành Windorws XP

? Nhận xét bài của bạn?

* Đặt vấn đề. (1’)

Các em đã thấy được vai trò quan trọng của hệ điều hành trong máy tính. Vậy hệ điều hành làm những công việc gì? Chúng ta cùng nghiên cứu trong bài học hôm nay.

b) Dạy nội dung bài mới: 37’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV

GV

   ?

HS

  ?

HS

GV

   ?

HS

   ?

HS

?

GV


	Qua vai trò to lớn của hệ điều hành trong MT, vậy HĐH là gì? nó có phải là 1 thiết bị trong MT không? Câu trả lời ở đây: HĐH không phải là 1 thiết bị được lắp ráp trong MT mà HĐH chính là 1 ctrình MT. Hay là 1 phần mềm MT

Gthiệu qua lịch sử phát triển MT từ rơ le quang học và rơ le điện (khi thực hiện con người phải đóng mở thủ công các rơ le đó) -> mạch điện -> phần mềm.

Các em thử hình dung nếu MT không có hệ điều hành thì điều gì sẽ sảy ra? Các thông tin đưa vào không được xử lí MT không hoạt động được.

Vậy hệ điều hành là phần mềm hay phần cứng?

Hệ điều hành là 1 phần mềm.

HĐH là phần mềm đầu tiên được cài đặt trong mát tính. Tất cả các phần mềm khác chỉ có thể hoạt động được sau khi MT đã có hệ điều hành.

MT chỉ có thể hoạt động được sau khi đã được cài đặt tối thiểu 1 hệ điều hành.

Vì sao hệ điều hành cần cài đặt đầu tiên và chạy trong máy vi tính?

Vì điều khiển tất cả các tài nguyên và ctrình có trong máy tính.

Các thành phần khác phải cài đặt trên nền của 1 HĐH đã có sẵn trong máy tính.

Hãy nêu sự khác nhau chính giữa điều hành với 1 phần mềm ứng dụng?

HĐH: Điều khiển tất cả phần mềm và phần cứng của máy tính.

Phần mềm ứng dụng: SD được trên nền của HĐH nào đó. Không có HĐH yhì phần mềm ứng dụng cũng không sử dụng được.

 Chốt lại: Như vậy MT chỉ có thể được sử dụng , khai thác có hiệu quả khi có HĐH. MT không bị gắn t.ứng với 1 HĐH cụ thể. Hiện nay có nhiều HĐH cho ta lựa chọn và có thể cài đặt 1 hoặc

1 vài HĐH trên 1 máy tính. Tất cả các HĐH đều có những chức năng chung. 

Ngoài HĐH Windows, trên thị trường hiện nay còn có HĐH MacOS, Linux, Unix
	1. Hệ điều hành là gì?(15’)

- Hệ điều hành không phải là 1 thiết bị được lắp ráp trong máy tính.

- Hệ điều hành là 1 ctrình phần mềm được cài đặt đầu tiên trong máy tính.

- Tất cả các phần mềm khác chỉ có thể hoạt động được sau khi máy tính đã có hệ điều hành.



	 ?

HS

GV

GV

   ?

HS

  ?

HS

GV

HS

GV

?

HS

  ?

HS

 GV

GV

GV
	Nhắc lại HĐH máy tính có n/vụ gì?

Điều khiển phần cứng và tổ chức thực hiện các chương trình máy tính.
Đây là nhiệm vụ quan trọng nhất của mọi HĐH. Các em chú ý tài nguyên của máy tính (CPU bộ nhớ trong, bộ nhớ ngoài,...) Chỉ có một giới hạn (giống như đường phố thì trật hẹp), nhưng các ctrình phần mềm luôn hoạt động tối đa (giống như người tham gia giao thông ai cũng muốn đi nhanh). 

Vậy nếu không được điều khiển thì sảy ra hiện tượng gì?

Ùn tắc giao thông, các tai nạn có thể sảy ra.

 Tương tự như thế khi máy tính không được điều khiển thì hiện tượng tranh chấp tài nguyên máy tính như thế nào? 

Khi đó hiện tượng tranh chấp tài nguyên trong máy tính sẽ hỗn loạn giống như hiện tượng tắc nghẽn giao thông trên đường phố.

Để minh hoạ cho hiện tượng đó các em qsát hình ảnh minh hoạ trong sgk - 42.

Quan sát.

Khắc phục hiện tượng đó thì HĐH điều khiển các hoạt động của toàn bộ hệ thống sẽ trở lên nhịp nhàng.

Ngoài nhiệm vụ đó ra, theo các em HĐH còn có n/vụ gì khác không?

Cung cấp giao diện cho người sử dụng Vậy giao diện là gì?

 Giao diện là môi trường giao tiếp cho phép con người trao đổi thông tin với máy tính trong quá trình làm việc.

Như vậy người ta có thể chia công việc của HĐH thành 2 nhóm chính: Nhiệm vụ hệ thống và giao diện với người sử dụng. Mọi HĐH đều thực hiện hai nhóm nhiệm vụ này.

 Việc tổ chức và quản lí thông tin trong máy tính là một nhiệm vụ khác của HĐH, các em sẽ được tìm hiểu nhiệm vụ này trong bài học sau.

Các em lưu ý: Người dùng có thể hoặc không thể nhìn thấy được các công việc mà hệ điều hành thực hiện ví dụ người dúng chỉ tiếp xúc với những gì diễn ra trên màn hình mà thường chỉ thấy kết quả công việc chứ không biết rõ được các bước chi tiết mà máy tính phải thưch hiện để thực hiện công việc đó.

 Củng cố: 
	2. Nhiệm vụ chính của Hệ điều hành : 17’
- Điều khiển phần cứng và tổ chức thực hiện các chương trình máy tính.
- Hệ điều hành Cung cấp giao diện cho người dùng. Giao diện là môi trường giao tiếp cho phép con người trao đổi thông tin với máy tính trong quá trình làm việc.

	  ?
	Hệ điều hành có những nhiệm vụ gì?
	*) Ghi nhớ: (sgk - 43)  5’

	  ? 
	Phần mềm nào được cài đặt đầu tiên trong máy tính?
	


c)  Củng cố, luyện tập. (1’) 

Bài học hôm nay các em cần nắm được hai nhiệm vụ chính của hệ điều hành là điều khiển hoạt động của máy tính và cung cấp môi trường giao tiếp giữa người và máy tính. Biết cách quản lý thông tin trong máy tính.

d) Hướng dẫn học sinh học bài ở nhà: (1’)

- Học bài theo vở ghi, học thuộc ghi nhớ.

- Trả lời các câu hỏi 4, 5, 6 (sgk - 43)

- Đọc trước bài Tổ chức thông tin trong máy tính.

- Tiết sau học bài tổ chức thông tin trong máy tính.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

----------------------------------------------------------------------
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Tiết 9: Bài 12: HỆ ĐIỀU HÀNH WINDOWS

1.Mục tiêu:

a) Kiến thức:  HS nhận biết được và chỉ đúng tên các biểu tượng chính trên giao diện khởi động của hệ điều hành windows.

b) Kỹ năng:  Biết được ý nghĩa của các khái niệm quan trọng sau của HĐH Windows màn hình nền (Desktop), thanh công việc (Task bar), nút Start, các biểu tượng chương trình ứng dụng và khái niệm cửa sổ (windows) trong hệ điều hành

c) Thái độ:  Biết và hiểu được các thành phần của một cửa số trong windows

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên:  Giáo án, SGK, phòng máy.

b) Học sinh:  Học bài, SGK, vở ghi.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ: (3’)

Câu hỏi:  Hệ điều hành là gì? Hãy kể tên 1 số hệ điều hành mà em biết.

Yêu cầu trả lời: Hệ điều hành là ctrình đặc biệt, hệ điều hành là phần mềm đầu tiên được cài đặt trong máy tính, không có hệ điều hành máy tính không thể sử dụng được.

 Ví dụ: Hệ điều hành MS.DOS, Windows.

* Đặt vấn đề. (1’)

Các em đã windows là hệ điều hành của hãng phần mềm Microsoft. Phiên bản đang được sử dụng phổ biến hiện nay trên thế giới là Windows XP. Trong bài học hôm nay các em sẽ hiểu rõ hơn về hệ điều hành Windows XP.

b) Dạy nội dung bài mới: 39’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV

  ?
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GV

  ?

HS

  ?
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  ?
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  ?
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GV

GV

GV
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GV
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  ?

   ?
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  ?
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HS 
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? 
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GV
	Hệ điều hành là phần mềm đầu tiên được cài đặt trong máy tính, không có hệ điều hành máy tính không thể HĐ dụng được. 

Vậy muốn khởi động hệ điều hành các em làm như thế nào?

Khởi động máy sẽ khởi động được HĐH hoạt động.

Khi HĐH hoạt động (Windows XP hoạt động) thì màn hình làm việc chính của Windows xuất hiện. 

Trên màn hình chỉnh các ctrình được bố trí, sắp xếp như thế nào cta n/cứu ->

Các em  quan sát màn hình nền của Windows XP

Chốt lại toàn bài

Cả lớp quan sát Trên màn hình nền của Windows có chứa những gì?

chứa các biểu tượng và thanh công việc.

Em có thể kể tên 1 vài biểu tượng mà em biết?

Biểu tượng: My Computer, My Documents, Word, Excel, ...

Các em đã biết biểu tượng là những hình ảnh thu nhỏ của những ctrình máy tính.

Vậy muốn những ctrình này hoạt động ta làm như thế nào?

Nháy đúp chuột vào biểu tượng của chương trình đó.

Các em qsát khi nháy đúp vào biểu tượng My Computer thì 1 cửa sổ được mở ra.

Khác với các biểu tượng trên đây chính là biểu tượng của các ctrình phần mềm ứng dụng còn My Computer,... là những phần mềm hệ thống.

    - Phần mềm hệ thống: Những Ctrình đkhiển máy tính hoạt động.

    - Phần mềm ứng dụng: Những Ctrình nhằm khai thác các tính năng kỹ thuật, tài nguyên máy tính.

Các em qsát trên thanh công việc, ở góc dưới bên trái có nut Start. Khi ấn nút Start thì bảng chọn Start xuất hiện.

Nghe giảng và ghi bài

Các ctrình này hoặc thể hiện bằng các biểu tượng trên màn hình nền hoặc có trong mục All Programs. Vào All Programs cta có thể khởi động được bất kỳ ctrình nào bằng cách nháy chuột vào biểu tượng tương ứng.

Các em sẽ được làm quen trong các bài thực hành sau:

Nghiên cứu sgk - 50

Qua n/cứu thanh công việc nằm ở vị trí nào trên màn hình.

Thanh công việc thường nằm ở đáy MH

Các em chú ý khi chạy 1 ctrình, biểu tượng của nó xuất hiện trên thanh công việc, em có thể thay đổi các ctrình đó bằng cách nháy chuột vào biểu tượng của ctrình tương ứng.

Trong Windows mỗi ctrình được thực hiện trong 1 cửa sổ riêng, người sử dụng giao tiếp với ctrình thông qua cửa sổ đó.

Các em qsát cửa sổ làm việc của ctrình word?

Quan sát, ghi bài

Giới thiệu: Thanh tiêu đề, thanh bảng chọn,

thanh công cụ, thanh cuốn dọc, ngang. Các cửa sổ trong HĐH Windows đều có điểm chung.

Nghe giảng

Đó là nội dung ghi nhớ.

Giới thiệu như 

Ghi bài

Đọc ghi nhớ.sgk – 51

Đọc ghi nhớ.

Chốt lại kiến thức của bài.
	1. Màn hình làm việc chính của windows:

10’
a) Màn hình nền

- Trên màn hình nền của Windows có chứa các biểu tượng và thanh công việc.

b) Một vài BT chính trên MH nền
My Computer, My Documents, Recycle Bin 

c) Các biểu tượng chương trình

Word, Paint, ...

2. Nút Start và bảng chọn Start: (12’)

Chứa các chương trình

- Nháy nút Start -> bảng chọn Start xuất hiện, bảng chọn này chứa mọi lệnh cần thiết để điều khiển Windows.

3. Thanh công việc: (8’)

- Thanh công thường nằm ở đáy màn hình.

-  Ngoài nút Start, trên thanh công việc còn chứa các nút chỉ các ctrình đang chạy.

4. Cửa sổ làm việc. 8’
Người sử dụng trao đổi thông tin với chương trình thông qua cửa sổ của nó.

* Ghi nhớ: SGK - 51


c) Củng cố, luyện tập. (1’) 

Qua bài học hôm nay các em biết và chỉ đúng tên các biểu tượng chính trên giao diện khởi động của hệ điều hành windows.

Biết được ý nghĩa của các khái niệm quan trọng sau của HĐH Windows màn hình nền (Desktop), thanh công việc (Task bar), nút Start, các biểu tượng chương trình ứng dụng và khái niệm cửa sổ (windows) trong hệ điều hành

d) Hướng dẫn học sinh học bài ở nhà: (1’)

- Học bài và làm bài tập 1, 2 sgk - 51

- Hướng dẫn bài 2 sgk - 51

- Mỗi cửa sổ đang mở sẽ được thể hiện bằng 1 nút trên thanh công việc.

- Học thuộc nội dung của bài trong vở ghi và xem thêm trong SGK.

- Chuẩn bị bài thực hành số 2 để tiết sau học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
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TIẾT 10: BÀI THỰC HÀNH 2:

LÀM QUEN VỚI HỆ ĐIỀU HÀNH WINDOWS

1. Mục tiêu:

a. Kiến thức: Củng cố cho hs các thao tác cơ bảnvới chuột, Thực hiện các thao tác vào\ ra hệ tống.
b. Kỹ năng: Làm quen với bảng chọn Start.

c. Thái độ:  Rèn tính tự giác cao trong quá trình học tập.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên:  Giáo án, SGK, phòng máy.

b) Học sinh:  Ôn bài, SGK, vở ghi

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ:  (4’)

Câu hỏi:

Có cách nào để biết rằng hiện tại em đang mở bao nhiêu cửa sổ trong Windows? Hãy nêu chi tiết cách nhận biết.

Yêu cầu trả lời:

Có, bằng cách qsát trên thanh công việc, mỗi cửa sổ đang mở sẽ được thể hiện bằng một nút trên thanh công việc.

? Nhận xét?


* Đặt vấn đề. (1’)

Hôm trước các em đã làm quen với hệ điều hành Windows, để vận dụng vào thực tế thì hôm chúng ta cùng nhau đi thực hành làm  quen với windows.
b) Dạy nội dung bài mới: 39’
	
	Hoạt động của GV và HS
	Ghi  bảng

	  ?

Gv

  ?

  ?

HS

GV

?

HS

GV

?


	Nhắc lại cách khởi động Windows?

Sau khi khởi động được Windows, các em qsát màn hình nền.

Phân biệt các biểu tượng và thanh công việc?

Mở bảng chọn Start làm như thế nào?

Nháy chuột vào nút Start.

Gthiệu cho hs nhận biết 1 số khu vực trong bảng chọn:

Khu vực1: Cho phép mở các thư mục chứâ dữ liệu chính của người dùng.

              2: All Programs.

              3: Các thành phần người dùng hay sử dụng trong thời gian ggàn đây.

              4: Các lệnh vào/ ra Windows

Để chọn mục nào đó các em làm ntn?

Nháy chuột lên biểu tượng của nó.

Khi được chọn thì biểu tượng hoặc mục trong bảng chọn sẽ đổi màu cho biết biểu tượng hay mục đượn chọn nhưng chưa được kích hoạt.

Muốn kích hoạt 1 ctrình nào đó, nháy đúp chuột hay chính là cách làm cho ctrình đó hoạt động. 
	1. Thực hành thao tác vào, ra Windows: (7’)

2. Làm quen với bảng chọn Start: (10’)



	GV
	Lưu ý: Trong qtrình thực hành các thao tác với chuột phải chính xác, dứt khoát. Tập chung vào 3 thao tác chính, nháy đúp và kéo thả.
	

	GV
	Chia lớp thành các nhóm mỗi nhóm 4 em và thực hành theo các mục GV đã hướng dẫn.
	

	HS

GV
	Thực hành

Quan sát lớp thực hành, hướng dẫn học sinh nếu cần.
	

	GV

HS

GV

GV

GV

GV

?

HS

GV

?

HS

  ?

HS


	Trên màn hình nền chứa 1 số biểu tượng ctrình, muốn chạy 1 ctrình em làm như thế nào?

...Nháy đúp chuột vào biểu tượng

 Khi nháy đúp chuột vào biểu tượng 1 cửa sổ mở ra. Trước tiên các em thực hành các biểu tượng.

 My Docments: Chứa tài liệu của người sd

 My Computer: Chứa biểu tượng ổ đĩa

Recycle: Chứa các tệp và thư mục đã xoá
   Yêu cầu HS thực hành nội dung sau.

Thực hiện các thao tác trên 1 lần, để hs thực hành theo nhóm đã phân công. kết thúc quy định gv ktra sắc xuất 1 số em của 1 số nhóm.

Các em đã thực hiện 1 số thao tác với biểu tượng, làm quen với cửa sổ.

Làm quen với cửa sổ các em thao tác như thế nào?

Kích hoạt biểu tượng ctrình.

Trên cửa sổ làm việc của ctrình các em nhận biết cho thầy thanh tiêu đề, thanh bảng chọn, thanh công cụ, thanh cuốn dọc, ngang.

Yêu cầu thực hành nội dung sau:

Thực hành

Để di chuyển cửa sổ làm như thế nào?

Chọn thanh tiêu đề của cửa sổ và kéo thả chuột đến vị trí mới.
	1. Thực hành 1 số thao tác với biểu tượng: (10’)

Chọn: Nháy chuột vào biểu tượng.

Kích hoạt: Nháy đúp chuột vào biểu tượng.

Di chuyển: Nháy chuột vào biểu tượng, thực hiện kéo thả để di chuyển đến vị trí mới.

2. Làm quen với cửa sổ: (9’)

- Nhận biết các thanh cuốn, các thanh tiêu đề,...

- Tìm các nút thu nhỏ, phóng to, đóng cửa sổ.

- Di chuyển cửa sổ.

	GV
	Gthiệu: ở trên thanh bảng chọn 1 số mục
	

	
	File: Chứa lệnh với tệp như tạo TM.
	

	HS

GV
	Edit: Chứa các lệnh sao chép, cắt dán.

View: Chọn cách biểu thị các biểu tượng trong cửa sổ.

Những nội dụng này các em được thực hành với bài tiếp theo.

Thực hành

Hướng dẫn học sinh thực hành.
	

	GV
	Hết giờ các em tắt phần mềm để nghỉ
	3. Kết thúc: (3’)

	HS


	Thực hiện tắt máy.
	- Kết thúc phiên làm việc:

Start -> Log off -> Log off.

- Ra khỏi hệ thống:

Start -> Turn off Cumputer ->Turn off


c. Củng cố, luyện tập. (1’) 

Qua  bài thực hành hôm nay các củng cố các thao tác cơ bản với chuột, thực hiện các thao tác cơ bản với cửa sổ, biểu tượng, thanh bảng chọn,... trong môi trường làm việc của Windows: Thao tác nhanh với hệ điều hành như là mở, đóng các cửa sổ, thao tác với nút Start.

d. Hướng dẫn học sinh tự học ở nhà. (1’)

· Ôn lại các thao tác với bảng chọn Start, biểu tượng, cửa sổ..

· Chuẩn bị câu hỏi, thắc mắc tiết sau chữa bài tập.

· Chuẩn bị bài thực hành 3 để tiết sau thực hành.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

	Ngµy so¹n:   17/ 9/ 2017
	Ngµy d¹y: 27/ 9/ 2017
	Líp 9A

	
	Ngµy d¹y: 25/ 9/ 2017
	Líp 9B


TIẾT 11: BÀI THỰC HÀNH SỐ 3

CÁC THAO TÁC VỚI THƯ MỤC

1. Mục tiêu:

a) Kiến thức. Học sinh làm quen với hệ thống quản lí tệp trong Windows XP. Biết sử dụng My Computer để xem nội dụng các thư mục.

b) Kỹ năng. Học sinh làm thành thạo thao tác xem, thuần thục các bước.

c) Thái độ. Giáo dục ý thức tổ chức, kỷ luật cao trong phòng máy.

2. Chuẩn bị của giáo viên và học sinh

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn lại các thao tác nháy chuột, cửa sổ My Computer.

3. Tiến trình bài dạy

a) Kiểm tra bài cũ

Kết hợp kiểm tra thông qua bài thực hành

* Đặt vấn đề. (1’)

Trong các tiết trước các em đã được biết như thế nào là hệ điều hành, hệ điều hành Windows, cách quản lý thông tin trong máy tính. Tiết này các em sẽ vận dụng các kiến thức đó để  thực hành.

b) Dạy nội dung bài mới: 42’
	
	Hoạt động của GV và HS
	Ghi bảng

	  ?

HS

GV

  ?

HS

GV

GV

?

HS

GV

GV

GV

HS

GV

  ?

  ?

 ?

HS
	Để xem các thông tin có trên máy tính các em chọn biểu tượng nào?

 ...Biểu tượng My Computer

Các em có thể sử dụng My Computer hay Windows XP để hiển thị các biểu tượng của ổ đĩa, thư mục và tệp trên các ổ đĩa đó.

Muốn sử dụng My Computer ta làm như thế nào?

Nháy đúp chuột vào biểu tượng.

Gthiệu các vùng, ngăn. Sau đó yêu cầu hs thực hành theo các bước sau:

Sau khi các em nháy chuột nút Folders thì cửa sổ My Computer được hiển thị dưới dạng 2 nhăn, ngăn bên trái cho biết cấu trúc các ổ đĩa và thư mục.

Muốn xem nội dung đĩa các em làm như thế nào?

...nháy chuột vào biểu tượng của ổ đĩa.

Nếu cửa sổ không đủ lớn chứa hết nội dung thư mục, em có thể kéo thanh cuốn 

Nếu thư mục có chứa thư mục con thì khi nháy chuột nút (+) đằng trước thư mục đấu có chuyển thành dấu (-) 

Yêu cầu các nhóm thực hành các thao tác trên đúng trình tự.

Thực hành theo nhóm

Kiểm tra từng nhóm.

*) Củng cố:  (4’)

Nắm được cách tổ chức sắp xếp thông tin trong máy tính (cửa sổ My Computer)

Nhắc lại các bước xem nội dung đĩa? các bước xem nội dung thư mục?

Muốn biết một thư mục có chứa thư mục con hay không các em làm như thế nào?

Trả lời
	1. Sử dụng My Computer: (7’)

- Nháy đúp chuột vào biểu tượng My Computer.

- Nháy nút Folders (thư mục) trên thanh công cụ.

2. Xem nội dung đĩa: (10’)

- Nháy đúp vào biểu tượng.

Nếu máy tính có các ổ đĩa khác, nháy đúp chuột vào biểu tượng ổ đĩa để xem nội dung.

3. Xem nội dung thư mục:  (10’)
- Nháy chuột và biểu tượng hoặc tên thư mục cần xem.

- Chọn các dạng hiển thị của biểu tượng hoặc thư mục ở các mức độ khác nhau, nháy chuột nút     (cạnh nút Folders)

- Trên thanh công cụ

+ Nút            Back: Hiển thị lại nội dung thư mục vừa xem trước.

+ Nút      : Xem thư mục mẹ của thư mục đang hiển thị.



	GV

HS

HS

GV

GV

GV

?

HS

GV

HS

GV


	- Mở cửa sổ thư mục sez chứa thư mục đó.

- Nháy nút phải chuột tại vùng trống trong cửa sổ t.mục -> New -> Folders -> 

Hộp chọn New Folders xuất hiện -> gõ tên thư mục em muốn đặt.

Thực hành

Lưu ý trong Windows tên của thư mục có thể dài 215 kí tự kể cả dấu cách. Tên thư mục không chứa các kí tự \, /, *, ?, ", <, >, không phân biệt chữ hoa, chữ thường.

Ktra việc tạo thư mục mới ở 1 số nhóm.

Thực hiện các thao tác trên 1 lần, yêu cầu hs thực hiện lại theo các thao tác trên theo nhóm.

Nếu nuốn sửa tên thì bước 3 dùng các phím mũi tên để di chuyển và các phím xoá để sửa.

…

Các em lưu ý những thư mục bị xoá nằm trong thùng rác, khi nào ta xoá nó ở thùng rác thì nó mới bị xoá thực sự.

…

Yêu cầu TH theo phần tổng hợp: (24’)

1. Sử dụng My Computer để xem nội dung đĩa C.

2. Tạo thư mục mới có tên NgocHa trong thư mục gốc C.

3. Đổi tên thư mục NgocHa thành Albun của em.
	4. Tạo thư mục mới: (5’)

- Mở cửa sổ thư mục sẽ chứa thư mục đó.

- Nháy nút phải chuột tại vùng trống đưa con trỏ New -> Folders rồi nháy chuột

-  Hộp chọn New Folders -> gõ tên của các em .

5. Đổi tên thư mục: (7’)

- Nháy chuột vào tên thư mục cần đổi tên.

- Nháy chuột vào tên thư mục một lần nữa.

- Gõ tên mới -> Enter hoặc nháy chuột tại 1 vị trí khác.

6. Xoá thư mục: (3’)

- Nháy chuột để chọn thư mục cần xoấ.

- ấn phím Delete




c) Củng cố, luyện tập :(1’)
Qua bài học hôm nay các em đã được thực hiện thành thạo các thao tác với thư mục.

d) Hướng dẫn học sinh học bài ở nhà: (1’)

- Làm thành thạo các yêu cầu tổng hợp.

- Đọc trước phần bài thực hành 4.

- Tiết sau thực hành tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

----------------------------------------------------------------------
	Ngµy so¹n:   27/ 9/ 2017
	Ngµy d¹y: 30/ 9/ 2017
	Líp 9A

	
	Ngµy d¹y: 30/ 9/ 2017
	Líp 9B


TIẾT 12 BÀI THỰC HÀNH SỐ 4

CÁC THAO TÁC VỚI TỆP TIN

1. Mục tiêu:

a) Kiến thức:  biết cách xem, đổi tên tệp tin, xoá tệp tin, sao chép tệp tin vào thư mục khác.

b) Kỹ năng: Rèn kỹ năng các thao tácđúng, nhanh, chính xác.

c) Thái độ: Nghiêm túc thực hành theo nội dung của bài, giữ gìn tốt phòng máy.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Vở ghi, ôn bài, SGK.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ:  (5’)

Câu hỏi:

Nêu các thao tác tạo một thư mục mới.

Yêu cầu trả lời:

Để tạo một thư mục mới:

- Mở cửa sổ thư mục sẽ chứa thư mục cần tạo.

- Nháy nút phải chuột tại vùng trống -> New -> Folder -> ghi tên thư mục cần tạo -> Enter.

* Đặt vấn đề. (1’)

Trong các tiết trước các em đã làm quen với các lệnh về tệp tin, thực hành các lệnh về thư mục. Bài hôm nay các em  thực hành các lệnh xem, xoa, tạo mới, đổi tên, sao chép, di chuyển tệp tin. 

b) Dạy nội dung bài mới. 37’
	
	Hoạt động của GV và HS
	Học sinh ghi

	GV 

HS

GV


	Các em ổn định chỗ ngồi , khởi động máy tính.

Khởi động máy tính.

Trong tiết học hôm trước các em đã được thực hành các thao tác với thư mục 
	* Khởi động máy tính (2’)

	  ?
	Nêu cách khởi động cửa sổ My Computer?
	1. Khởi động My Computer:  (5’)

	GV
	Mở một thư mục có chứa ít nhất một tệp tin, ví dụ thư mục My Documents
	

	  ?
	Tương tự như thư mục, các em có thể đổi tên và xoá một tệp tin?
	2. Đổi tên tệp tin, xoá tệp tin:  (5’)

	HS
	- Nháy chuột vào tên tệp.

- Nháy chuột vào tên một lần nữa.

- Gõ tên mới rồi ấn Enter.
	- Nháy chuột vào tên tệp.

- Nháy chuột vào tên một lần nữa.

- Gõ tên mới rồi ấn Enter.

	GV
	Lưu ý không nên đổi phần mở rộng của tên tệp tin.
	

	GV
	Thực hiện các thao tác mẫu 1 lần.

Yêu cầu hs thực hành theo nhóm đã được phân công.
	

	HS
	Thực hành
	

	GV
	Kiểm tra, hướng dẫn các nhóm làm.
	

	  ?
	Để xoá tệp tin vừa tạo các em làm như thế nào?
	*) Xoá tệp tin: (4’)

	HS
	- Nháy chuột để để chọn tệp tin cần xoá.

- Nhấn phím Delete.
	

	GV
	Các em thực hành xoá tệp tin vừa tạo.
	

	HS
	Thực hành
	

	GV
	Lưu ý cho hs cũng như với thao tác xoá thư mục, sau khi nhấn phím Delete tệp tin sẽ được đưa vào Recycle Bin.
	

	GV
	Kiểm tra việc thực hành của các nhóm. Lưu ý không được xoá tệp, thư mục trong HĐH
	3. Sao chép tệp tin vào TM khác: (4’)

	GV
	Muốn sao chép tệp tin vào thư mục khác các em làm như sau:

- Chọn tệp tin cần sao chép.

- Edit -> Copy.

- Chuyển đến thư mục sẽ chứa tệp mới.

- Edit -> Paste.
	

	GV
	Hướng dẫn các em thực hành:

Chia nhóm, hs TH theo nhóm.

Lưu ý: - Các em không thao tác với các tệp, TM hệ thống của HĐH, làm cho HĐH bị hỏng. Nhất là thao tác xoá tệp hay thư mục.

- Chỉ thực hiện tên tệp mà các em tự tạo.

*) Củng cố?
	

	  ?
	Nhắc lại các t/tác đổi tệp tin, xoá tệp tin?
	

	  ?

HS
	Các bước sao chép tệp tin và thư mục khác?
	

	GV

HS

GV

HS

GV

HS

GV

HS

GV

HS

GV

GV

HS

GV

HS

GV

GV


	Chiếu lên bảng phụ ghi các bước đổi tên tập tin. Gọi HS đọc trên bảng phụ.

Đọc: 

Một em nhắc lại các bưới trên

Nhắc lại các bước đổi tên tập tin.

Các em nghiên cứu Ví dụ: Đổi tên tập tin  

Nghiên cứu

Yêu cầu HS hoạt động nhóm.

Hoạt động nhóm. 

Gọi đại diện nhóm trình bày.

Đại diện nhóm trình bày.

Tương tự như thao tác với thư mục các em có lệnh xoá tệp tin.

 Nêu các bước xoá tập tin?

Trả lời: 

Gọi HS khác bổ sung.

Trả lời: 

 Bổ sung và chốt.

 Các em chuyển sang lệnh sao chép tập tin
	4, Các bước đổi tên tệp tin. 2’

B1: Nhấn nút phải chuột lên tập tin cần đổi tên.

B2: Chọn lệnh Rename.

B3: Nhập tên mới.

B4: Nhấn Enter.

 5.Ví dụ: 4’
 Đổi tên tập tin  C:\Bai 1.doc thành C:\bai 2.doc.

B1: My Computer -> C Nhấn nút phải chuột lên tập tin Bai 1.doc

B2: Chọn lệnh Rename.

B3: Nhập tên mới: Bai 2.doc

B4: Nhấn Enter.

3. Các bước xoá tập tin: 4’
B1: Nhấn nút phải chuột lên tập tin cần xoá.

B2: Chọn lệnh Delete. Xuất hiện hộp thoại.

B3: Chọn Yes.

	GV

HS

GV

HS

GV
	Nêu các bước sao chép ( di chuyển) tập tin?

Trả lời.

Các em thực hành các lệnh trên.

Thực hành.

Quan sát lớp thực hành, hướng dẫn học sinh ( nếu cần)
	4. Sao chép, di chuyển tệp tin. 4’
B1: Chọn tệp tin cần sao chép ( di chuyển)

B2: Nháy chuột phải vào tên tệp tin cần sao chép( di chuyển), chọn copy (cut).

B3: Nháy chột phải vào thư mục cần dán tệp tin vừa chọn, nháy Paste

*) Thực hành. 5’


c. Củng cố, luyện tập: (1’)

              Qua bài học hôm nay các em đã được thực hành các lệnh về thư mục như đổi tên, xóa, sao chép, di chuyển tệp tin. 

d. Hướng dẫn học sinh tự học ở nhà: (1’)

Học bài trả lời các câu hỏi và bài tập.

Xem lại các thao tác đã thực hành.

Ôn tập kiến thức đã học, tiết sau kiểm tra một tiết.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

------------------------------------------------------------------

	Ngµy so¹n:   30/ 9/ 2017
	Ngµy d¹y: 04/ 10/ 2017
	Líp 9A

	
	Ngµy d¹y: 02/ 10/ 2017
	Líp 9B


TIẾT 13: LÀM QUEN VỚI SOẠN THẢO VĂN BẢN

1. Mục tiêu:

a) Kiến thức: Học sinh biết được vai trò của phần mềm soạn thảo văn bản, biết Microsoft Word (gọi tắt là Word) là phần mềm soạn thảo văn bản, nhận biết được biểu tượng của Word & biết thực hiện thao tác khởi động Word.Hiểu được vai trò của các bảng chọn & các nút lệnh, tác dụng của các nút lệnh trên thanh công cụ và lệnh tương ứng trong bảng chọn & cách SD các nút lệnh trên thanh công cụ.

b) Kỹ năng: HS nhận biết & phân biệt được các thành phần cơ bản của cửa sổ Word: Thanh bảng chọn, Các nút lệnh trên thanh công cụ,....

c)  Thái độ: Học sinh cần có thái độ nghiêm túc trong giờ học, thấy được 

2. Chuẩn bị của giáo viên và học sinh

a) Giáo viên: Giáo án, SGK.

b) Học sinh: Vở ghi, vở bài tập, SGK.

3. Tiến trình bài dạy

a) Kiểm tra bài cũ: Không

* Đặt vấn đề. (2’)
      Như các em đã biết các cuốn sgk, tạp trí, ... đều gọi chung là các văn bản, để có được các văn bản đó các tác giả biên soạn, các nhà xuất bản phải soạn thảo VB. Vậy soạn thảo VB là gì? Các em sẽ n\cứu trong chương 4 này. Trước đây có rất nhiều cách thức soạn thảo VB như sắp chữ, viết, ... với cách làm truyền thống đó người soạn thảo gặp rất nhiều khó khăn, cũng xuất phát từ những khó khăn đó cùng với sự phát triển như vũ bão của KHCN trên thị trường xuất hiện các phần mềm soạn thảo văn bản và những tính năng ưu việt của chúng. một trong những phần mềm soạn thảo VB được ưa chuộng hiện nay là phần mềm Microsoft Word.  

b) Dạy nội dung bài mới: 41’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV

  ?

HS

GV

GV

  ?

HS

GV

?

HS

GV

  ?

HS

GV

  ?

HS

GV

GV
	Giới thiệu như sgk: Các em đã thường xuyên tiếp xúc với nhiều VB: Sách, báo, vở,... các em không chỉ xem mà còn có thể tự mình tạo ra 1 VB.

Ta có thể tạo ra 1 VB bằng cách nào?

... viết, sắp chữ

Ngoài các cách đó ra ta có thể sử dụng MT & phần mềm soạn thảo VB để tạo ra 1 VB. 

Gthiệu phần mềm Microsoft Word

vậy muốn khởi động phần mềm này các em làm như thế nào?

Nháy đúp chuột vào biểu tượng của phần mềm hoặc nháy nút Start -> All Prorgam -> Microsoft Word

Sau khi khởi động, Word mở 1 VB trống có tên tạm thời là Document 1, sẵn sàng để các em nhập nội dung VB.

Các em qsát cửa sổ của Word sgk - 64 cho biết trên cửa sổ có những gì?

- Thanh tiêu đề.

- Thamh công cụ.

- các nút lệnh.

- Thanh cuốn dọc, ngang.

- Vùng soạn thảo VB.

- Con trỏ soạn thảo.

 Các em qsát thanh bảng chọn có chứa các bảng chọn được sắp xếp theo từng nhóm: Filr, Edit, View, Insert,...

Muốn thực hiện 1 lệnh nào đó ta làm như thế nào?

...ta nháy chuột vào tên bảng chọn đó.

KHi nháy chuột vào bảng chọn nào thì bảng chọn đó mở ra, các em qsát bảng chọn File đang được mở.

Các nút lệnh nằm ở vị trí nào?

Thường nằm trên thanh công cụ. Mỗi nút lệnh đều có tên để phân biệt.

Chỉ vào nút lệnh gthiệu tên cho hs biết

New - Mở 1 VB mới

Open - Mở tệp VB có sẵn trên máy

Save - Ghi

Print - Lệnh in

Các em sẽ được làm quen ở bài t/hành sau

Nếu các em nháy chuột New trên thanh công cụ 1 VB mới được mở ra. Lệnh này tương tự như ta sử dụng bảng chọn File 

-> New được 1 VB mới.
	1. Văn bản và phần mềm soạn thảo văn bản: (8’)

- Microsoft Word là phần mềm soạn thảo văn bản do hãng  Microsoft phát hành (gọi tắt là Word) 

2. Khởi động Word: (19’)

Có 2 cách: 

C1: Nháy đúp chuột vào biểu tượng W của word trên màn hình nền.

C2: Nháy nút Start/ All Program chọn Microsoft word.

3. Có gì trên cửa sổ của Word: (23’)

a) Bảng chọn:

- Các bảng chọn Filr, Edit, View, Insert,... nằm trên thanh bảng chọn

b) Nút lệnh:

- Các nút lệnh thường được đặt trên thanh công cụ. Mỗi nút lệnh đều có 1 tên để phân biệt.


c) Củng cố, luyện tập. (1’) 

Qua bài hôm nay các em đã nắm được cách khởi động Word, các thanh trên cửa sổ của Word. (1’)

d. Hướng dẫn học sinh tự học bài ở nhà. (1’)

- Làm câu hỏi 1, 2, 3, 4 (sgk - 68), đọc bài đọc thêm. Hướng dẫn bài 4 sgk – 68. Các em tìm từ đúng điền vào các chỗ trống:Thanh công cụ gồm các nút lệnh. Đọc trước các phần còn lại để tiết sau học tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
------------------------------------------------------------------

	Ngµy so¹n:   04/ 10/ 2017
	Ngµy d¹y: 07/ 10/ 2017
	Líp 9A

	
	Ngµy d¹y: 07/ 10/ 2017
	Líp 9B


TIẾT 14: LÀM QUEN VỚI SOẠN THẢO VĂN BẢN (TIẾP)

1/ Mục tiêu :


a) Kiến thức: Biết cách tạo VB mới, mở VB đã được lưu trên máy, lưu VB và kết thúc phiên làm việc với Word.

b) Kỹ năng: Rèn hs tính tư duy lô gic, tắt mở thành thạo phầm mềm Word .

c) Thái độ: Nghiêm túc trong giờ học, tự so sánh với soạn thảo văn bản bằng bút, từ đó thấy được những ưu điểm của phần mềm soạn thảo văn bản nhờ máy tính.

2. Chuẩn bị của giáo viên và học sinh

a) Giáo viên: Giáo án, SGK.

b) Học sinh: Vở ghi, vở bài tập, SGK.

3. Tiến trình bài dạy

a) Kiểm tra bài cũ:(5’)

Câu hỏi:

Em hãy liệt kê 1 số thành phần cơ bản trên cửa sổ của Word? Trên thanh công cụ khi sử dụng nút lệnh New sẽ tương ứng với lệnh nào của bảng chọn?

Đáp án:

Một số thành phần cơ bản của cửa sổ Word: Thanh tiêu đề, thanh bảng chọn, các nút lệnh trên thanh công cụ, vùng soạn thảo, các thanh cuốn. 

Khi sử dụng nút lệnh New trên thanh công cụ,tương ứng với việc sử dụng bảng chọn File -> New trên thanh bảng chọn.

? Nhận xét bài của bạn?

* Đặt vấn đề. (1’)


Bài hôm nay các em tiếp tục làm quen các thao tác soạn thảo văn bản.

b) Dạy nội dung bài mới. 37’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV

  ?

HS

GV

  ?

GV

HS

GV

GV

  ?

  ?

HS
	ở tiết trước khi học các nút lệnh và tên gọi của mỗi nút, qua nghiên cứu sgk và bài học trước 

muốn mở 1 VB có sẵn trong máy tính các em làm như thế nào?

Nháy chuột lên nút lệnh Open

Sau khi nháy chuột Open, hộp thoại Open mở ra, trong hộp thoại có chứa các tệp thư mục, muốn chọn tệp hay thư mục nào các em chỉ việc nháy chuột vào thư mục đó, nháy nút Open để mở.

Sau khi mở VB các em có thể gõ nội dung mới hoặc chỉnh sửa nội dung VB.

Vậy sau khi mở VB -> chỉnh sửa được nội dung Vb, muốn lưu VB đó các em làm như thế nào?

Dùng nút lệnh Save trên thanh công cụ . 

Sau khi dùng nút lệnh Save hộp thoại Save As xuất hiện -> gõ tên VB cần lưu vào ô File name -> ấn nút Save.

 Các em lưu ý nếu tệp VB đã được lưu ít nhất một lần thì cửa sổ Save As không xuất hiện, mọi thay đổi sẽ được lưu trên chính tệp VB đó.    

Các em làm bài 5 (sgk - 68)

Nêu yêu cầu của bài?

Đánh dấu lựa chọn đúng trong các câu sau:

1. Open

2. Save

3. New
	4. Mở văn bản: (12’)

- Để mở tệp vb dùng nút lệnh Open 1 hộp thoại xuất hiện chọn VB cần mở -> nháy chuột nút Open.

5. Lưu văn bản:  (17’)

- Để lưu vb dùng nút Save trên thanh công cụ, hộp thoại Save As xuất hiện -> gõ tên VB cần lưu vào ô file name, nháy Save để lưu.

*) Bài 5 (sgk - 68)



	  ?
	Vậy khi sử dụng các nút lệnh này theo em nhận thấy tác dụng gì?
	

	HS
	...giúp cho việc làm nhanh, gọn & chính xác hơn, tiết kiệm được thời giang làm việc
	

	  ?
	Muốn kết thúc việc soạn thảo và đóng VB các em làm như thế nào
	6. Kết thúc: (5’)

	HS
	Đóng nút X ở góc phải màn hình
	

	GV
	Các em qsát đóng VB Và kết thúc soạn thảo trong sgk - 67
	*) Ghi nhớ:  (sgk - 67)   3’

	HS
	Đọc ghi nhớ.
	


c) Củng cố, luyện tập. (1’) 

Qua bài học hôm nay các em cần nắm cách tạo văn bản mới, mở văn bản đã được lưu trên máy, lưu văn bản và kết thúc phiên làm việc với Word.

d. Hướng dẫn học sinh tự học bài ở nhà. (1’)

- Học thuộc bài trong vở ghi, xem thêm trong SGK

- Xem lại các thao tác định dạng và các hàm đã làm.

- Xem lại các kiến thức cũ như: Sắp xếp, lọc dữ liệu và tạo biểu đồ.

- Đọc trước bài  soạn thảo văn bản đơn giản, để tiết sau học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

---------------------------------------------------------------------------

	Ngµy so¹n:   06/ 10/ 2017
	Ngµy d¹y: 09/ 10/ 2017
	Líp 9A

	
	Ngµy d¹y: 11/ 10/ 2017
	Líp 9B


TIẾT 15 BÀI 14: SOẠN THẢO VĂN BẢN ĐƠN GIẢN

1.  Mục tiêu :

a) Kiến thức:  HS biết được các thành phần cơ bản của một văn bản, nhận biết được con trỏ soạn thảo, vai trò của nó cũng như cách di chuyển con trỏ soạn thảo, biết các quy tắc soạn thảo văn bản trong word, biết cách gõ văn bản tiếng việt.

b) Kỹ năng: Bắt đầu hình thành kỹ năng soạn thảo văn bản nhờ máy tính điện tử.

c) Thái độ: Nghiêm túc trong học tập, yêu thích môn tin nhờ những ưu điểm của nó cụ thể là soạn thảo văn bản.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, máy chiếu

b) Học sinh: Ôn bài và đọc trước bài mới, SGK., vở ghi.

3. Tiến trình bài dạy

a) Kiểm tra bài cũ. Xen kẽ trong giờ học     

* Đặt vấn đề. (1’)

   Trong bàn phím máy tính không có các chữ cái như là: Â, Ă, Ê, Ô, Ơ, Ư, và các dấu hỏi, nặng, sắc, huyền, ... Vậy làm thế nào để có thể gõ được chữ tiếng việt bằng máy tính. Để trả lời câu hỏi đó chúng ta nghiên cứu bài hôm nay.

b) Dạy nội dung bài mới: 42’
	
	Hoạt động của GV và HS
	Ghi bảng

	  ?

HS

GV

  ?
	Nhắc lại các thành phần của một vb trong tiếng việt?

...từ, câu, đoạn văn

Ngoài các thành phần trên khi soạn thảo văn bản trong máy tính các em còn phân biệt kí tự, dòng, đoạn và trang. Các em nghiên cứu sgk - 71

Vậy kí tự là gì? 
	1. Các thành phần của văn bản: (10’)

 a) Ký tự:

 Là con chữ, số, ký tự...là thành phần cơ bản nhất của vb.

VD:  n, 5,   ....là các ký tự.

	  ?

  ?

  ?

HS

GV
	Dòng là gì?

Thế nào là đoạn?

KHi soạn thảo VB bằng Word muốn kết thúc 1 đoạn VB các em làm như thế nào?

ấn phím Enter.

Ngoài kí tự, dòng, đoạn còn có trang VB.
	b) Dòng:

 Là tập hợp các kí tự nằm / cùng 1 đường ngang từ lề trái sang lề phải.

c) Đoạn:

 Nhiều câu liên tiếp, có liên quan với nhau & hoàn chỉnh về ngữ nghĩa nào đó tạo thành 1 đoạn vb.

d) Trang:

 Văn bản / 1 trang in được gọi là trang văn bản.

	GV
	Yêu cầu hs nghiêng cứu sgk - 71
	2. Con trỏ soạn thảo: 8’

	  ?
	Qua nghiên cứu cho biết con trỏ soạn thảo văn bản là gì?
	- Con trỏ soạn thảo là một vạch đứng nhấp nháy trên màn hình.

	HS
	Trong khi gõ VB, con trỏ soạn thảo sẽ di chuyển từ trái sang phải và tự

động suống dòng mới nếu nó đến vị trí cuối dòng.
	

	  ?
	Em hãy phân biệt con trỏ chuột với con trỏ soạn thảo?
	* Lưu ý: (sgk - 71).



	HS


	Con trỏ chuột có hình dạng       , I,..   

có thể ở bất kỳ vị trí nào trên màn hình. 

Con trỏ soạn thảo: Chỉ vạch đứng nhấp nháy trong vùng soạn thảo VB
	

	GV
	Muốn chèn kí tự (hoặc đến 1 vị trí nào đó) ta di chuyển con trỏ tới vị trí đó bằng các phím mũi tên. Ngoài ra còn có thể sử dụng phím

Home, End,...trên bàn phím
	

	GV
	Các quy tắc gõ VB trong Word:

- Các dấu ngắt câu., :, ;, !, ? phải được đặt sát vào từ đứng trước nó.

 - Các dấu mở ngoặc đặt sát bên trái kí tự đầu tiên, các dấu đóng ngoặc đặt sát bên phải của kí tự cuối cùng của từ ngay trước đó.

 
	3. Quy tắc gõ văn bản trong word:

10’
- Các dấu ngắt câu., :, ;, !, ? phải được đặt sát vào từ đứng trước nó.

- Các dấu mở ngoặc đặt sát bên trái kí tự đầu tiên, các dấu đóng ngoặc đặt sát bên phải của kí tự cuối cùng của từ ngay trước đó.

- Giữa các 

	  ?
	Các em qsát cách gõ sai, gõ đúng trong sgk - 72.
	

	
	
	4. Gõ văn bản chữ việt: (sgk - 73)  9’

	GV
	Các em nghiên cứu hai kiểu gõ phổ biến nhất hiện nay là Telex và Vni sgk - 73
	Để có chữ 

   ă  gõ  aw   ;      ơ   gõ   ow

   â        aa     ;      đ         dd       

   ô        oo     ;      ư         uw

   ê          ee 

	  ?

GV
	Nếu cách gõ kiểu Telex

Lưu ý: sgk - 74
	Để có dấu ( \ )  gõ   f    ;  ( / ) gõ  s

                  ( . )         j    ;  ( ? )       r

                   ( ~ )        x

	  ?
	Các em n/c nội dung bài 2 (sgk - 74)
	*) Ghi nhớ: sgk - 74

	HS
	"Ngày nay khi soạn thảo văn bản chúng ta thường sử dụng máy tính"
	Bài2: sgk - 74  (5’) 

	
	Có 3 lỗi: 

- lỗi 1 và 3 giữa 2 từ chưa có kí tự trống..

- Lỗi 2 sau khi đánh dấu ( , ) phải có kí tự trống mới gõ tiếp từ chúng.
	

	GV
	Ngoài ra Word xem dãy kí tự đứng giữa 2 dấu cách là 1 từ 

VD: Khisoạn - máy coi đây là 1 từ
	


c) Củng cố, luyện tập. (1’) 

Qua bài học hôm nay các em cần nắm được các thành phần cơ bản của một văn bản, con trỏ soạn thảo, vai trò của nó cũng như cách di chuyển con trỏ soạn thảo, biết các quy tắc soạn thảo văn bản bằng word,  cách gõ văn bản tiếng việt 
d. Hướng dẫn học sinh tự học bài ở nhà. (1’)

- Học thuộc quy tắc gõ văn bản trong Word, gõ văn bản chữ việt .

- Học thuộc ghi nhớ và làm bài tập 6 sgk - 68.

- Đọc trước bài mới, đọc bài đọc thêm 5 (sgk - 68)

- Làm các câu hỏi 3, 4, 5, 6 (sgk - 74).

- Tiết sau lên máy thực hành.   

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

-----------------------------------------------------------------------------

	Ngµy so¹n:   11/ 10/ 2017
	Ngµy d¹y: 14/ 10/ 2017
	Líp 9A

	
	Ngµy d¹y: 14/ 10/ 2017
	Líp 9B


TIẾT 16: BÀI THỰC HÀNH 5:

VĂN BẢN ĐẦU TIÊN CỦA EM

1. Mục tiêu:

a) Kiến thức: HS  Làm quen và tìm hiểu cửa sổ làm việc của word, các bảng chọn, một số nút lệnh, làm quen với vị trí các phím trên bàn phím và biết gõ chữ việt bằng một trong hai cách gõ Telex.

b) Kỹ năng: Hình thành kỹ năng soạn thảo bằng máy vi tính, soạn thảo bằng mười đầu ngón tay.

c) Thái độ: Học sinh cần có thái độ đúng đắn trong thực hành, rèn tính cẩn thận, chịu khó, trung thực

2. Chuẩn bị của giáo viên và học sinh

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn tập.

3. Tiến trình bài dạy

a) Kiểm tra bài cũ.

Kết hợp với bài thực hành

* Đặt vấn đề. (1’)

Để vận dụng các kiến thức về soạn thảo văn bản trong Word. Bài hôm nay chúng ta thực hành soạn thảo văn bản đầu tiên của em.

b) Dạy nội dung bài mới: 42’
	
	Hoạt động của Gv và HS
	Học sinh ghi

	  ?


	Để k/động Word các em làm như thế nào?
	1. Khởi động word & tìm hiểu các tthành phần trên màn hình của Word: (15’)

	HS
	Nháy đúp chuột vào biểu tượng của Word trên màn hình nền.

Hoặc Start -> All Program -> Microsoft Word
	

	GV
	Các nhóm thực hiện khởi động Word
	

	HS
	Thực hành
	

	  ?
	Các em qsát trên cửa sổ của Word nhận biết các thành phần sau:

- Bảng chọn và thanh bảng chọn. Mở 1 vài bảng chọn.

- Phân biệt các nút lệnh, t5hanh công cụ

- Tìm hiểu 1 số chức năng của bảng chọn File: Mở, đóng và lưu văn bản.

- Chọn File -> Open và nháy nút lệnh Open trên thanh công cụ để suy ra lệnh trong bảng chọn và nút lệnh có sự tương tư.
	

	HS
	Thực hành theo yêu cầu trên
	

	GV
	Qsát hướng dẫn các nhóm - nhận xét
	

	  ?
	Nêu cách gõ văn bản tíng việt theo kiểu telex?
	2. Soạn một VB đơn giản: (27’)

	HS
	Nêu lại cách gõ.
	

	  ?
	Các nhóm gõ đoạn văn "Biển đẹp" sgk - 77

Chú ý gõ chính xác mười ngón.
	

	HS
	Thực hành
	

	GV
	Qsát các nhóm gõ xong hoặc chưa xong mà biết thời gian,  hướng dẫn các em lưu VB theo tên nhóm, lớp.

Nháy chuột nút lệnh Save (hoặc File -> Save) -> gõ tên cần lưu -> ấn nút Save trên hộp thoại.
	


c) Củng cố, luyện tập. (1’)  

Qua bài thực hành hôm nay các em đã được làm quen và tìm hiểu cửa sổ làm việc của word, các bảng chọn, một số nút lệnh, làm quen với vị trí các phím trên bàn phím và biết gõ chữ việt bằng một trong hai cách gõ Telex.

d) Hướng dẫn học sinh tự học bài ở nhà: (1’)

    - Ôn lại cách khởi động Word, nhận biết các thành phần trên cửa sổ Word.

    - Tiết sau thực hành tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

	Ngµy so¹n:   13/ 10/ 2017
	Ngµy d¹y: 18/ 10/ 2017
	Líp 9A

	
	Ngµy d¹y: 16/ 10/ 2017
	Líp 9B


TIẾT 17: BÀI THỰC HÀNH 5:

VĂN BẢN ĐẦU TIÊN CỦA EM  (TIẾP)

1. Mục tiêu:

a) Kiến thức: HS bước đầu biết tạo văn bản, lưu văn bản, hiển thị văn bản ở các chế độ khác nhau; Phóng to, thu nhỏ kích thước màn hình soạn thảo; đóng văn bản, thoát khỏi Word.

b) Kỹ năng:  Rèn kỹ năng vận dụng lý thuyết vào thực hành.

c) Thái độ: Học sinh cần có thái độ nghiêm túc trong giờ thực hành, giữ gìn trật tự, bảo vệ phòng máy.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn tập.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ.

Kết hợp với bài thực hành

* Đặt vấn đề.(1’)

Bài hôm nay các em thực hành tiếp các thao tác soạn thảo văn bản Word.

b) Dạy nội dung bài mới: 42’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV

HS 

GV


	Các em khởi động máy tính.

Khởi động máy tính

Yêu cầu hs mở lại văn bản "biển đẹp", gõ lại phần văn bản còn lại và Lưu thêm
	* Khởi động máy tính. 2’


	HS
	Thực hành
	3. Tìm hiểu cách di chuyển con trỏ soạn thảo và các cách hiển thị văn bản. 

	GV
	- Các em tập di chuyển con trỏ soạn thảo trong văn bản bằng chuột và các phím mũi tên đã nêu trong bài.

- Sử dụng các thanh cuốn để xem các phần ( nhau của văn bản khi được phóng to

- Hướng dẫn các em các cách để hiển thị văn bản: View -> Normal

                Vew -> Print Layout

                 View -> Outline

Nháy lần lượt các nút trên thanh cuốn.

- Thu nhỏ kích thước màn hình soạn thảo.
	

	HS

GV
	Các nhóm thực hành.

 Quan sát hướng dẫn các nhóm thực hành.
	* Thực hành.  37’

	GV
	Các em lưu hoàn chỉnh bài "Biển đẹp" với tên của nhóm mình.
	

	  ?
	Các em đóng cửa sổ văn bản và thoát khỏi Word?
	 * Thoát khỏi cửa sổ Word (3’)

	HS
	File -> Edit.
	


c) Củng cố, luyện tập. (1’) 

Qua bài thực hành hôm naycác em cần nhớ các thao tác tạo văn bản, lưu văn bản, hiển thị văn bản ở các chế độ khác nhau; phóng to, thu nhỏ kích thước màn hình soạn thảo; đóng văn bản, thoát khỏi Word., rèn kỹ năng vận dụng lý thuyết vào thực hành.

d) Hướng dẫn học sinh tự học bài ở nhà: (1’)

- Ôn lại các quy tắc gõ văn bản trong Word.

- Đọc trước bài mới.

- Tiết sau học bài chỉnh sửa văn bản.

    - Tiết sau thực hành tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
--------------------------------------------------------------------------------

	Ngµy so¹n:   18/ 10/ 2017
	Ngµy d¹y: 21/ 10/ 2017
	Líp 9A

	
	Ngµy d¹y: 21/ 10/ 2017
	Líp 9B


TIẾT 18 BÀI 15: CHỈNH SỬA VĂN BẢN

1. Mục tiêu:

a) Kiến thức: HS được làm quen với các thao tác cơ bản trong biên tập văn bản: Xoá, chèn và chọn phần văn bản.
b) Kỹ năng: Nhận biết và biết cách sử dụng các lệnh xoá, chèn, chọn phần văn bản trong quá trình chỉnh sửa văn bản.

c) Thái độ: Giáo dục tính tỉ mỉ, cẩn thận và kiên nhẫn.
2.  Chuẩn bị của giáo viên và học sinh :

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn các cách gõ văn bản trong Word, SGK.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ. (5’)

Câu hỏi:  Em hãy nêu cách mở 1 văn bản có sẵn trong máy tính? Có mấy cách mở?

Đáp án:

Để mở 1 văn bản có sẵn trong máy tính: Nháy chuột File -> Open -> chọn văn bản cần mở -> nháy chuột nút Open trên hộp thoại.

Hoặc: ấn nút Open trên thanh công cụ -> nháy chuột vào tên văn bản cần mở -> nháy chuột nút Open trên hộp thoại.

Có 2 cách mở.

* Đặt vấn đề. (1’)

Bài trước chúng ta đã bước đầu làm quen với soạn thảo văn bản. Trong tiết học hôm nay chúng ta sẽ làm quen với các thao tác cơ bản trong biên tập văn bản như: Xoá, sao chép và di chuyển các phần văn bản.

b) Dạy nội dung bài mới: 37’
	
	Hoạt động của GV và HS
	Ghi bảng

	   ?

HS

GV

  ?


	Để xoá 1 kí tự em có thể dùng những phím xoá nào?

Phím Backspace hoặc Delete

Phím Backspace(() dùng để Xoá kí tự ngay trước con trỏ soạn thảo 

phím Delete dùng để Xoá kí tự ngay sau con trỏ soạn thảo.

Các em qsát xoá 1 vài kí tự trong trường hợp dùng Backspace, Delete 
	1. Xoá và chèn thêm văn bản:  (18’)



	HS
	Qsát sgk - 78
	

	GV


	Muốn chèn thêm văn bản vào 1 vị trí, em di chuyển con trỏ vào vị trí đó và có thể sử dụng bàn phím để gõ nội dung cần bổ xung.
	

	  ?
	Trong trường hợp muốn xoá phần lớn, hay nhiều đoạn trong văn bản, các em sử dụng cách làm nào cho nhanh nhất?
	

	HS


	Chọn phần văn bản cần xoá (bôi đen) dùng Backspace hoặc Delete để xoá.
	

	GV
	Các em lưu ý hãy suy nghĩ cẩn thận trước khi xoá nội dung v bản
	

	  ?
	Vậy việc chọn phần văn bản các em thao tác như thế nào?
	2. Chọn phần văn bản:  (19’)

	GV
	Các em nghiên cứu sgk - 79
	

	  ?
	Qua n/cứu để chọn phần văn bản các em làm như thế nào?
	

	HS
	Bước1:Nháy chuột tại vị trí bắt đầu

Bước2: Kéo thả chuột -> phần cuối văn bản cần chọn.
	

	GV
	Đây chính là 2 bước để chọn phần văn bản như xoá, chuyển vị trí, thay đổi cách trình bày...

Nếu thực hiện 1 thao tác mà kết quả không được như ý muốn, em có thể khôi phục trạng thái của văn bản bằng cách nháy nút lệnh Undo.
	

	  ?
	Các em qsát việc huỷ bỏ thao tác sai trong hình minh hoạ sgk - 79?
	

	HS
	Quan sát
	

	GV
	Chốt lại: Qua đây các em nắm rõ muốn máy tính thực hiện 1 điều gì đó thì cần đưa ra yêu cầu rõ ràng tên thao tác (sao chép, xoá, di chuyển,...) mà chỉ rõ đối tượng (phần văn bản) được tác động đến bằng cách chọn (bôi đen) nó. Điều này không chỉ đúng khi soạn thảo văn bản mà nó còn đúng với các phần mềm khác.
	

	  ?

HS
	Nếu sự giống nhau và khác nhau về chức năng của phím Delete và phím Backspace trong soạn thảo văn bản.
	


c) Củng cố, luyện tập 

Qua bài học hôm nay các em đã được làm quen với các thao tác cơ bản trong biên tập văn bản: Xoá, chèn và chọn phần văn bản, biết cách sử dụng các lệnh xoá, chèn, chọn phần văn bản trong quá trình chỉnh sửa văn bản.
d) Hướng dẫn học sinh tự học bài ở nhà: (1’)

     - Học thuộc bài trong vở ghi,xem thêm trong SGK, phân biệt chức năng của phím Delete và phím Backspace.

     - Ôn các thao tác để chọn phần văn bản.

     - Đọc trước các phần còn lại của bài để tiết sau học tiếp.

    - Tiết sau thực hành tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

----------------------------------------------------------------------------------
	Ngµy so¹n:   21/ 10/ 2017
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Tiết 19 Bài 15: CHỈNH SỬA VĂN BẢN (Tiếp)

1. Mục tiêu:

a) Kiến thức: HS được làm quen với các thao tác sao chép, di chuyển phần văn bản từ vị trí này sang vị trí khác.
b) Kỹ năng:  Kỹ năng phân biệt và sử dụng các thao tác.

c) Thái độ: Giáo dục cho học sinh ý nghĩa của việc soạn thảo văn bản bằng máy tính.
2.  Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn bài, SGK.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ. (5’)

Câu hỏi:

Nêu sự giống và khác nhau về chức năng của phím Delete và phím Backspace trong soạn thảo văn bản?

Yêu cầu trả lời:

- Giống nhau: Dùng để xoá một vài kí tự.

- Khác nhau: Delete - Xoá kí tự ngay đằng sau con trỏ soạn thảo.

                     Backspace - Xoá kí tự đằng trước con trỏ soạn thảo.

* Đặt vấn đề. (1’)


Bài hôm nay các em tiếp tục thực hành các thao tác chỉnh sửa vân bản.

b) Dạy nội dung bài mới: 37’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV


	Trong qtrình soạn thảo văn bản có gặp những đoạn, trong văn bản được lặp đi lặp lại nhiều lần, máy tính cho phép ta sử dụng đoạn, trong văn bản đó mà không phải đánh lại nhiều lần đó là thao tác sao chép văn bản.
	3. Sao chép:  



	  ?
	Vậy sao chép văn bản là gì?
	- Sao chép phần văn bản là giữ nguyên 

	HS


	...là giữ nguyên  phần văn bản đó ở vị trí gốc, đồng thời sao chép nội dung đó vào vị trí khác.
	phần văn bản đó ở vị trí gốc, đồng thời sao chép nội dung đó vào vị trí khác.

	  ?
	Để sao chép 1 phần văn bản đã có vào 1 vị trí khác, các em làm như thế nào?
	- Để sao chép phần văn bản thực hiện theo các bước sau:

B1: Chọn phần VB cần sao chép, nháy

	HS


	- B1: Chọn phần VB cần sao chép, nháy nút Copy

- B2: Đưa con trỏ đến vị trí cần sao chép, nháy nút Paste.
	nút Copy.

B2: Đưa con trỏ đến vị trí cần sao chép, nháy nút Paste.

	GV
	Các em lqsát hình minh hoạ khi sao chép phần văn bản sgk - 80
	

	HS
	Quan sát
	

	  ?
	Các em lưu ý có thể nháy nút Copy 1 lần và nháy nút Paste nhiều lần để sao chép cùng 1 nội dung vào nhiều vị trí khác nhau.
	

	  ?
	Vậy muốn di chuyển 1 đoạn, 1 phần văn bản từ vị trí này sang vị trí khác các em làm như thế nào?
	4. Di chuyển

	GV
	Có thể di chuyển phần VB từ vị trí này sang vị trí khác bằng cách: Sao chép rồi xoá phần VB ở vị trí gốc.
	- Di chuyển phần văn bản là thay đổi phần VB đó từ vị trí này sang vị trí khác

	  ?
	Ngoài cách đó ra, em có thể thực hiện việc di chuyển bằng cách khác được không?
	- Để di chuyển phần VB thực hiện 

theo các bước sau:

	HS
	B1: Chọn phần VB, nháy nút Cut

B2: Đưa con trỏ soạn thảo đến vị trí mới chọn Paste
	B1: Chọn phần VB, nháy nút Cut

B2: Đưa con trỏ soạn thảo đến vị trí mới chọn Paste

	  ?
	Vậy em hãy cho biết t.tác sao chép ( thao tác di chuyển ở chỗ nào?
	

	HS
	Đối với thao tác sao chép, sau khi chọn phần VB, nháy nút Copy phần VB còn; những thao tác di chuyển sau khi chọn phần VB, nháy Cut, và phần VB gốc sẽ không còn.
	

	GV
	Đây chính là điểm khác nhau cơ bản của thao tác sao chép và di chuyển. Các em lưu ý sao chép phần Vb thì phần VB đó vẫn còn ở gốc, di chuyển phần VB nào thì phần VB đó không còn ở gốc.
	

	GV
	Đưa bài 4 (sgk - 81) lên bảng phụ, hs điền.
	

	  ?
	Đọc ghi nhớ
	*) Ghi nhớ: (sgk - 81)


c) Củng cố, luyện tập (1’):

Qua bài học hôm nay các em đã được làm quen với các thao tác sao chép, di chuyển phần văn bản từ vị trí này sang vị trí khác, biết phân biệt và sử dụng các thao tác copy, di chuyển.
d) Hướng dẫn học sinh tự học bài ở nhà: (1’)

- Ôn lại 4 thao tác cơ bản khi chỉnh sửa văn bản.

- Làm bài 2, 3, 5(sgk - 81).


- Chuẩn bị bài thực hành 6 để tiết sau thực hành.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
----------------------------------------------------------------

	Ngµy so¹n:   25/ 10/ 2017
	Ngµy d¹y: 28/ 10/ 2017
	Líp 9A

	
	Ngµy d¹y: 28/ 10/ 2017
	Líp 9B


Tiết 20 Bài thực hành 6:

EM TẬP CHỈNH SỬA VĂN BẢN

1. Mục tiêu:

a) Kiến thức: Luyện cho hs các thao tác mở văn bản mới hoặc văn bản đã lưu, nhập nội dung văn bản và kỹ năng gõ văn bản tiếng việt. 

b) Kỹ năng: Phân biệt 2 chế độ gõ chèn, đè.

c) Thái độ: Giáo dục học sinh ý thức tự giác, nghiêm túc giữ vệ sinh phòng máy.

2.  Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn lại cách gõ 10 ngón, các thao tác chỉnh sửa VB.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ

Kết hợp với bài thực hành

* Đặt vấn đề. (1’)


Để củng cố và vận dụng các kiến thức chỉnh sửa văn bản. Bài hôm nay các em thực hành tập chỉnh sửa vân bản.

b) Dạy nội dung bài mới: 42’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV

HS 

 ?

HS

GV

 ?

HS

GV

HS

GV


	Các em khởi động máy tính để thực hành

Khởi động máy tính 

Nhắc lại cách khởi động Word?

Nháy đúp chuột vào biểu tượng của Word hoặc vào Start -> All Program -> Microsoft Word.

Các nhóm k/đ Word và gõ, sửa lỗi (nếu có) của VB sgk - 84

Để gõ VB đó các em mở 1 VB khác

Mở văn bản mới làm như thế nào?

Nháy chuột lên nút lệnh New

Các em mở VB mới gõ VB đó lưu tên 

" Bài thực hành 6"

Các nhóm thực hành

Kiểm tra sử dụng 10 ngón để gõ của các nhóm.
	* Khởi động máy tính. 3’ 

1. Khởi động Word và tạo văn bản mới: 16’
a) Khởi động Word

b) Tạo văn bản mới:

- Nháy chuột lên nút lệnh New

- Gõ nội dung văn bản

- Lưu văn bản đó với tên "Bài TH 6"



	
	Sau khi gõ và lưu Vb với tên " Bài thực hành 6", hướng dẫn các em sử dụng chế độ gõ chèn, gõ đè
	2. Phân biệt chế độ gõ chèn,  gõ đè:  20’

	GV
	DDDeer có thể gõ chèn / đè các em sử dụng lệnh Overtype/ Insert. Vậy gõ đè/chèn là gì?

Gõ chế độ đè ta đưa con trỏ đến vị trí cần đè và gõ kí tự từ bàn phím, tự động

đè kí tự đó lên ngay đằng trước con trỏ
	- Nút OVR rõ: Chế độ gõ đè

- Nút OVR mờ: Chế độ gõ chèn

- Ngoài ra để thay đổi chế độ gõ các em ấn nút Insert (Isn) trên bàn phím 

	  
	Chế độ gõ chèn ta có thể chèn bất kỳ kí tự nào vào vị trí con trỏ.
	  

	  ?
	Các em ấn lệnh Overtype/ Insert thấy nút OVR hiện rõ, ấn 1 lần nữa nut OVR lại mờ đi, vậy nó thể hiện điều gì?
	

	HS
	- Nút OVR rõ: Chế độ gõ đè

- Nút OVR mờ: Chế độ gõ chèn
	

	GV
	Các em gõ đoạn VB thứ 2: "Lại đến... rắc lên" để phân biệt tác dụng của hai chế độ gõ.
	

	HS
	Các nhóm thực hành
	

	GV
	Qua việc sử dụng chế độ gõ chèn/ đè các em thấy gõ ở chế độ nào thì người soạn thảo quen sử dụng hơn?
	

	HS
	...Chế độ gõ chèn
	

	GV
	Trong thực tế những người quen soạn thảo VB trên máy tính hầu như không bao giờ làm việc trong chế độ đè.

Vậy khi làm việc trên máy các em có thể sử dụng phím Insert hay Ins trên bàn phím để thay đổi chế độ gõ.
	

	GV

HS
	Các em tắt chương trình Word và máy tính.

Tắt chương trình Word, máy tính.


	*Tắt chương trình Word, máy tính. 3’


c) Củng cố, luyện tập. (1’) 

Qua bài học hôm nay các em cần nhớ các thao tác mở văn bản mới hoặc văn bản đã lưu, nhập nội dung văn bản và kỹ năng gõ văn bản tiếng việt, phân biệt 2 chế độ gõ chèn, đè.

d) Hướng dẫn học sinh tự học bài ở nhà: (1’)

           - Học bài, ôn lại cách khởi động Word, lưu, mở văn bản có sẵn các thao tác chỉnh sửa văn bản..


- Thực hành trên máy tính ( Nếu gia đình có máy tính)

           - Tiết sau thực hành tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

------------------------------------------------------------------
	Ngµy so¹n:   27/ 10/ 2017
	Ngµy d¹y: 01/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 30/ 10/ 2017
	Líp 9B


Tiết 21 Bài thực hành 6:

EM TẬP CHỈNH SỬA VĂN BẢN (Tiếp)

1. Mục tiêu:

a) Kiến thức: HS thực hiện các thao tác cơ bản để chỉnh sửa nội dung văn bản, thay đổi trật tự nội dung văn bản bằng các chức năng sao chép, di chuyển.

b) Kỹ năng:  Thực hành chọn, sao chép, di chuyển phần văn bản, nâng cao kỹ năng nháy chuột, nháy đúp chuột.

c) Thái độ: Giáo dục học sinh ý thức, nghiêm túc thực hiện tốt nội quy phòng máy.

2.  Chuẩn bị của giáo viên và học sinh :

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn bài.

3. Tiến trình bài dạy:

a)  Kiểm tra bài cũ: (5’)
Câu hỏi:

Thao tác sao chép và thao tác di chuyển có điểm gì giống và khác nhau.

Yêu cầu trả lời:

Thao tác sao chép và thao tác di chuyển có:

+ Giống nhau: 

- Cùng có chức năng giúp việc soạn thảo nhanh, tiện.

+ Khác nhau:

- Thao tác sao chép: Giữ nguyên phần VB ở vị trí gốc, ấn nút Copy

- Thao tác di chuyển: Thay đổi vị trí phần văn bản và phần văn bản đó không còn ở vị trí gốc, ấn nút Cut.

* Đặt vấn đề.  (1’)

Ở các bài thực hành trước các em đã có nội dung bài của nhóm mình các em có thể có được nội dung một bài hoàn chỉnh bằng cách sao chép, di chuyển nội dung các văn bản đã có thông qua phần tiếp theo của bài thực hành.

b) Dạy nội dung bài mới: 37’
	Hoạt động của GV và HS
	Ghi bảng

	?

HS


	Để mở ndung văn bản đã có sẵn trong máy tính các em làm như thế nào?

Để mở ndung văn bản đã có sẵn 

sử dung nút lệnh Open trên hộp thoại
	3. Mở VB đã lưu & sao chép, chỉnh sửa nội dung VB: (20’)

- Mở văn bản



	GV
	Các nhóm mở bài của mình có tên "Biển đẹp.doc" đã lưu ở bài thực hành trước.
	

	GV
	- Trở lại bài thực hành"TH6 - nhóm -  lớp"

và sao chép nội dung bài đó vào bài "Biển đẹp.doc"

HD học sinh thao tác đó 1 lần.

- Mở bài "Biển đẹp. doc"

- Mở bài "TH 6", chọn toàn bộ bài (hoặc ấn Ctr + A), ấn nút Copy.

- Đưa chuột vào VB "Biển đẹp" ấn nút Paste
	 

	   ?
	Các nhóm thực hiện, gv đi kiểm tra và hướng dẫn các nhóm chưa làm được.
	  

	HS
	Thực hành
	

	GV
	Các em có thể thay đổi trật tự các đoạn VB bằng cách sao chép hoặc di chuyển với các nút lệnh Copy, Cut, Paste để có thứ tự đúng.
	- Thay đổi trật tự văn bản.

	  ?
	Các nhóm thực hiện thay đổi trật tự các đoạn văn bản?
	

	HS
	Các nhóm thực hiện
	

	GV
	Kiểm tra bài của các nhóm, yêu cầu các nhóm lưu với tên VB cũ "Biển đẹp.doc"
	- Lưu văn bản.

	
	
	4. TH gõ chữ việt kết hợp với sao chép nội dung: (17’)

	GV
	Các em mở 1 văn bản mới, gõ nội dung bài Trăng ơi. Lưu ý:

- Các câu thơ lặp lại các em sao chép nhanh nội dung.

- Sửa lỗi sai khi gõ nội dung.

- Lưu văn bản với tên "Trăng ơi"
	

	HS
	Các nhóm thực hành
	

	GV
	HD, qsát việc sử dụng 10 ngón để gõ văn bản.
	


c) Củng cố, luyện tập. (1’) 

Qua bài học hôm nay các em cần nắm được các thao tác cơ bản để chỉnh sửa nội dung văn bản, thay đổi trật tự nội dung văn bản bằng các chức năng sao chép, di chuyển, thực hành chọn, sao chép, di chuyển phần văn bản, nâng cao kỹ năng nháy chuột, nháy đúp chuột.
d. Hướng dẫn học sinh tự học bài ở nhà: (1’)

        - Ôn lại các thao tác chỉnh sửa văn bản.


- Thực hành các thao tác đã thực hành ở nhà (Nếu có máy tính)

        - Đọc trước bài 16: Định dạng văn bản để tiết sau học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

	Ngµy so¹n:   01/ 11/ 2017
	Ngµy d¹y: 04/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 04/ 11/ 2017
	Líp 9B


Tiết 22 Bài 16: ĐỊNH DẠNG VĂN BẢN

1. Mục tiêu:

a) Kiến thức: HS năm được khái niệm định dạng văn bản và mục tiêu của định dạng văn bản, hiểu các nội dung định dạng kí tự. 
b) Kỹ năng: Thực hiện được các thao tác định dạng kí tự cơ bản.

c) Thái độ: Học sinh nghiêm túc trong học tập, thấy được các tính năng của phần mềm soạn thảo văn bản từ đó thêm hăng say học học bộ môn tin.

2. Chuẩn bị của giáo viên và học sinh:

a)  Giáo viên: Giáo án, SGK, 2 VB (1 chưa định dạng, 1 đã định dạng) phòng máy.

b) Học sinh: Ôn lại các nút lệnh và các bảng chọn.

3. Tiến trình bài dạy

a)  Kiểm tra bài cũ: Không

* Đặt vấn đề. (2’) 

Ở trong các tiết học trước các em đã biết chỉnh sửa 1 văn bản song để có 1 văn bản hoàn chỉnh về mặt hình thức và bố cục đẹp mà qua đó người đọc có thể ghi nhớ được những nội dung cần thiết, chúng ta phải định dạng văn bản đó. Vậy định dạng văn bản là gì? Các thao tác để định dạng 1 văn bản như thế nào? Thầy cùng các em nghiên cứu nội dung bài học hôm nay.

b) Dạy nội dung bài mới: 41’
	Hoạt động của GV và HS
	Ghi bảng

	GV
	Cho hs quan sát 2 văn bản:

Một văn bản đã có nội dung nhưng chưa định dạng và 1 văn bản khác với cùng nội dung nhưng đã được định dạng.
	1. Định dạng văn bản:  (11’)



	 HS
	Quan sát hai văn bản trên.
	

	  ?
	Qua qsát em hãy so sách sự khác biệt giữa hai văn bản?
	

	HS
	Văn bản (đã định dạng) dễ đọc, dễ ghi nhớ và đẹp hơn văn bản kia (chưa định dạng).
	

	GV
	Như vậy văn bản mà được định dạng thì dễ đọc, dễ nhớ và đẹp hơn, vậy định dạng văn bản là gì?
	

	HS
	Định dạng văn bản là thay đổi kiểu dáng, vị trí của các kí tự (con chữ, số, kí hiệu)
	- Định dạng văn bản là thay đổi kiểu dáng, vị trí của các kí tự (con chữ, số, kí hiệu).

	  ?

HS
	Định dạng văn bản nhằm mục đích gì?

... để văn bản dễ đọc, dễ nhớ
	- Định dạng văn bản nhằm mục đích để văn bản dễ đọc, trang văn bản có bố cục đẹp và dễ ghi nhớ những nội dung cần thiết.

	GV
	Định dạng văn bản gồm 2 loại: 

Định dạng kí tự và định dạng đoạn văn. Trong bài hôm nay các em sẽ học định dạng kí tự. Vậy định dạng kí tự như thế nào?
	2. Định dạng kí tự:  (26’)

	
	
	- Định dạng kí tự là thay đổi dáng vẻ của một nhóm kí tự.

	GV
	Khi định dạng kí tự các em phải chú ý đến các tính chất phổ biến của chúng như: Font chữ, cỡ chữ, kiểu chữ, mầu chữ của các kí tự được hiển thị.

Ngoài các thuộc tính trên còn có nhiều thuộc tính khác các em sẽ tìm hiểu sau.
	- Các tính chất cơ bản của kí tự:

Font chữ, cỡ chữ, kiểu chữ, mầu sắc.

	  ?
	Vậy để định dạng lí tự ta thực hiện các thao tác như thế nào?
	a) Sử dụng các nút lệnh:

	HS
	Sử dụng các nút lệnh trên thanh công cụ để định dạng kí tự hay nhóm kí tự.
	

	GV
	Các em qsát các nút lệnh định dạng kí tự trên thanh công cụ định dạng trong sgk -86
	- Font chữ: Nháy nút ( bên phải hộp 

	  
	
	font và chọn Font chữ thích hợp.

- Cỡ chữ: Nháy nút ( bên phải hộp Size và chọn cỡ chữ cần thiết.

- Kiểu chữ: 

             Bold         (B)   chữ đậm

             Italic         ( I )     chữ nghiêng

              Underline (U) chữ gạch chân

- Mầu chữ: Nháy nút ( bên phải hộp font Color và chọn mầu thích hợp.

	GV
	Cho hs thực hành các nút lệnh trên máy để định dạng kí tự.
	

	  
	
	b) Sử dụng hộp thoại:

	GV
	Ngoài cách sử dụng các nút lệnh ta có thể sử dụng bảng chọn để định dạng kí tự.

Trên hộp thoại Font các em lựa chọn các mục:

Font - chọn font (Vntime, Arial,..)

Fontstyle - chọn kiểu chữ (B, I, U)

Size - chọn cỡ chữ (14, 16,...)

Font Color - chọn màu chữ.

Khi chọn các mục song ấn nút Default -> OK.
	- Vào bảng chọn Format -> Font -> hộp thoại Font xuất hiện (chọn Font chữ, cỡ chữ, màu chữ, ...) -> ấn nút Default -> OK

	  ?
	Trên hộp thoại Font có các lựa chọn định dạng kí tự tương đương với các nút lệnh trên thanh công cụ định dạng không?
	

	HS
	... có
	

	GV
	Lưu ý cho hs: Nếu không chọn phần trước văn bản nào thì các thao tác định dạng trên sẽ áp dụng cho các kí tự gõ vào sau đó/
	*) Ghi nhớ: SGK/87    4’


c) Củng cố, luyện tập. (1’)  

Qua bài học hôm nay các em cần nắm được khái niệm định dạng văn bản và mục tiêu của định dạng văn bản, hiểu các nội dung định dạng kí tự, thực hiện được các thao tác định dạng kí tự cơ bản.
d. Hướng dẫn học sinh tự học bài ở nhà: (1’)

 - Ôn lại thao tác định dạng kí tự bằng nút lệnh và bằng bảng chọn.

- Làm bài tập 1, 2, 3, 4, 5, 6 (sgk - 88).

Hướng dẫn bài 3:

          Gõ 1 vài chữ việt (ă, ê,...) và định dạng theo font chữ đó. Nếu có hiển thị -> có font tiếng việt. Nếu nó không hiển thị -> không có font tiếng việt.

Các em phải thử cả hai kiểu gõ Telex và Vni

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

--------------------------------------------------------------------------
	Ngµy so¹n:   03/ 11/ 2017
	Ngµy d¹y: 08/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 06/ 11/ 2017
	Líp 9B


Tiết 23 Bài 17: ĐỊNH DẠNG ĐOẠN VĂN BẢN 
1. Mục tiêu:

a) Kiến thức:  HS nắm được khái niệm  định dạng văn bản và sử dụng các nút lệnh để định dạng văn bản.
b) Kỹ năng: Thực hiện được các thao tác định dạng đoạn văn bản  cơ bản.

c) Thái độ: Học sinh cần có thái độ nghiêm túc trong học tập, thấy dựoc những ưu điểm của việc định dạng văn bản từ đó thêm hăng say học bộ môn tin học.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn lại các nút lệnh, bảng chọn.

3.Tiến trình bài dạy:

a) Kiểm tra bài cũ:  (7’)

Câu hỏi:

Định dạng kí tự là gì? Có mấy cách định dạng kí tự? nêu cách định dạng kí tự sử dụng các nút lệnh?

Yêu cầu trả lời:

- Định dạng kí tự là thay đổi dáng vẻ của 1 hay 1 nhóm kí tự.

- Có 2 cách định dạng kí tự: Sử dụng nút lệnh và sử dụng hộp thoại font

Định dạng kí tự bằng nút lệnh:

Font: Phông chữ

Size: Cỡ chữ

B, I, U: Kiểu chữ

Font Color: Màu chữ

* Đặt vấn đề. (1’) 

Trong bài học trước các em đã biết cách định dạng kí tự, vậy muốn định dạng đoạn văn bản tiến hành các thao tác như thế nào? Thầy cùng các em đi nghiên cứu bài học hôm nay.

b. Dạy nội dung bài mới: 35’
	Hoạt động của GV và HS
	Ghi bảng

	GV
	Cho học sinh qsát hai văn bản 1 VB đã có nội dung nhưng chưa định dạng và 1 văn bản khác với cùng nội dung nhưng đã được định dạng.

2 VB này đưa vào bảng phụ.
	1. Định dạng đoạn văn bản.  (17’)

	HS
	Quan sát
	

	  ?


	So sách hình thức của 2 văn bản trên?
	

	HS
	Văn bản đã được định dạng có bố cục đẹp, các đoạn văn rõ ràng, dễ đọc.
	

	GV


	Văn bản này là văn bản đã được định dạng hay nói cách khác các đoạn văn trong văn bản đã được định dạng, vì kết quả này tác động đến toàn văn bản.
	- Định dạng đoạn văn là thay đổi kiểu dáng, vị trí của 1 hay 1 số đoạn văn bản

	  ?
	Vậy để hiểu thế nào là định dạng đoạn văn các em nhắc lại các thuộc tính cơ bản của kí tự?
	

	HS
	Thuộc tính cơ bản của kí tự gồm:

Font chữ, cỡ chữ, kiểu chữ, màu chữ
	

	GV
	Vậy đoạn văn có thuộc tính như kí tự hay không các em quan sát 1 văn bản sau đây"

Đưa lên bảng phụ văn bản chỉ cho hs cách căn lề, khoảng cách giữa các dòng và các đoạn trong 1 trang văn bản.
	- Kiểu căn lề:

	  ?
	Có mấy kiểu căn lề? 
	+ Căn thẳng lề trái

+ Căn thẳng lề phải

+ Căn thẳng hai lề

+ Căn giữa

	GV
	Thuộc tính thứ hai của đoạn văn bản là vị trí lề của cả đoạn văn so với toàn trang văn bản: Gồm thụt lề dòng đầu tiên của đoạn văn, cả đoạn văn thụt lề.
	- Vị trí lề của cả đoạn văn so với toàn trang

+ Thụt lề dòng đầu tiên

+ Cả đoạn văn thụt lề

- K.cách đến doạn văn trên hoặc dưới

- K.cách giữa các dòng trong đoạn văn

- Khoảng cách lề của dòng đầu tiên

	  ?
	Vậy khi định dạng 1 đoạn văn trong Vb có làm thay đổi hình thức của cả văn bản đó không?
	

	HS
	...làm thay đổi cả văn bản
	

	  ?
	Còn định dạng kí tự làm thay đổi cả hình thức của trang văn bản không?
	

	HS
	...không
	

	GV
	Chốt lại: Khác với định dạng kí tự, định dạng đoạn văn nó tác động đến toàn bộ văn bản và con trỏ soạn thảo đang ở đó.
	

	  ?
	Nhắc lại để định dạng kí tự có những cách làm nào quên thuộc?
	

	HS
	Có 2 cách: Định dạng bằng nút lệnh và định dạng bằng bảng chọn.
	

	GV

GV
	Cũng tương tự như định dạng kí tự, để định dạng đoạn văn bản có thể sử dụng 2 cách: Định dạng đoạn văn bằng các nút lệnh và định dạng đoạn văn bằng bảng chọn trong phạm vi tiết học này cô cùng các em tìm hiểu cách thứ nhất sử dụng nút lệnh để định dạng đoạn văn.

ở bài 13 các  em học về TP của 1 cửa sổ
	2. Sử dụng các nút lệnh để định dạng đoạn văn: (18’)

	  ?
	Các nút lệnh nằm trên thanh nào?
	

	HS
	Các nút lệnh nằm trên thanh công cụ
	

	GV
	Các em qsát các nút  định dạng văn bản trong sgk - 89
	

	   ?
	Qua qsát trên thanh công cụ có những nút định dạng đoạn văn  nào?
	

	HS
	Căn thẳng lề trái, Căn giữa, Căn thẳng lề phải, Căn thẳng hai lề, tăng mức thụt lề trái, giảm mức thụt lề trái.
	

	  ?
	Tương tự như định dạng kí tự, muốn định dạng đoạn văn sẽ làm như thế nào?
	

	HS
	Chọn đoạn văn cần định dạng và sử dụng các nút lệnh trên thanh công cụ
	- Căn lề: Nháy 1 trong các nút

        Căn thẳng lề trái, Căn giữa, Căn thẳng lề phải, Căn thẳng hai lề trên thanh công cụ để căn lề.

- Thay đổi lề cả đoạn văn: Nháy chuột vào 1 trong các nút tăng, giảm mức thụt lề trái.

- Khoảng cách dòng trong đoạn văn: Nháy nút ( bên phải nút khoảng cách dòng trong đoạn văn, trọng 1 tỷ lệ thích hợp.


c. Củng cố, luyện tập :(1’)

Qua bài học hôm nay các em cần nắm được khái niệm  định dạng văn bản và sử dụng các nút lệnh để định dạng văn bản. Thực hiện được các thao tác định dạng đoạn văn bản.
d. Hướng dẫn học sinh tự học bài ở nhà:(1’)

           - Phân biệt các thuộc tính của kí tự và các thuộc tính của đoạn văn.

           - Ôn lại các nút lệnh đã học.


- Chuẩn bị các phần tiếp theo của bài.


- Tiết sau chúng ta học tiếp định dạng văn bản bằng hộp hội thoại Paragraph.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
-------------------------------------------------------------------------------------------

	Ngµy so¹n:   07/ 11/ 2017
	Ngµy d¹y: 11/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 11/ 11/ 2017
	Líp 9B


Tiết 24 Bài 17: ĐỊNH DẠNG ĐOẠN VĂN BẢN (Tiếp)

1. Mục tiêu:

a) Kiến thức: HS nắm được các thao tác  định dạng đoạn văn bản bằng bảng chọn Format và hộp thoại (Paragraph), phân biệt được các thuộc tính của đoạn văn bản trên hộp thoại Paragraph.

b) Kỹ năng: Thực hiện được các thao tác định dạng đoạn văn bản, kỹ năng phân biệt các nút lệnh, rèn tư duy suy luận của hs.

c) Thái độ: Học sinh cần có thái độ nghiêm túc trong giờ học.  

2. Chuẩn  bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn lại các thuộc tính , nút lệnh của đoạn văn.

3.Tiến trình bài dạy:

a) Kiểm tra bài cũ:  (4’)

Câu hỏi:

Nêu các thuộc tính cơ bản của định dạng đoạn văn bản?

Yêu cầu trả lời:

Các thuộc tính cơ bản của định dạng đoạn văn bản là:

- Kiểu căn lề

- Vị trí lề của cả đoạn văn bản so với toàn trang.

- Khoảng cách lề của dòng đầu tiên

- Khoảng cách đến đoạn văn bản trên hoặc dưới

- Khoảng cách giữa các dòng trong đoạn văn

* Đặt vấn đề. (1’) 

Ở bài học trước các em đã nắm được các thuộc tính của đoạn văn và sử dụng các nút lệnh để định dạng đoạn văn. Trong tiết học này các em sẽ được tìm hiểu cách định dạng đoạn văn bằng bảng chọn. Vậy cách định dạng đó  như thế nào? Chúng ta đi nghiên cứu bài học hôm nay.

b) Dạy nội dung bài mới: 38’
	Hoạt động của GV và HS
	Ghi bảng

	  ?
	Nhắc lại cách định dạng kí tự bằng bảng chọn?
	3. Định dạng đoạn văn bằng hộp thoại Paragraph:  (15’)

	HS
	Vào Format -> Font (hộp thoại Font xuất hiện, lựa chọn Font chữ, cỡ chữ, kiểu chữ, màu chữ) -> OK.
	

	GV


	Để định dạng đoạn văn bản ta sử dụng lệnh Paragraph trong bảng chọn Format.
	

	  ?
	Tương tự cách định dạng kí tự bằng bảng chọn, muốn định dạng đoạn văn bản bằng bảng chọn tya sẽ thực hiện các thao tác nào?
	

	HS


	Vào Format -> Paragraph (hộp thoại Paragraph xuất hiện, định dạng: Kiểu căn lề, Khoảng cách lề, thụt lề đầu dòng, ...) -> OK.
	- Vào Format -> Paragraph (hộp thoại

	GV
	Đây chính là các thao tác định dạng đoạn văn bằng hộp thoại Paragraph.
	Paragraph xuất hiện, định dạng: Kiểu căn lề, Khoảng cách lề, thụt lề đầu dòng, ...) -> OK.

	  ?
	Như vậy khi định dạng đoạn văn bản ta có cần chọn toàn bộ trang văn bản không?
	

	HS
	...ta không cần phải chọn toàn bộ trang văn bản mà chỉ cần chọn đoạn văn bản cần định dạng.
	

	  ?
	Hãy chỉ ra các lựa chọn định dạng đoạn văn trên hộp thoại Paragraph tương ứng với các nút lệnh trên thanh công cụ định dạng? 
	

	HS
	...
	

	GV
	Chốt lại: Như vậy để định dạng 1 văn bản ta phải định dạng kí tự và định dạng đoạn văn.
	

	
	- Với định dạng kí tự các em phải nắm được các thuộc tính của kí tự: Font chữ, cỡ chữ, kiểu chữ và màu sắc chữ. Để định dạng kí tự ta thường sử dụng 2 cách quen thuộc: Dùng các nút lệnh và dùng hộp thoại Font để định dạng.
	

	  
	- Với định dạng đoạn văn phải nắm được các thuộc tính của đoạn văn: Kiểu căn lề, vị trí lề đoạn văn so với trang văn bản, khoảng cách lề của dòng đầu tiên, khoảng cách của đoạn văn trên hoặc dưới, khoảng cách giữa các dòng. Định dạng đoạn văn có 2 cách: Sử dụng nút lệnh và dùng hộp thoại Paragraph để định dạng.
	*) Ghi nhớ: sgk - 90

	GV
	Cho hs đọc ghi nhớ sgk - 90
	4. Bài tập:  (12’)

	HS
	...
	Bài2 (sgk - 91)

	GV

  ?
	Cho hs nghiên cứu bài 2 sgk -91. đưa nội dung bài 2 vào bảng phụ.

1 em lên bảng điền.
	Nút   [image: image6.png]


    dùng để căn lề trái

Nút    [image: image7.png]


   dùng để căn đều 2 lề

Nút   [image: image8.png]


    dùng để căn giữa

	
	
	Bài 4: (sgk - 91)

	  ?
	Một đoạn văn bản có thể nằm ngoài lề trang văn bản được không?
	Được, khi khoảng cách lề đó có giá trị âm (lưu ý: Chỉ định dạng lề có giá trị âm bằng hộp thoại Paragraph, nút lệnh giảm mức thụt lề không có tác dụng.


c) Củng cố, luyện tập. (15’)  

Câu 1. Thanh này là thanh gì trong Word?

 [image: image9.png]i A4 ormal
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a) Thanh bảng chọn




b) Thanh định dạng.


c) Thanh cuốn dọc.




d) Thanh tiêu đề.

Câu 2.  Khi gõ nội dung văn bản, nếu muốn xuống dòng,em phải:

A. Gõ dấu chấm câu


C. Nhấn phím End

B. Nhấn phím Enter



D.Nhấn phím Home

Câu 3. Điền từ hoặc cụm từ “bên trái, kí tự, bên phải , ở giữa, một vạch” vào chỗ trống (…) để được câu đúng. (1đ)

A. Phím Backspace dùng để xóa kí tự …………………………… con trỏ soạn thảo.

B. Phím Delete dùng để xóa kí tự …………………………….. con trỏ soạn thảo

C. Con trỏ soạn thảo là .....................đứng nhấp nháy trên màn hình.

D. Có hai loại định dạng cơ bản là định dạng ............ và định dạng đoạn văn.

d. Hướng dẫn học sinh tự học bài ở nhà: (1’)
- Nắm được cách định dạng văn bản bằng hộp thoại Paragraph.

- Thực hiện tốt các thao tác định dạng bằng nút lệnh;

- Làm bài tập 3, 5, 6 (sgk-91).


- Chuẩn bị bài thực hành để tiết sau học. 

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

-------------------------------------------------------------------------------------
	Ngµy so¹n:   10/ 11/ 2017
	Ngµy d¹y: 13/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 15/ 11/ 2017
	Líp 9B


Tiết 25 Bài thực hành 7:

EM TẬP TRÌNH BÀY VĂN BẢN

1. Mục tiêu:

a) Kiến thức: Học sinh biết và thực hành được các thao tác định dạng văn bản đơn giản: Định dạng kí tự, định dạng đoạn văn.

b) Kỹ năng: Rèn kỹ năng nháy chuột nhanh, chính xác, kỹ năng chọn kí tự và chọn phần văn bản.

c) Thái độ: Học sinh cần có thái độ nghiêm túc trong giờ thực hành, thực hành theo đúng nội dung của bài.

2. Chuẩn bị của giáo viên và học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn lại các thao tác định dạng văn bản.

3. Tiến trình bài dạy:

a) Kiểm tra bài cũ:  Kết hợp với bài thực hành

* Đặt vấn đề. (1’) 

Ở trong các bài học trước các em đã được học về định dạng văn bản, trong tiết học này các em sẽ vận dụng các kiến thức đó để tập trình bày một văn bản.
b) dạy nội dung bài  mới: 42’
	Hoạt động của GV và HS
	Ghi bảng

	GV
	Yêu cầu hs các nhóm khởi động Word
	1. Định dạng văn bản: (42’)

	  ?
	Để mở một tệp đã có trong máy tính các em làm như thế nào?
	- Khởi động Word

	HS
	Nháy chuột nút Open -> chọn văn bản cần tìm -> Open trên hộp thoại.
	

	  ?
	Các em mở tệp "biển đẹp. doc"?

(Một số nhóm lưu với tên của nhóm mình ví dụ Tan ba)
	

	  ?
	Các em hãy áp dụng các định dạng em đã biết để trình bày giống mẫu 

(sgk - 92) theo yêu cầu:
	- Định dạng văn bản theo mẫu sgk - Tr92

	GV
	Đưa nội dung yêu cầu lên bảng phụ cho hs quan sát và làm theo yêu cầu:

- Tiêu đề có font chữ, kiểu chữ, mầu chữ khác với font chữ, kiểu chữ, mầu chữ của nội dung văn bản.

Cỡ chữ của tiêu đề lớn hơn nhiều so với cỡ chữ của phần nội dung.

- Tiêu đề căn giữa trang, các đoạn nội dung căn thẳng cả hai lề, đoạn cuối cùng căn thẳng lề phải.

- Các đoạn nội dung có dòng đầu thụt lề

- Kí tự đầu tiên của đoạn nội dung thứ nhất có cỡ chữ lớn hơn và kiểu chữ đậm
	Thực hành.

	  ?
	Để thực hiện yêu cầu thứ nhất các em làm như thế nào?
	

	HS
	Chọn tiêu đề, định dạng cỡ chữ (ví dụ: cỡ 18), kiểu chữ ( B ), màu sắc chữ 

( Xanh ). 

Chọn phần nội dung, định dạng cỡ chữ (ví dụ: 14), font chữ VN Time, kiểu chữ Nomal, màu sắc chữ (đen).

Chọn "theo" kiểu chữ nghiêng ( I )

Chọn "Vũ Tú Nam" kiểu chữ in hoa
	

	  ?
	Muốn tiêu đề căn giữa trang, các đoạn nội dung căn thẳng 2 lề em làm như thế nào?
	

	HS
	Chọn tiêu đề -> nháy chuột lên nút lệnh căn giữa trên thanh công cụ.

Chọn các đoạn nội dung -> nháy chuột lên nút lệnh căn thẳng lên hai lề.
	

	  ?
	Đoạn cuối cùng các em căn lề phải?
	

	  ?
	Các đoạn nội dung có dòng đầu thụt lề?
	

	HS
	Chọn các đoạn nội dung đó -> nháy chuột lên nút thụt lề trái.
	

	  ?
	Kí tự đầu tiên của đoạn nội dung thứ nhất có cỡ chữ, kiểu chữ đậm lớn hơn chữ ở nội dung?
	

	HS
	Chọn chữ -> Size (16) -> kiểu chữ ( B )
	

	GV
	Kiểm tra, hướng dẫn việc thực hành của các nhóm và sửa sai (nếu có).
	

	HS
	Các nhóm thực hành.
	

	  ?
	Sau khi định dạng văn bản theo các yêu cầu trên các em lưu văn bản với tên cũ (hoặc TH 7 - Tên lớp)
	


c) Củng cố, luyện tập. (1’) : 

Qua bài hôm nay các em cần biết và thực hành được các thao tác định dạng văn bản đơn giản: Định dạng kí tự, định dạng đoạn văn, rèn kỹ năng nháy chuột nhanh, chính xác, kỹ năng chọn kí tự và chọn phần văn bản.

d) Hướng dẫn học sinh tự học bài ở nhà:  (1’)

                - Ôn lại các thao tác định dạng kí tự và định dạng đoạn văn.

                - Ôn lại cách mở và lưu văn bản.

                - Tiết sau thực hành tiếp.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
-----------------------------------------------------------------------

	Ngµy so¹n:   15/ 11/ 2017
	Ngµy d¹y: 18/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 18/ 11/ 2017
	Líp 9B


Tiết 26 Bài thực hành 7:

EM TẬP TRÌNH BÀY VĂN BẢN (Tiếp)

1. Mục tiêu:

a) Kiến thức: Học sinh làm thành thạo các thao tác định dạng kí tự, định dạng đoạn văn.

b) Kỹ năng: Nâng cao kỹ năng mở, lưu văn bản.

c) Thái độ: Nghiêm túc trong giờ thực hành, thực hành theo đúng nội dung của bài.

2.  Chuẩn bị của giáo viên và  học sinh:

a) Giáo viên: Giáo án, SGK, phòng máy.

b) Học sinh: Ôn bài, vở ghi, SGK

3. Tiến trình bài dạy

a) Kiểm tra bài cũ.

Kết hợp với bài thực hành

b) Dạy nội dung bài mới: 42’
	 
Hoạt động của GV và HS
	Ghi bảng

	GV

HS
	Yêu cầu hs kiểm tra máy tính, bàn ghế và khởi động máy tính, Word

Kiểm tra máy tính, bàn ghế và khởi động máy tính, Word
	1. Kiểm tra máy tính, bàn ghế và khởi động máy tính, khởi động Word. 5’

	GV

HS

  ?
	Các em thực hành trình bày văn bản tiếp

...

Để mở văn bản mới các em làm ntn?
	2. Thực hành:  (37’)
- Gõ và định dạng đoạn văn theo mẫu sau (chỉ thực hành với phần văn bản)

	HS
	Nháy chuột trên nút New trên thanh công cụ
	

	GV
	Các nhóm mở văn bản mới gõ nội dung văn bản "Tre xanh" sgk - 93

Lưu ý: Gõ nội dung trước sau đó mới định dạng văn bản.
	

	HS
	Thực hành gõ
	

	  ?
	Nhận xét gì về tiêu đề của văn bản trên
	

	HS
	Tiêu đề căn giữa, có cỡ và màu chữ khác với phần nội dung, có kiểu chữ nghiêng.
	

	  ?
	Các em định dạng tiêu đề theo mẫu trên
	

	HS
	Chọn tiêu đề và sử dụng các thao tác căn giữa, B, I, cỡ 18, màu chữ.
	

	  ?
	Phần nội dung văn bản được trình bày như thế nào?
	

	HS
	Nội dung văn bản căn giữa, có kiểu chữ nghiêng và cỡ chữ nhỏ hơn cỡ chữ tiêu đề.
	

	  ?
	Thực hiện định dạng nội dung theo mẫu
	

	HS
	Thực hành
	

	  ?
	Phần chú thích (Theo Nguyễn Duy) các em làm như thế nào?
	

	HS
	Chọn theo -> kiểu I

Nguyễn Duy -> VnTime 

và chọn căn lề phải
	

	GV
	Kiểm tra, hướng dẫn việc thực hành của các nhóm.
	

	GV
	Sau khi các nhóm hoàn chỉnh bài của mình theo yêu cầu.
	

	  ?
	Các em lưu văn bản với tên "Tre xanh"?
	- Lưu văn bản với tên Tre xanh

	HS
	Lưu
	


c) Củng cố, luyện tập. (1’) 

Qua bài hôm nay các em cần thao tác thành thạo các thao tác định dạng kí tự, định dạng đoạn văn. Nâng cao kỹ năng mở, lưu văn bản.
d) Hướng dẫn học sinh tự học bài ở nhà:  (1’)

                - Ôn lại các thao tác định dạng kí tự và định dạng đoạn văn.

                - Xem lại các câu hỏi và bài tập của các bài học trong chương 4.

                - Tiết sau chữa bài tập.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
	Ngµy so¹n:   18/ 11/ 2017
	Ngµy d¹y: 21/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 22/ 11/ 2017
	Líp 9B


Tiết 27 Bài 18: TRÌNH BÀY TRANG VĂN BẢN VÀ IN

1. Mục tiêu:

a. Kiến  thức: - HS  biết được một số khả năng trình bày trang văn bản của words.

b. Kỹ năng: - Biết cách thực hiện các thao tác chọn hướng trang và đặt lề trang.

c. Thái độ: - Phân biệt lề trang văn bản và lề đoạn văn.

2. Chuẩn bị của giáo viên và học sinh:

a.  Giáo viên:  Giáo án, SGK, bảng phụ.

b. Học sinh:  Học bài cũ, vở ghi, SGK
3. Tiến trình bài dạy:

a. Kiểm tra bài cũ.

Xen kẽ trong giờ học

* Đặt vấn đề. (1’)

Ở các bài học trước các em đã biết chỉnh sửa và định dạng văn bản. Vậy để có một văn bản hoàn chỉnh cả về nội dung và hình thức, trong bài học hôm nay thầy sẽ hướng dẫn các em trình bày trang văn bản và in.

b. Dạy nội dung bài mới. 42’
	Hoạt động của GV và HS
	Ghi bảng

	GV
	Đưa lên bảng bảng phụ trình bày văn bản (sgk - 94)
	1. Trình bày trang văn bản.  (34’)

	  ?
	Qsát hai văn bản trên
	

	HS
	Quan sát
	

	  ?
	Qua qsát em có nhận xét gì về nội dung của 2 văn bản đó ?
	

	HS
	Hai văn bản này có cùng nội dung
	

	  ?
	Nhận xét về kiểu trình bày?
	

	HS
	Văn bản a, Được trình bày trang đứng

              b, Được trình bày nằm ngang
	

	  ?
	Vậy với cùng một nội dung văn bản ta có mấy kiểu trình bày?
	

	HS
	...có 2 kiểu: Đứng và nằm ngang.
	

	GV
	Chốt: Như vậy với cùng 1 nội dung văn bản ta có thể trình bày trang văn bản đó theo 2 kiểu: Kiểu đứng và kiểu nằm ngang. Đây chính là yêu cầu cơ bản khi trình bày trang văn bản là chọn hướng trang 
	- Chọn hướng trang:

Trang đứng hay trang nằm ngang.

	GV
	Chỉ trên bảng phụ giới thiệu cho hs (văn bản a,)

- K/c từ mép giấy bên trái tới lề văn bản gọi là lề trái.

Tương tự lề phải, lề trên, lề dưới
	

	  ?
	Một em lên bảng xác định các lề trên, dưới, phải, trái trên văn bản b?
	

	HS
	lên bảng chỉ trên hình.
	

	GV
	Ngoài việc chọn hướng trang thì một trong các yêu cầu đó là đặt lề trang, đặt lề trang tức là phải chỉnh sửa lề trái, phải, trên, dưới.
	- Đặt lề trang: 

Lề trên, lề dưới, lề phải và lề trái

	  ?

HS

  ?
	Một em cho cô biết k/c từ đâu tới đâu được gọi là lề trang văn bản?

Từ mép giấy tới lề VB gọi là lề trang VB.

Vậy lề đoạn văn được tính như thế nào?
	

	 HS
	Tính từ mép giấy đến lề trang văn bản dòng đầu tiên của đoạn văn bản so với lề trang văn bản.
	

	GV
	Lưu ý: Lề đoạn văn có thể nằm ngoài lề trang, và phải phân biệt rõ đâu là lề đoạn văn, đâu là lề trang văn bản.
	

	GV
	Khi học định dạng kí tự và định dạng đoạn văn nó tác động đến 1 trang hay nhiều trang văn bản.
	

	HS
	...tác động tới 1 trang văn bản
	

	GV
	Khi các em chọn hướng trang và đặt lề trang trong TH văn bản có nhiều trang thì nó sẽ tác động đến tất cả các trang trong văn bản đó.

Đây cũng chính là nội dung chú ý sgk - 95
	*) Chú ý: (sgk - 95): (3’)

	HS
	Đọc lại chú ý
	

	GV
	Trở lại hai văn bản a, b trên bảng phụ
	

	  ?
	Qsát 2 văn bản đó ngoài hướng trang và lề trang còn có yếu tố nào khác không?
	

	HS
	...đầu trang và số trang.
	

	  ?
	Đầu trang thường nằm ở lề nào?
	

	HS
	Lề trên của văn bản.
	

	  ?
	Thông thường các em thấy số trang thường được đánh ở đâu?
	

	HS
	Bên phải
	

	GV
	*) Củng cố:
	

	  ?

GV
	Cho hs làm bài 1 (sgk - 96): Phân biệt lề trang văn bản với lề đoạn văn?

Cho hs thảo luận nhóm thời gian (5’)

Gọi đại diện 1 nhóm lên trình bày, các nhóm khác nhận xét.
	*) Bài 1: (sgk - 96): (5’)

Trả lời

  Lề trang văn bản: Là biên ngoài của vùng chứa văn bản trên trang in.

  Lề đoạn văn: Là k/c tương đối của đoạn văn bản tới lề trang


c. Củng cố, luyện tập. (1’)

Bài học hôm nay các em cần Phân biệt lề trang văn bản và lề đoạn văn. Biết cách thực hiện các thao tác chọn hướng trang và đặt lề trang, biết được một số khả năng trình bày trang văn bản của words. Biết cách chọn hướng trang và đặt lề trang, phân biệt lề trang văn bản và lề đoạn văn.

d. Hướng dẫn học sinh tự học bài ở nhà: (1’)

- Về nhà học thuộc bài trong vở ghi và xem thêm trong SGK.

- Đọc trước phần 3, tiết sau học tiếp trên máy.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
-----------------------------------------------------------------------------------

	Ngµy so¹n:   22/ 11/ 2017
	Ngµy d¹y: 25/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 25/ 11/ 2017
	Líp 9B


Tiết 28 Bài 28: TRÌNH BÀY TRANG VĂN BẢN VÀ IN (Tiếp)

1. Mục tiêu:

a. Kiến  thức: - HS thấy được một số khả năng trình bày trang văn bản của words. Biết xem văn bản trước khi in.

b. Kỹ năng: - Phân biệt lề trang văn bản và lề đoạn văn.

c. Thái độ: - Rèn kỹ năng nháy chuột nhanh chính xác.

2. Chuẩn bị của giáo viên và học sinh:

a.  Giáo viên:  Giáo án, SGK, phòng máy,bảng phụ Page Setup.

b. Học sinh:  Học bài cũ, vở ghi, SGK

3. Tiến trình bài dạy:

a. Kiểm tra bài cũ.

Xen kẽ trong giờ học

* Đặt vấn đề. (1’)


Bài hôm nay các em tiếp tục học bài trình bày và in trang tính cụ thể là chón hướng giấy in và đặt lề trang.

b.Dạy nội dung bài mới. 42’
	Hoạt động của GV và HS
	Ghi bảng

	?
	Một em nhắc lại cho cô các yêu cầu khi trình bày trang văn bản?
	2. Chọn hướng trang và đặt lề trang: (32’)

	HS
	Có 2 yêu cầu:

- Chọn hướng trang: Trang đứng, trang nằm ngang

- Đặt lề trang: Lề trái, phải, trên, dưới.
	

	GV
	Như vậy để chọn hướng trang và đặt lề trang cho một văn bản nào đó các em tiến hành các thao tác như thế nào?
	

	GV
	Yêu cầu hs n/c thông tin trong sgk, qsát bảng 
	File -> Page Setup (hộp thoại Page Setup xuất hiện) -> Margins

	  ?
	Qua n/c em hãy cho biết để chọn hướng trang và đặt lề trang ta làm như thế nào?
	

	HS
	Vào bảng chọn File -> Page Setup 

-> Margins -> Chọn hướng trang -> đặt lề trang
	- Chọn hướng trang:

+ Portrairt (trang đứng)

- Chọn hướng trang:

+ Portrairt (trang đứng)

	  ?
	Sau khi đã chọn được hướng trang và đặt lề trang các em làm như thế nào?
	- Đặt lề trang:

Top: Trên                 Left:  Trái

Boottm: Dưới              Right: Phải

Sau khi chọn được hướng trang và lề trang nháy OK

	HS
	Nháy chuột nút OK
	

	GV
	Các em lưu ý các nút ...  ở bên phải các ô Top, Boottom, Left, Right có chức năng tăng, giảm k/c của các lề

Khi các em thay đổi k/c lề, chọn lại hướng giấy thì các em có thể qsát được trang giấy của cta ở góc dưới bên phải hộp thoại, nhìn vào đó các em sẽ biết được trang giấy của mình đã ưng ý hay chưa, từ đó thay đổi các chỉ số sao cho phù hợp.
	*) Lưu ý: (sgk - 95)

	GV
	Đây chính là nội dung lưu ý (sgk - 55)
	[image: image10.wmf]

	HS
	Đọc nội dung lưu ý
	

	  ?
	Yêu cầu các nhóm thực hành thao tác chọn hướng trang và đặt lề trang trên máy.

Top: 1,5              Bottom: 2

Left: 1,5              Right: 2

Chọn hướng giấy nằm ngang
	

	HS
	Các nhóm thực hành
	

	GV
	Qsát và hướng dẫn hs
	

	GV
	Chốt lại: Như vậy để đặt lề và chọn hướng trang sử dụng bảng chọn File -> Page Setup -> Margins -> OK
	

	GV
	Vậy sau khi đã chỉnh sửa VB được hoàn chỉnh cả nội dung và hình thức muốn in văn bản đó làm như thế nào
	3. In văn bản: (10’)

	  ?
	Các em n/c thông tin sgk - 95
	- In văn bản nháy chuột lên nút lệnh Print

	  ?
	Để in VB các em làm như thế nào?
	

	HS
	Nháy chuột trên nút lệnh Print là toàn bộ VB sẽ được in ra.
	

	  ?
	Để in được cần có điều kiện gì?
	

	HS
	Máy in nối với máy tính và máy in phải được bật
	*) Lưu ý: (sgk - 95)

	  ?
	Muốn xem văn bản trước khi in ta làm như thế nào?
	

	HS
	Nháy chuột nút Print PreView để ktra -> việc trình bày của trang.
	

	GV
	Các em nháy chuột lên các nút ....... để xem các trang nếu VB gồm nhiều trang.

    : Xem VB sau VB hiện thời.

    : Xem VB trước VB hiện thời.

Nháy nút Close trên thanh công cụ để trở về chế độ xem bình thường.
	

	HS
	Đọc ghi nhớ
	*) Ghi nhớ: (sgk - 95)


c. Củng cố, luyện tập. (1’) 

Bài học hôm nay các em cần nắm được một số khả năng trình bày trang văn bản của words. Biết xem văn bản trước khi in. Rèn kỹ năng nháy chuột nhanh chính xác. Phân biệt lề trang văn bản và lề đoạn văn, thao tác in văn bản

d. Hướng dẫn học sinh tự học bài ở nhà: (1’)

- Nắm được các thao tác khi trình bày trang VB và thao tác xem trước khi in.

- Học thuộc bài trong vở ghi và xem thêm trong SGK.

- Làm bài 2 -> 4 (sgk - 96).

- Hướng dẫn bài 4: Có thể in được 2 trang đầu.

- Đọc trước bài tìm kiếm và thay thế để tiết sau học

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

-----------------------------------------------------------------------------------
	Ngµy so¹n:   24/ 11/ 2017
	Ngµy d¹y: 29/ 11/ 2017
	Líp 9A

	
	Ngµy d¹y: 27/ 11/ 2017
	Líp 9B


Tiết 29 Bài 19: TÌM KIẾM VÀ THAY THẾ
1. Mục tiêu:

a. Kiến  thức: - HS biết được tác dụng và cách sử dụng các tính năng tìm kiếm và thay thế.
b. Kỹ năng: - Rèn kỹ năng vận dụng lý thuyết vào thực hành các thao tác tìm kiếm trong văn bản đơn giản.

c. Thái  độ: Nghiêm túc học tập, liên hệ với thực tế.

2. Chuẩn bị của giáo viên và học sinh:

a.  Giáo viên:  Giáo án, SGK.

b. Học sinh:  Vở ghi, vở bài tập, SGK.

3. Tiến trình bài dạy:

a. Kiểm tra bài cũ.

Xen kẽ trong giờ học

* Đặt vấn đề.(1’)   

Hơn hẳn khi viết trên giấy, khi soạn thảo trên máy tính phần mềm sẽ cung cấp cho em nhiều công cụ sửa lỗi rất nhanh chóng. Trong bài này các em sẽ học cách sử dụng các công cụ tìm và thay thế trong văn bản.

b.Dạy nội dung bài mới . 42’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV
	Các em nghiên cứu thông tin mục 1 trong sgk - 97
	1. Tìm phần văn bản.  (32’’)

	HS
	Nghiên cứu
	

	  ?
	Qua nghiên cứu sgk em cho biết tìm kiếm là gì?
	

	HS
	Tìm kiếm là công cụ giúp tìm nhanh 1 từ (hoặc dãy kí tự) trong văn bản
	- Tìm kiếm là công cụ giúp tìm nhanh 1 từ (hoặc dãy kí tự) trong văn bản

	  ?
	Để tìm kiếm em sử dụng hộp thoại nào?
	

	HS
	Hộp thoại Find
	

	  ?
	Theo em hộp thoại Find nằm trong bảng chọn nào?
	

	HS
	Bảng chọn Edit
	

	  ?
	Vậy muốn sử dụng công cụ tìm kiếm Find em làm như thế nào?
	

	HS
	Edit -> Find (hộp thoại Find and Replace xuất hiện)
	- Để sử dụng công cụ tìm kiếm ta làm như sau:

	GV
	Đưa bảng phụ hộp thoại Find and Replace cho hs qsát

Sau khi hộp thoại Find and Replace xuất hiện các em gõ nội dung cần tìm vào ô Find What, sau đó nháy chuột trên nút Find next để tìm.
	Edit -> Find (hộp thoại Find and Replace xuất hiện)

B1: Gõ nội dung cần tìm vào ô Find What

B2: Nháy chuột Find Next để tìm

	  ?
	Vậy khi sử dụng công cụ tìm kiểm em thực hiện qua mấy bước? đó là những bước nào?
	

	HS
	...2 bước: B1: Gõ nội dung cần tìm vào ô Find What.

B2: Nháy chuột lên nút Find next để tìm.
	

	GV
	Từ (hoặc dãy kí tự) tìm được nếu có sẽ được hiển thị trên màn hình dưới dạng bị bôi "đen"
	

	  ?
	Giả sử trong VB "Tre xanh" muốn tìm từ "xanh" các em tìm như thế nào?
	

	HS
	Gõ từ "xanh" vào ô Find What, nháy nút Find next
	

	  ?
	Khi đó từ "Xanh" có hình dạng như thế nào? 
	

	HS
	Bôi đen
	

	  ?
	Muốn tìm tiếp từ "Xanh" khác trong VB các em làm như thế nào?
	

	HS
	Nháy chuột lên nuts Find next dể tìm kiếm
	

	GV
	Lưu ý: Ta sử dụng nút Find Next, các em nháy chuột lên đó một lần sẽ tìm được 1 từ, cứ tiếp tục nháy Find Next các em sẽ tìm hết trong VB

Nếu không muốn tìm nữa nháy nút Cancel để kết thúc
	*) Lưu ý: 10’
Ta sử dụng nút Find Next, các em nháy chuột lên đó một lần sẽ tìm được 1 từ, cứ tiếp tục nháy Find Next các em sẽ tìm hết trong VB

Nếu không muốn tìm nữa nháy nút Cancel để kết thúc

	GV
	Yêu cầu các em thực hiện tìm từ "Xanh" trong bài Tre xanh
	

	HS
	Các nhóm thực hành
	

	GV
	Ktra, hướng dẫn hs thực hiện các thao tác 
	

	  ?
	Đổi nhóm thực hành, yêu cầu tìm từ "Diển đẹp" trong VB Biển đẹp
	

	HS
	Các nhóm thực hành
	


c. Củng cố, luyện tập (1’):

 
Qua bài học hôm nay các em cầc biết được tác dụng và cách sử dụng các tính năng tìm kiếm và thay thế. Rèn kỹ năng vận dụng lý thuyết vào thực hành các thao tác tìm kiếm trong văn bản đơn giản.

d. Hướng dẫn học sinh tự học bài ở nhà: (1’)

- Học thuộc bài trong vở ghi và xem thêm trong SGK, tài liệu tham khảo.  

- Ôn lại các thao tác để tìm phần văn bản.
  - Đọc trước phần thay thế để tiết sau học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

----------------------------------------------------------------------------
	Ngµy so¹n:   28/ 11/ 2017
	Ngµy d¹y: 02/ 12/ 2017
	Líp 9A

	
	Ngµy d¹y: 02/ 12/ 2017
	Líp 9B


Tiết 30 Bài 19: TÌM KIẾM VÀ THAY THẾ (Tiếp)

1. Mục tiêu:

a. Kiến  thức:   HS biết được tác dụng và cách sử dụng các tính năng tìm kiếm và thay thế. Biết phân biệt sự khác nhau giữa Find và Find and replace.
b. Kỹ năng:  Vận dụng các kiến thức đó và thực hành.

c. Thái độ:  Giáo dục ý thức tự giác, nghiêm túc trong giờ học.

2. Chuẩn bị của giáo viên và học sinh:

a. Giáo viên:  Giáo án, SGK, phòng máy.

b. Học sinh:  Ôn bài.

3. Tiến trình bài dạy:

a. Kiểm tra bài cũ. 6’
Câu hỏi:

Nêu các thao tác sử dụng công cụ tìm kiếm trong VB

Yêu cầu trả lời:

Để tìm phần văn bản ta làm như sau:

Edit -> Find... (hộp thoại Find and Replace xuất hiện với trang Find)

B1: Gõ nội dung cần tìm vào ô Find What

B2: Nháy chuột Find Next để tìm

? Nhận xét, đánh giá?

* Đặt vấn đề.(1’)


Bài hôm nay các em tiếp tục học thao tác thay thế phần văn bản.

b. Dạy nội dung bài mới. 36’
	
	Hoạt động của GV và HS
	Ghi bảng

	GV
	ở phần thứ nhất các em đã nắm được các thao tác tìm kiếm, giả sử sau khi đã tìm kiếm được từ (kí tự) đó, cô muốn thay bằng 1 từ (kí tự) khác ta thực hiện các thao tác như thế nào?
	2. Thay thế: (25’)

	  ?
	Các em n/c thông tin sgk – 97 
	

	HS
	
	

	  ?
	Qua n/c, em cho biết thay thế cho chức năng gì?
	

	HS
	Thay thế giúp tìm nhanh 1 dãy kí tự trong văn bản và thay thế dãy kí tự tìm được bằng 1 dãy kí tự khác
	

	  ?
	Để thực hiện em sử dụng hộp thoại nào?
	

	HS
	... Find and Replace
	

	GV
	Vậy muốn tìm nhanh và thay thế 1 dãy kí tự trong văn bản bằng 1 dãy kí tự khác ta sử dụng hộp thoại Find and Replace.
	

	  ?
	Muốn có hộp thoại Find and Replace các em tiến hành các thao tác như thế nào?
	

	HS
	Edit -> Replace ...(hộp thoại Find and Replace xuất hiện với trang Replace)
	

	GV
	Đưa bảng phụ hình ảnh hộp thoại Find and Replace với trang  Replace

Để thay thế phần văn bản các em gõ nội dung cần thay thế vào ô Find What.

Sau đó gõ nội dung thay thế vào Replace With, tiếp theo nháy chuột Find Next để tìm, cuối cùng nháy Replace để thay thế.
	

	  ?
	Qua đây để thực hiện thao tác thay thế người ta thực hiện qua mấy bước? Đó là những bước nào?
	

	HS
	...4 bước: 

B1: Gõ nội dung cần thay thế vào Find What

B2: Gõ nội dung thay thế Replace With.

B3: Nháy Find Next để tìm.

B4: Nháy Replace With để thay thế
	

	GV
	Lưu ý cho hs: Nếu chắc chắn em có thể nháy nút Replace All để thay thế tất cả các cụm từ tìm được bằng các cụm từ thay thế
	*) Lưu ý: (sgk – 98) 6’

	GV
	Giả sử cô thay từ "Xanh" trong văn bản Tre xanh bằng từ "Vàng" các em làm như thế nào?
	

	HS
	Edit -> Replace...

B1: Gõ từ Xanh vào ô Find What.

B2: Gõ từ Vàng vào ô Replace With

B3: Nháy Find Next để tìm

B4: Nháy Replace để thay thế
	

	  ?
	Các em hãy thực hiện thay thế trên máy
	

	HS
	Thực hành

*) Củng cố:
	

	  ?
	Tìm kiếm là gì? Nêu các thao tác tìm phần văn bản?
	*) Ghi nhớ: (sgk – 98) 5’

	  ?
	Thay thế là gì? Nêu các thao tác thay thế phần văn bản.
	

	HS
	Lần lượt trả lời 
	

	GV
	Cho hs n/c bài 1 (sgk - 99)
	Bài 1: (sgk - 99)

	  ?
	Nêu yêu cầu bài?
	Trả lời

	HS
	Nêu sự khác biệt giữa lệnh Find và Find and Replace.
	Find: Có chức năng tìm kiếm từ (dãy kí tự)

Find and Replace: Vừa tìm và thay thế từ (dãy kí tự) tìm được bằng từ (dãy kí tự) khác.


c. Củng cố, luyện tập (1’).

 Thông qua bài học hôm nay  các em đã biết được tác dụng và cách sử dụng các tính năng tìm kiếm và thay thế. Biết phân biệt sự khác nhau giữa Find và Find and replace

d. Hướng dẫn học sinh tự học bài ở nhà: (1’)

  - Nắm vững các thao tác tìm và thay thế phần văn bản,

  - làm bài tập về nhà 2, 3, 4 (sgk - 98, 99).

- Hướng dẫn bài 4:

Có thể dùng công cụ tìm kiếm và thay thế để gõ tắt được.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

------------------------------------------------
	Ngµy so¹n:   01/ 12/ 2017
	Ngµy d¹y: 06/ 12/ 2017
	Líp 9A

	
	Ngµy d¹y: 04/ 12/ 2017
	Líp 9B


Tiết 31 Bài 20: THÊM HÌNH ẢNH ĐỂ MINH HỌA

1. Mục tiêu:

a. Kiến  thức:  HS biết được tác dụng minh hoạ của hình ảnh trong văn bản.
b. Kỹ năng: Biết cách thực hiện các thao tác chèn hình ảnh vào văn bản và chỉnh sửa vị trí của hình ảnh trên văn bản.

c. Thái độ:  HS vận dụng linh hoạt các kiến thức vào thực hành.

2. Chuẩn bị của giáo viên và học sinh:

a. Giáo viên:  Giáo án, SGK, phòng máy.

b. Học sinh:  Ôn bài, vở ghi, SGK

3. Tiến trình bài dạy:

a. Kiểm tra bài cũ.

Xen kẽ trong giờ học

* Đặt vấn đề. (2’)

   Hình ảnh minh hoạ thường được dùng trong văn bản và làm cho nội dung của văn bản trực quan, sinh động hơn. Không những thế trong rất nhiều trường hợp nội dung của văn bản sẽ rất khó hiểu nếu thiếu hình ảnh minh hoạ.

Vậy chèn thêm hình ảnh để minh hoạ ta thực hiện các thao tác như thế nào?  các em nghiên cứu bài hôm nay.

b.Dạy nội dung bài mới. 41’
	 
	Hoạt động của GV và HS
	Ghi bảng

	GV
	Cho hs qsát  2 văn bản có cùng nội dung văn bản a, có hình ảnh.
	1. Chèn hình ảnh vào văn bản: (20’)

	GV
	Vậy muốn chèn hình ảnh vào văn bản như thế nào?
	

	HS
	Đưa con trỏ soạn thảo vào vị trí cần chèn hình ảnh.
	

	GV
	Sau khi đưa con trỏ vào vị trí cần chèn các sử dụng bảng chọn Insert (chèn) -> Picture -> From File...(hộp thoại Insert Picture xuất hiện) 
	- Để chèn hình ảnh vào văn bản ta thực hiện các bước sau:

B1: Đưa con trỏ đến vị trí cần chèn hình ảnh.

	GV
	Cho bảng phụ hình ảnh của hộp thoại Insert Picture, giới thiệu cho hs

Chọn hình ảnh cần chèn, sau đó nháy chuột lên nút lệnh Insert để chèn
	B2: Insert -> Picture -> From File...(hộp thoại Insert Picture xuất hiện).

B3: Chọn tệp hình ảnh cần chèn

B4: Nháy Insert trên hộp thoại 

	  ?
	Sau khi hộp thoại Insert Picture xuất hiện các em thực hiện mấy bước.
	

	HS
	Theo 2 bước:

B1: Chọn tệp hình ảnh

B2: Nháy Insert 
	

	  ?
	Yêu cầu hs chèn 1 hình ảnh vào văn bản Tre xanh
	

	  ?
	Để chèn hình ảnh vào bài Tre xanh các em làm như thế nào?
	

	HS
	Mở văn bản Tre xanh, chọn vị trí chèn hình ảnh.

- Vào Insert -> Picture -> From File...(hộp thoại Insert Picture xuất hiện).

- Nháy chuột để chọn tệp hình ảnh

- Nháy Insert để chèn.
	

	GV
	Các em đã nắm được các thao tác các nhóm thực hành chèn hình ảnh vào văn bản Tre xanh
	

	HS
	Thực hành, gv hướng dẫn hs
	

	GV
	Ta có thể chèn nhiều loại hình ảnh khác nhau vào bất kỳ vị trí nào trong văn bản. Cũng có thể sao chép, xóa hình ảnh hay di chuyển tới vị trí khác trong văn bản như các phần văn bản khác.
	

	  ?
	Muốn sao chép, di chuyển ta làm như thế nào?
	

	HS
	Dùng lệnh Copy -> Paste, Cut -> Paste
	

	GV
	Cho hs n/c sgk - 100
	2. Thay đổi bố trí hình ảnh trên trang văn bản: (19’).

	  ?
	Thông thường chèn hình ảnh vào văn bản có những cách làm nào phổ biến?
	

	HS
	Có 2 cách:

- Trên dòng văn bản

- Trên nền văn bản
	a) Trên dòng văn bản

	  ?
	Chèn trên dòng văn bản ta làm như thế nào?
	

	HS
	
	

	GV
	Trong cách bố trí này, hình ảnh được xem như 1 kí tự đặc biệt và được chèn ngay vào vị trí con trỏ soạn thảo
	

	GV
	Hướng dẫn hs cách chèn này trên máy.
	

	HS
	làm theo sự hướng dẫn của gv 
	

	GV
	Ngoài cách bố trí hình ảnh này ra ta có thể bố trí hình ảnh trên nền văn bản, để làm được điều này ta thực hiện các bước sau:

B1: Nháy chuột trên hình để chọn hình vẽ đó.

B2: Pormat -> Picture...(hộp thoại Pormat Picture xuất hiện) -> LayOut

B3: Chọn kiểu bố trí hình -> OK

Sau khi chọn kiểu bố trí, em có thể di chuyển đối tượng đồ hoạ trên trang bằng thao tác kéo thả chuột
	b) Trên nền văn bản:

B1: chọn hình vẽ.

B2: Pormat -> Picture...(hộp thoại Pormat Picture xuất hiện) -> LayOut

B3: Chọn In line With Text (nằm trên dòng văn bản).

Chọn Square (hình vuông nằm trên nền văn bản)

	GV
	Hướng dẫn hs thực hiện các thao tác trên máy
	

	HS
	Thực hành
	

	HS
	Đọc ghi nhớ
	*) Ghi nhớ: (sgk - 102) 2’


c. Củng cố, luyện tập : (1’)

 
Qua bài học hôm này các em đã biết được tác dụng minh hoạ của hình ảnh trong văn bản. Biết cách thực hiện các thao tác chèn hình ảnh vào văn bản và chỉnh sửa vị trí của hình ảnh trên văn bản.

d. Hướng dẫn học sinh tự học bài ở nhà: (1’)

- Học bài, nắm vững các thao tác chèn hình ảnh vào văn bản.

- Làm các câu hỏi 1, 2, 3 (sgk - 102).

- Chuẩn bị bài thực hành 8 để tiết sau học.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

---------------------------------------------------------------------
	Ngµy so¹n:   06/ 12/ 2017
	Ngµy d¹y: 09/ 12/ 2017
	Líp 9A

	
	Ngµy d¹y: 09/ 12/ 2017
	Líp 9B


Tiết 32: BÀI 1 : CHƯƠNG TRÌNH BẢNG TÍNH LÀ GÌ?
1 -  MỤC TIÊU:

a. Kiến thức
- Biết được nhu cầu sử dụng bảng tính trong đời sống và trong học tập.

- Biết được các chức năng chung của chương trình bảng tính.

- Nhận biết được các thành phần cơ bản của màn hình trang tính.

b. Kỹ Năng
- Thao tác với các thành phần cơ bản của màn hình trang tính.

c. Thái độ
- Biết hợp tác trong việc học nhóm.

2  -  CHUẨN BỊ:

1. Giáo viên: Giáo trình, phòng máy, tranh.

2. Học sinh: Học và chuẩn bị bài ở nhà.

3 -  TIẾN TRÌNH BÀI DẠY:

a - KIỂM TRA BÀI CŨ: 

b – NỘI DUNG BÀI MỚI

	Hoạt động của thầy và trò 
	Nội dung

	a.Họat động 1:

-GV Yêu cầu học sinh lấy một số ví dụ về thông tin được biểu diễn ở dạng bảng

-HS Ví dụ như thời khoá biểu, danh sách lớp…
	1- Bảng và nhu cầu xử lý thông tin dạng bảng:

Trên thực tế có rất nhiều thông tin được biểu diễn dưới dạng bảng để tiện theo dõi, so sánh, sắp xếp, tính toán. . .

Các số liệu trong bảng tính cũng có thể được biểu diễn dưới dạng biều đồ để minh họa trực quan cho các số liệu ấy.

	b.Họat động 2:

-GV Thông tin được biểu diễn như vậy nhằm mục đích gì?

-HS Trả lời

-GV Khái quát về định nghĩa chương trình bảng tính.
	2- Chương trình bảng tính :

ĐN: SGK / 5



	c.Họat động 3:

-GV Mở bảng tính Excel và cho học sinh nhận xét có gì giống với chương trình Word?

-HS có bảng chọn, nút lệnh và cửa sổ làm việc chính.

-GV Dữ liệu bao gồm những dữ liệu nào?

-HS trả lời

-GV lấy vd cụ thể

Học sinh: lắng nghe, ghi chép


	a)Màn hình làm việc:

Có nhiều phần mềm bảng tính: QuatroPro, Lotus1-2-3, Excel. .

Nhưng đặc trưng chung là biễu diễn dữ liệu (số, văn bản) và kết quả tính toán dưới dạng bảng.

b)Dữ liệu:

Có nhiều loại dữ liệu nhưng thường là loại dữ liệu dạng văn bản và dữ liệu kiểu số.

c)Khả năng tính toán và sử dụng hàm có sẳn:

Với chương trình bảng tính, em có thể thực hiện 1 cách tự động công việc tính toán hoặc sử dụng các hàm có sẳn để tính toán cho dữ liệu trong bảng tính.

Lưu ý : Khả năng tính toán 1 cách tự động khi cập nhật số liệu.

	d.Họat động 4:

-GV dùng các ví dụ để minh hoạ cho việc sắp xếp và lọc dữ liệu

-HS nghe và ghi chép


	d)Sắp xếp và lọc dữ liệu:

Dữ liệu trong bảng tính có thể được sắp xếp theo nhiều tiêu chuẩn khác nhau : sắp xếp theo thứ tự tăng dần hoặc giảm dần ( dữ liệu kiểu số), theo thứ tự mẫu tự ABC hoặc có thể được lọc theo nhóm dữ liệu theo 1 tiêu chuẫn nào đó (nhóm học sinh khá, giỏi, nhóm học sinh có điểm trên 5).

	e.Họat động 5:

-GV cho hs làm bài tập

-GV sửa bài
	-Hs làm bài tập 1.1 – 1.3 sách BT/6



	a.Họat động 6:

-GV dùng tranh giới thiệu biểu đồ

-Hs quan sát và ghi chép


	2-Chương trình bảng tính: (tt)

e)Biểu đồ: 

Biểu đồ : là dạng trình bày dữ liệu cô đọng và trực quan 

Chương trình bảng tính cung cấp công cụ tạo biểu đồ

Ngoài ra trong chương trình bảng tính em có thể thực hiện việc định dạng (chọn phông chữ, cân chỉnh hành cột, thêm xóa hành cột, chỉnh sửa sao chép nội dung trong ô. . .)

	b.Họat động 7:

-GV dùng Hình 6 để giới thiệu cửa sổ làm việc Excel

-Hs thảo luận nhóm, tìm các thành phần có trong cửa sổ, trình bày kết quả thảo luận.

-GV nhận xét

-Hs ghi chép

-GV cho ví dụ để giới thiệu các khái niệm hàng, cột, khối, địa chỉ ô /khối

-Hs quan sát và ghi chép


	3-Màn hình làm việc của chương trình bảng tính:
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Tương tự như các thành phần trong cửa sổ soạn thảo văn bản Microsoft Word, cửa sổ soạn thảo bảng tính Excel còn có: 

-Thanh công thức: hiển thị địa chỉ ô và công thức tính toán của ô.

-Bảng chọn Data : có các lệnh để xử lý dữ liệu.

-Trang tính: SGK/8

Chú ý:

-Hàng: được đánh dấu 1,2,3. . .

-Cột: được đánh dấu A,B,C. . .

-Địa chỉ ô: là ô tính giao giữa cột và hàng
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Ví dụ: B3 là ô nằm ở cột B và hàng 3

-Khối ô : bao gồm các ô tính nằm liền nhau tạo thành hình chữ nhật.

-Địa chỉ khối ô: là cặp địa chỉ của ô trên cùng bên trái và ô dưới cùng bên phải
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Ví dụ: B3:E7 là các ô nằm ở cột C, D, E và nằm trên hàng 3, 4, 5, 6, 7.

	c.Họat động 8:

-GV cho ví dụ minh hoạ việc nhập, chỉnh sửa, di chuyển trong bảng tính

-Hs nghe và ghi chép


	4- Nhập dữ liệu vào trang tính:

a)Nhập và sửa dữ liệu:

Nháy chọn ô và nhập dữ liệu vào từ bàn phím. Kết thúc việc nhập dữ liệu bằng cách nhấn phím Enter hoặc nháy chọn ô tính khác.

Để chỉnh sửa nội dung trong ô, nháy đúp vào ô tính rồi thực hiện việc chỉnh sửa hay chọn ô tính đó –nhấn phím F2 và chỉnh sửa

	d.Họat động 9:

-GV cho ví dụ minh hoạ cách di chuyển trong bảng tính

-Hs nghe và ghi chép
	b)Di chuyển trên trang tính: Có thể sử dụng :

-Các phím mũi tên.

-Chuột và các thanh cuốn.

-Hộp tên.

	e.Họat động 10

-GV củng cố cách gõ và bộ phông chữ Việt để gõ tiếng Việt
	c)Gõ chữ Việt trên trang tính:

Tương tự như làm việc với chương trình soạn thảo văn bản, cần có chương trình hỗ trợ gõ (chương trình gõ) và bộ phông chữ Việt.

	g.Họat động 11

-GV cho hs làm bài tập 

-GV sửa bài
	-Hs làm bài tập 1.6 , 1.7, 1.10   sách BT/7,8




c - CỦNG CỐ :

-GV củng cố các phần chính vừa học


d - HƯỚNG DẪN HỌC SINH TỰ HỌC Ở NHÀ

-Về nhà học bài, xem trước bài 1( phần còn lại).

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

--------------------------------------------------------------------

	Ngµy so¹n:   09/ 12/ 2017
	Ngµy d¹y: 13/ 12/ 2017
	Líp 9A

	
	Ngµy d¹y: 11/ 12/ 2017
	Líp 9B


Tiết 33: Bài thực hành số 1 : LÀM QUEN VỚI CHƯƠNG TRÌNH BẢNG TÍNH EXCEL
1 -  MỤC TIÊU:

a. Kiến thức
- Biết cách khởi động và thoát Excel

- Nhận biết các ô, hàng, cột trên bảng tính excel

- Biết cách di chuyển trên trang tín

b. Kỹ Năng
- Thực hành trên máy một cách linh hoạt và chính xác.

c. Thái độ
-Có thái độ nghêm túc trong giờ học. 

2 -  CHUẨN BỊ:

1. Giáo viên: Giáo trình, phòng máy, tranh.

2. Học sinh: Học và chuẩn bị bài ở nhà.

3 -  TIẾN TRÌNH BÀI DẠY:

a - KIỂM TRA BÀI CŨ:
-Nêu các thành phần có trong cửa sổ CTBT? (5d)

-Nêu cách nhập và chỉnh sửa dữ liệu? (5đ)

b – NỘI DUNG BÀI MỚI:

	Hoạt động của thầy và trò 
	Nội dung

	a.Họat động 1:

-GV hướng dẫn thực hành 

-Hs tiến hành thực hành theo nhóm 

-GV theo dõi giúp đỡ khi cần thiết
	1- Khởi động Excel:

Theo 3 cách:

-Menu: Start( All programs ( Microsoft Office ( Microsoft Excel

-Biểu tượng Excel trên màn hình Desktop


[image: image14.png]sl e
)




​-Biểu tượng Excel trên thanh công việc

	b.Họat động 2:

-GV hướng dẫn thực hành bài tập 1

-Hs tiến hành thực hành theo nhóm và ghi chép những nhận xét rút ra từ quá trình thực hành

-GV theo dõi hướng dẫn và giúp đỡ khi cần thiết
	2- Lưu kết quả và thóat khỏi Excel:

Lưu: Menu: File ( Save

Thoát theo 3 cách:

-File ( Exit

-Nút Close

-Tổ hợp phím: Alt+F4

	c.Họat động 3:

-GV nêu vấn đề

-Hs tiến hành thực hành theo nhóm quan sát các bảng chọn và thực hiện di chuyển trong bảng tính.

-GV theo dõi hướng dẫn và giúp đỡ khi cần thiết


	3- Bài tập 1:

-Nhận xét điểm giống và khác nhau giữa màn hình Word và Excel

-Mở và quan sát các bảng chọn. Thực hiện tìm xem các lịnh sau nằm ở mục nào trong thanh bảnh chọn

1)Sort

2)Toolbars

3)Chart

-Thực hiện di chuyển trong bảng tính bằng :

1)Chuột và thanh trượt

2)Các phím mũi tên

3)Ô địa chỉ

	d.Họat động 4:

-GV nhận xét quá trình thực hành của hs

-Hs nhận xét bài thực hành và rút kinh nghiệm

-GV chọn một số cá nhân để đánh giá và nhận xét kết quả thực hành
	


 c - CỦNG CỐ: 

- Nhắc lại cách khởi động, nhập dữ liệu, lưu kết quả và thoát khỏi Excel.


d - HƯỚNG DẪN HỌC SINH TỰ HỌC Ở NHÀ
- Học thuộc bài cũ.

- Đọc và chuẩn bị trước phần còn lại bài thực hành 1
RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

----------------------------------------------------------------

	Ngµy so¹n:   13/ 12/ 2017
	Ngµy d¹y: 16/ 12/ 2017
	Líp 9A

	
	Ngµy d¹y: 16/ 12/ 2017
	Líp 9B


Tiết 34 : Bài thực hành số 1 : LÀM QUEN VỚI CT BẢNG TÍNH EXCEL (tt)
1 -  MỤC TIÊU:

a. Kiến thức
- Biết cách nhập dữ liệu vào trang tính

- Biết cách chỉnh sửa dữ liệu trong ô

b. Kỹ Năng
- Thực hành trên máy một cách linh hoạt và chính xác.

c. Thái độ
-Có thái độ nghêm túc trong giờ học. 

2 -  CHUẨN BỊ

a. Giáo viên: Giáo trình, phòng máy, tranh.

b. Học sinh: Học và chuẩn bị bài ở nhà.

3 -  TIẾN TRÌNH BÀI DẠY:

a - KIỂM TRA BÀI CŨ:

-Thế nào là chương trình bảng tính? (5 đ)

-Nêu cách nhập dữ liệu. (5 đ)
b – NỘI DUNG BÀI MỚI:

	Hoạt động của thầy và trò 
	Nội dung

	a.Họat động 1:

-GV hướng dẫn thực hành 

-Hs tiến hành thực hành theo nhóm 


	1- Cách nhập dữ liệu vào ô :

Theo cách:

-Kích hoạt 1 ô tính bằng chuột và nhập dữ liệu

-Di chuyển con trỏ ô bằng các phím mũi tên và nhập dữ liệu

	b.Họat động 2:

-GV hướng dẫn thực hành 

-Hs tiến hành thực hành theo nhóm 

-GV theo dõi giúp đỡ khi cần thiết
	2- Chỉnh sửa dữ liệu trong ô tính:

Theo cách:

-Nháy đúp chuột vào ô để xuất hiện con trỏ soạn thảo trong ô rồi chỉnh sửa dữ liệu

-Nháy chuột chọn ô cần chỉnh sửa, nhấn phím F2 rồi chỉnh sửa dữ liệu

	c.Họat động 3:

-GV hướng dẫn thực hành 

-Hs tiến hành thực hành theo nhóm 
	3- Xoá dữ liệu trong ô tính:

Chọn ô tính có dữ liệu cần xoá ( nhấn phím Delete

	d.Họat động 4:

-GV nêu yêu cầu 

-Hs tiến hành thực hành theo nhóm : 

-GV theo dõi giúp đỡ khi cần thiết
	4- Bài tập 2:

-Nhập dữ liệu vào ô tính theo hướng dẫn SGK trang 11

	e.Họat động 5:


	5- Bài tập 3:

-Nhập dữ liệu như sách trang 11

-Lưu với tên DS lớp 7x-(nhóm x)

	g.Họat động 6:

-GV nhận xét quá trình thực hành 

-Hs nhận xét bài thực hành và rút kinh nghiệm

-GV chọn một số cá nhân để đánh giá và nhận xét kết quả thực hành
	


c - CỦNG CỐ: 

-GV củng cố các phần chính vừa học


d- HƯỚNG DẪN VỀ NHÀ: 

-Về nhà học bài, xem trước bài 2.

RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

----------------------------------------------------------------

	Ngµy so¹n:   15/ 12/ 2017
	Ngµy d¹y: 20/ 12/ 2017
	Líp 9A

	
	Ngµy d¹y: 18/ 12/ 2017
	Líp 9B


Tiết 35 : BÀI 2 : CÁC THÀNH PHẦN CHÍNH VÀ DỮ LIỆU TRÊN TRANG TÍNH 
1 -  MỤC TIÊU:

a. Kiến thức
- Biết được các thành phần chính trên trang tính : hàng, cột, ô, khối, hộp tên, thanh công thức

- Hiểu vai trò của thanh công thức.

b. Kỹ Năng
- Rèn luyện thao tác với các thành phần trên trang tính.

c. Thái độ
- Có thái độ học tập nghiêm túc, chú ý bài giảng.

2  -  CHUẨN BỊ:

a. Giáo viên: Giáo trình, phòng máy, tranh.

b. Học sinh: Học và chuẩn bị bài ở nhà.

3 -  TIẾN TRÌNH BÀI DẠY:

a - KIỂM TRA BÀI CŨ:
-Nêu điểm khác của Excel so với Word . (5 đ)

-Nêu cách di chuyển trong bảng tính. ( 5 đ)

b – NỘI DUNG BÀI MỚI:

	Hoạt động của thầy và trò 
	Nội dung

	a.Họat động 1:
-GV cho hs xem hình 13 để giới thiệu bảng tính 

-Hs quan sát, nêu nhận xét  về trang tính (sheet 1, sheet 2 . . .)

- Hs quan sát, nêu nhận xét  sự khác biệt giữa trang tính đang mở (kích hoạt) và đóng

-GV nhận xét

-Hs tổng hợp và ghi bài.
	1-Bảng tính:

Một bảng tính có thể có nhiều trang tính, trang tính được phân biệt bằng nhãn trang.

Trang tính đang được kích hoạt: là trang tính đang hiển thị và có nhãn trang màu trắng, chữ in đậm. Để kích hoạt 1 trang tính em nháy chuột vào nhãn trang của nó

	b.Họat động 2:

-GV dùng hình 14 giới thiệu các khái niệm hộp tên, khối ô, thanh công thức

-Hs quan sát và nhận xét 

-Hs ghi chép


	2-Các thành phần chính trên trang tính :

Ngoài cột, hàng, ô tính trên trang tính còn có :

-Hộp tên: là ô dầu tiên trên thanh công thức. Hiển thị địa chỉ ô đang được chọn

-Tên hàng, tên cột, ô tính, khối ô

-Thanh công thức: hiển thị công thức hay nội dung của ô đang được chọn

	c.Họat động 3:
-GV cho hs làm bài tập 

-GV sửa bài
	-Hs làm bài tập 2.2 ; 2.4; 2.7  sách BT/10,11



	d.Họat động 4:
-GV cho hs xem hình 15, 16, 17, 18 và giới thiệu các thao tác chọn các đối tượng trên trang tính

-Hs quan sát, nghe và ghi chép.


	3-Chọn các đối tượng trên trang tính:

Để chọn các đối tượng trên trang tính trang tính, em thực hiện:

-Chọn một ô: nháy chuột trái vào ô hoặc dùng các phím mũi tên để di chuyển con trỏ ô đến ô muốn chọn.

-Chọn một hàng: nháy chuột vào nút tên hàng.

-Chọn một cột: nháy chuột vào nút tên cột.

-Chọn một khối: kéo thả chuột từ ô đầu tiên bên trái đến ô đối diện ở góc dưới bên phải, ô chọn đầu tiên là ô được kích hoạt.

-Chọn nhiều khối khác nhau: chọn khối đầu tiên, sau đó nhấn giữ phím Ctrl và lần lượt chọn các khối tiếp theo.

	e.Họat động 5:
-GV cung cấp thêm các cách chọn các đối tượng khác nếu còn thời gian

-Hs quan sát, nghe và ghi chép.


	-Chọn nhiều hàng liên tục: kéo thả chuột ở nút tên hàng

-Chọn nhiều cột liên tục: kéo thả chuột ở nút tên cột

-Chọn nhiều hàng không liên tục: chọn hàng đầu tiên, sau đó nhấn giữ phím Ctrl và lần lượt chọn các hàng tiếp theo.

-Chọn nhiều cột không liên tục: chọn các cột đầu tiên, sau đó nhấn giữ phím Ctrl và lần lượt chọn các cột tiếp theo.

-Chọn cả trang tính: dùng tổ hợp phím Ctrl+A hay nháy chuột trái vào ô giao nhau giữa tên cột và tên hàng

	g.Họat động 6:
-GV nêu ví dụ về các loại dữ liệu

-Hs quan sát, nhận xét và ghi chép
	4-Dữ liệu trên trang tính :

a)Dữ liệu số: 

Bao gồm các số 0, 1,  . .9 , dấu cộng trước số cho biết là số dương, dấu trừ cho biết là số âm.

Ví dụ : 120, -2, +38. .

Thông thường, dấu phẩy được dùng để ngăn cách hàng nghìn, hàng triệu. . Dấu chấm dùng ngăn cách phần nguyên và phần thập phân.

Ngầm định, dữ liệu số được căn thẳng lề phải trong ô tính.

b)Dữ liệu ký tự:

Bao gồm các chữ cái, chữ số và các ký hiệu.

Ví dụ : Điểm thi,  Lớp 7A. .

Ngầm định, dữ liệu ký tự được căn thẳng lề trái trong ô tính.

	f.Họat động 7:
-GV cho hs làm bài tập 

-GV sửa bài
	-Hs làm bài tập 2.8 ; 2.9; 2.10  sách BT/12




c - CỦNG CỐ: 

-GV củng cố các phần chính vừa học


d - HƯỚNG DẪN VỀ NHÀ: 

-Về nhà xem trước bài 2( phần còn lại).Làm Bài tập  2.1; 2.3; 2.5; 2.6 sách BT/ 10,11

-Học thuộc bài và soạn câu hỏi 1,2 sách bài học/18
RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................

------------------------------------------------------------------

	Ngµy so¹n:   20/ 12/ 2017
	Ngµy d¹y: 23/ 12/ 2017
	Líp 9A

	
	Ngµy d¹y: 23/ 12/ 2017
	Líp 9B


Tiết 36: Bài thực hành số 2 :
 LÀM QUEN VỚI CÁC KIỂU DỮ LIỆU TRÊN TRANG TÍNH
1 -  MỤC TIÊU:

a. Kiến thức 

- Phân biệt được bảng tính, trang tính và các thành phần trên trang tính.

- Chọn các đối tượng trên rang tính.

- Mở và lưu bảng tính trên máy tính.

b. Kỹ Năng

- Thành thạo thao tác chọn một trang tính, mở và lưu trang tính, chọn các đối tượng trên trang tính.

c. Thái độ

- Tự giác, ham học hỏi.

2 -  CHUẨN BỊ:

a. Giáo viên: Giáo trình, phòng máy, tranh.

b. Học sinh: Học và chuẩn bị bài ở nhà.

3 -  TIẾN TRÌNH BÀI DẠY:

a - KIỂM TRA BÀI CŨ:

b – NỘI DUNG BÀI MỚI: 

	Hoạt động của thầy và trò 
	Nội dung

	a.Họat động 1:
-GV hướng dẫn thực hành

-Hs tiến hành thực hành theo nhóm và ghi chép những nhận xét rút ra từ quá trình thực hành

-GV theo dõi hướng dẫn và giúp đỡ khi cần thiết


	1- Mở mới 1 bảng tính:

Theo 3 cách:

-Menu: File( New hoặc nháy chuột vào biểu tượng 
[image: image15.png]


 trên thanh công cụ.

2- Lưu bảng tính với 1 tên khác

Lưu: Menu: File ( Save As ( xuất hiện hộp hội thoại, gõ tên mới vào ô File name ( nháy chuột vào nút Save

3- Bài tập 1:

1)Mở mới 1 bảng tính và quan sát các thành phần chính trên trang tính

2)Kích hoạt các ô tính khác nhau và quan sát hộp tên và thanh công thức

3)Đổi tên cho nhãn trang:

4)Nhập công thức =5+7 vào ô tính và quan sát ô tính đó với nội dung hiển thị trên thanh công thức thanh công 

	b.Họat động 2:
-GV hướng dẫn : 

.Cách chọn hàng cột liên tục và không liên tục

.Cách chọn đối tượng bằng hộp tên

-Học sinh quan sát và ghi chép

-Hs tiến hành thực hành theo nhóm và ghi chép những nhận xét rút ra từ quá trình thực hành
	4- Bài tập 2:

+Chọn các đối tượng trên trang tính:

-Chọn 1 ô

-Chọn 1 hàng

-Chọn 1 cột

-Chọn nhiều hàng, cột liên tục

-Chọn nhiều hàng, cột không liên tục

-Chọn khối ô

-Chọn nhiều khối ô khác nhau

+Chọn các đối tượng trên bảng tính bằng hộp tên

	c.Họat động 3:
-GV chọn một số cá nhân để đánh giá và nhận xét kết quả thực hành

-Hs nhận xét bài thực hành và rút kinh nghiệm
	GV nhận xét quá trình thực hành của hs

	d.Họat động 4:
-GV nêu yêu cầu đề

-HS làm bài
	Kiểm tra 15 phút
(tham khảo đề và đáp án)


C  - CỦNG CỐ: 


d - HƯỚNG DẪN VỀ NHÀ:

- Học thuộc bài cũ.  Đọc và chuẩn bị trước phần còn lại bài 2
RÚT KINH NGHIỆM SAU KHI GIẢNG

- Thời gian giảng toàn bài:...................................................................................

- Thời gian dành cho từng phần:..........................................................................
- Nội dung kiến thức:...........................................................................................

- Phương pháp giảng dạy:....................................................................................
Nhập


Input








Xuất


Output





Xử lý
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